








http://www.akaipro.com
http://www.akaipro.com/support


http://www.akaipro.com
http://www.akaipro.com


http://www.akaipro.com
http://www.ilok.com
http://www.asio4all.com
























































  

 
35 

 

 
General Features 
 
Programs 
 

About Programs 

 

Each track you create within a sequence is routed through a program. There are six types of programs, each of 
which determines how the track sounds or what it is used for. A single project can hold up to 128 programs. 

This chapter covers how to create each program type. 

To learn about editing your programs to your preference, see the Modes > Program Edit Mode chapter. 

 

A drum program uses one or more samples as its sound source. It contains (1) a list of samples and (2) the settings 
for each sample (i.e., pad assignments, loop points, pitch tuning, effects, etc.). Drum programs are used mostly for 
creating drum parts and quickly and easily assigning samples to pads. See Drum Programs for more information. 

 

A keygroup program uses one or more samples as its sound source. It contains (1) a list of samples and (2) the 
settings for each sample (i.e., pitch tuning, effects, etc.). Keygroup programs are used to play samples chromatically 
with a MIDI keyboard or the MPC pads. See Keygroup Programs for more information. 

 

A clip program uses several samples that can be looped (clips). Each clip can be assigned to a pad, which you can 
press to trigger the clip according to a quantization setting. This lets you create intriguing, layered performances by 
launching different combinations of clips together. See Clip Programs for more information. 

 

A plugin program contains an instance of a plugin through which you can send your track’s MIDI data. See Plugin 
Programs for more information. 

 

A MIDI program lets you send your track’s MIDI data to an external MIDI device like a synth or drum machine. See 
MIDI Programs for more information. 

 

A CV program lets you send your track’s MIDI data to an external MIDI device that uses control voltage (CV), like a 
synth. See CV Programs for more information. 
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MIDI Programs 

 

A MIDI program lets you send your track’s MIDI data to an external MIDI device like a synth or drum machine.  

 

To create a MIDI program: 

1. Press Main to enter Main Mode. 

2. Use the cursors to select Pgm, and press Window. 

3. Press F3/New. 

4. In the New Program screen that appears, set the Type field to Midi. 

5. Press F5/Do It to create the program or F4/Cancel to return to Main Mode without creating the program. 

 

There are five additional settings to configure for a MIDI program: the MIDI port (Port), program change message 
(PC), MIDI channel (Ch), Most Significant Byte (Bank MSB), and Least Significant Byte (Bank LSB). See this section 
to learn more. 

Note: You also have to configure the MIDI ports in the software’s Preferences (in the Edit Menu). See the user guide 
in the MPC software to learn more: click the Help menu, select MPC Help, and select MPC User Manual. 

 

 

To adjust the level and panning of a track using the plugin program: 

1. Press Shift+Prog Mix/Track Mix to enter the Channel Mixer. 

2. Set Mixer to Tracks. 

3. Press F1/Level to view the velocity levels of all tracks or F2/Pan to view the panning of all tracks. 

4. Select the field that corresponds to the track with the MIDI program, and adjust the value. Alternatively, turn its 
corresponding Q-Link knob. After you do this once, you can adjust the volume and panning of the MIDI program 
normally. 

Important: 

If you copy a sequence, the volume and pan values will be copied with that sequence. This is also true if you 
move to a new sequence and put the same plugin program on a new track. 
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Recording Bit Depth determines bit depth of the audio recorded from a sample. 

 

Display Resolution is the display resolution in PPQN (pulses per quarter note) of pulse values in certain areas of the 
operating system. Please note that this setting affects the display resolution, not the timing. 

 

Program Change Target determines what an incoming MIDI program change message will change: nothing (Off), a 
program (Program), a sequence (Sequence), or a track (Track). 
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Timing Correct/T.C. 
 

The Timing Correct feature (abbreviated TC) includes settings to help quantize the note events in a track. This is 
available in Main Mode and the Step Sequencer. 

Note: Pad Mute Mode and Track Mute Mode include a similar Timing Correct feature in each mode, but it is different 
from the feature described here. See Modes > Pad Mute Mode and Track Mute Mode to learn about those settings. 

To open the Timing Correct settings: 

In Main Mode, press Shift+F1/T.C. 

In the Step Sequencer, press F1/T.C. 

 

 
 

 
 

You can use the following fields and buttons in the Timing Correct screen. Use the cursors to select each field, and 
then use the data dial or –/+ buttons to change the parameter. If the field is a number, you can use the numeric 
keypad to enter a number and then press Enter to confirm it. 

 

Type determines how timing corrections are applied. 

• Start: The entire note event will be nudged forward or backward so the start point aligns with the closest 
time division marker in the grid. 

• End: The end points of note events will be extended or shortened to align with the closest time division 
marker in the grid. The start points will remain untouched. 

• Length: The end points of note events will be extended or shortened so that each event’s length is a multiple 
of the time division, regardless of where it is in the grid. The start points will remain untouched. 

• Legato: The end points of note events will be extended or shortened to create a long, unbroken phrase from 
the first note event’s start point to the last note event’s end point. Each note event will sustain until another 
note event starts. If multiple note events start at the same time (and are not the last note events), their 
lengths will become identical. Selecting Legato disables all other options in this window. 

  
Without legato applied. With legato applied. 
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Time Div is the quantization value. Note events will “snap” to these time divisions on the grid. The T indicates a 
triplet-based value. 

To set the quantization value, use this field. Alternatively, if you are not in the Timing Correct screen, press 
and hold Note Repeat and press one of the six buttons under the screen; F1–F5 sets the note value, and F6/(3) 
determines whether it is a standard value or triplet-based value. 

 

Strength determines how strictly notes will be quantized (i.e., shifted toward the quantize value): 0–100%. Lower 
values move notes a little bit towards the closest quantize value, resulting in a less mechanical feel than a strict 
quantization (a higher value). 

To set the quantization strength, use this field. 

 

Swing determines the amount of swing: 50–75%. Swing lets you “shuffle” your beats, from subtle to extreme. 50% 
corresponds to no swing (“straight”) and 75% corresponds to the maximum amount. 

To set the amount of swing, use this field. 

 

Shift Timing is an offset for the events that will be time-corrected. The affected events will be shifted by this amount: 
-48 to 48 ticks of the time counter. 

To off-set the time-corrected notes, use this field. 

 

Window determines how many notes around each beat (Time Div) will be quantized. Any notes outside this range 
will not be quantized; notes inside will. This value is measured as a percentage: 0–100%. 

To set the quantization window, use this field. 

 

Events determines the target range for the time correction: 

• All: Time correction will be applied to all note events in the currently selected track. 

• Selected: Time correction will be applied to only the selected note events in the currently selected track. (Use 
the grid in the MPC software window to do this.) 

• Range: Time correction will be applied to note events within a certain span of time. You can also set whether 
it applies to all notes within that timespan or specific note values only.  

From is the start of the range. 

To is the end of the range. 

Notes are the specific note values that you want to time-correct within the range. Press the corresponding 
pads to select or deselect the notes. 

 

 

 

F3/All Trks applies the Timing Correct settings to all tracks at the same time. 

 

F4/Close returns to the previous screen without applying your changes. 

 

F5/Do It applies the time corrections you entered and returns to the previous screen. 



  

 
48 

 

 
Click/Metronome 
 

The Click/Metrome screen contains all settings regarding the metronome (click track). These settings are accessible 
from within Main Mode only, though they apply to all modes (globally). 

To open the metronome settings, press Main to enter Main Mode, and then press Shift+F2/Click. 

 

 
 

You can use the following fields and buttons in the Click/Metronome screen. Use the cursors to select each field, 
and then use the data dial or –/+ buttons to change the parameter. If the field is a number, you can use the numeric 
keypad to enter a number and then press Enter to confirm it. 

 

Count-In determines if the metronome counts before recording and playback. 

To set how the metronome count-in works, use this field to select an option: 

• Off disables the metronome pre-count. 

• Record enables the pre-count during recording only. 

• Record + Play enables pre-count in both Record and Playback Modes. 

 

Metronome determines if/when the metronome is enabled: 

To set when the metronome is enabled, use this field to select an option: 

• Off disables the metronome. 

• Play enables the metronome sound during playback only. 

• Record enables the metronome sound during recording only. 

• Record + Play enables the metronome to sound during recording and playing. 

 

Rate is the time division of the metronome click: 1/4, 1/4T, 1/8, 1/8T, 1/16, 1/16T, 1/32 or 1/32T. T indicates a 
triplet-based time division. 

To set the metronome rate, use this field. 

 

Sound is the sound that occurs during each beat of the metronome: Sidestick 1, Sidestick 2, Clap, Metroclick, 
Shake, Tambourine, or MPC Click. 

To set the metronome sound, use this field. 

 

Volume is the volume of the metronome. 

To set the metronome volume, use this field. 
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Automation 
 

You can set the automation for programs and audio tracks to be “written,” “read,” or disabled entirely. You can do 
this globally or for individual programs and audio tracks. 

 

 

Global 

 

Changing the global automation state will change the automation state for all programs in your project. 

To change the global automation state, press Q-Link Trigger when it is set to Global in the Preferences screen 
(see this section to learn how to do this). 

The Q-Link Trigger button will cycle through its three states: 

• When off, automation data will be ignored. If you have already recorded or entered automation, this will 
switch between Read (solidly lit) and Write (flashing) only, but you can override this and turn it off by 
pressing and holding Shift while pressing the button. 

Important: If you have already recorded automation and turn it off, the track will still use the effect and 
its parameter values at the point where you turned it off. 

• When solidly lit (Read), automation data will be read but not recorded. (Think of this as a protective 
feature to prevent accidental changes to your automation while recording.) 

• When flashing (Write), automation can be recorded and will overwrite any existing automation. (Make 
sure not to touch the Q-Link knobs accidentally while you are recording.) 

To set Q-Link Trigger to control global automation, press Shift+Song/Other (which will enter MIDI Control 
Mode), press F1/Prefs to show the Preferences screen, and set Auto button to Global. 

 

 

Programs & Audio Tracks 

 

You can also set the automation for each program or audio track. Program automation is available for all program 
types except MIDI programs. 

Note: Remember that changing the global automation state will change the automation state for all programs in your 
project; if they were originally different, all of them will then match the global automation state. 

To change the automation state of a program or audio track, first select the MIDI track using the desired 
program or select the desired audio track. After that, press Q-Link Trigger when it is set to Program in the 
Preferences screen (see this section to learn how to do this). 

 

Alternatively, do the following: 

1. Press Main to enter Main Mode or Step Seq to enter the Step Sequencer. 

2. Use the cursors to select the parameter in the lower-right corner. This varies depending on the last parameter 
you adjusted in its sub-window. 

3. Press Window. 

4. Use the cursors to select Automation. Use the data dial or –/+ buttons to change its automation state. 
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You can set each program or audio track to one of three automation states: 

• When off (x), the program or audio track will ignore automation data. 

Important: If you have already recorded automation and turn it off, the track will still use the effect and 
its parameter values at the point where you turned it off. 

• When set to Read (R), the program or audio track will read automation data but will not record any 
additional automation over it. (Think of this as a protective feature to prevent accidental changes to your 
automation while recording.) 

• When set to Write (W), the program or audio track can record automation. (If you have any Q-Link knobs 
assigned to automatable parameters, make sure not to touch any accidentally while you are recording.) 

 

To set Q-Link Trigger to control automation for a program or audio track, press Shift+Song/Other (which will 
enter MIDI Control Mode), press F1/Prefs to show the Preferences screen, and set Auto button to Program. 

 

 

16 Level 
 

16 Level temporarily copies the samples of one pad to all 16 pads. The pads will now output the same note number 
as the initial pad, but a selectable parameter will be fixed at values that increase as the pad numbers increase (i.e., 
Pad 1 is the minimum, Pad 16 is the maximum), regardless of how hard you press them. 

 

 

 

 

 

To activate or deactivate 16 Level: 

1. Press 16 Level. 

2. Use the fields in the 16 Levels screen that appears: 

• Active determines whether 16 Level is activated (ON) or not (OFF). 

• Pad is the pad that will be copied to all 16 of them. (You can simply press the pad to select it, but Active 
must be set to OFF first.) 

• Type is the parameter that will vary in value across all 16 pads: Velocity, Tune, Filter, Layer, Attack, or 
Decay.  

If you select Tune, use the Original Pad field to select which you pad you want to use the original pitch 
of the sample/samples. Alternatively, hold Shift and press the desired pad. 

When Type is set to Layer, pads with multiple samples will play back each layer according to the 
Velocity Start and Velocity End settings for each layer. 

3. Press F5/Close to the previous screen. 



  

 
51 

 

 
Pad Assign 
 

Pad Assign enables you to assign samples and specific colors to your pads in each program. 

 
 

 

 

 

 
 
To use Pad Assign: 

1. Press Pad Assign. 

2. Use the fields in the screen that appears: 

Program is the currently selected program whose pads are shown in the 16 fields below. 

Style determines how the pad lights will display: 

• OFF: The pads will be unlit whether you are playing them or not. 

• VELO: The pads will be unlit while you are not playing them. When you press them, they will light 
with colors according to the velocity: red indicates a high velocity, yellow indicates a low velocity. 

• FIXED: The pads will be lit with their assigned colors whether you are playing them or not. 

• OFF->V: The pads will be unlit when you are not playing them. When you press them, they will light 
with their assigned color with a brightness that corresponds with the velocity. 

• DIM->V: The pads will be dimly lit when you are not playing them. When you press them, they will 
light with their assigned color with a brightness that corresponds with the velocity. 

• BRI->V: The pads will be brightly lit when you are not playing them. When you press them, they will 
light with their assigned color with a brightness that corresponds with the velocity. 

Pad determines whether you are setting the color for one pad (SINGLE) or all pads (ALL). 

The pads are shown in a 4x4 array with the names of their assigned samples or their colors, depending on 
the tab selected at the bottom of the screen. 

To view more pads, use the Pad Bank buttons. 

To assign samples to the pads, press F1/Sample to select the Sample tab. Use the field in each pad 
to select a sample from your project’s sample pool. You can also select a pad by pressing it. 

To assign colors to the pads, press one of the F2–F5 buttons to select the corresponding color. Press 
each pad to assign or un-assign that color. 

F6/>Default makes the current pad color settings the defaults for all programs on the same type (e.g., drum 
programs, keygroup programs, etc.). In the screen that appears, press F4/Do it to confirm your choice or 
F3/Cancel to return to the previous screen without saving the settings as defaults. 

3. Press a mode button to enter any other mode. 
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Pad Copy 
 

You can use the Pad Copy function to copy the samples and parameters from one pad to another. 

 

 

 

To copy one pad to another: 

1. Press and hold Shift+Pad Assign/Pad Copy.  

2. In the Copy Pad window that appears, use the From Pad field to select the “source” pad. Alternatively, press 
the “source” pad (when this field is selected). 

3. Use the cursors to select the To Pads field, and then press the “destination” pads. 

4. Press F5/Do It to continue. The samples and parameters will be copied automatically from the source pad to the 
destination pad/pads. 

Alternatively, press F4/Close to cancel the operation and return to the previous screen. 
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Erase 
 

The Erase function erases all or part of a track in a specific sequence. 

 

 

 

 

 

To use the Erase function: 

1. Press Erase. 

2. Use the fields in the screen that appears: 

Sequence determines the sequence containing the track whose events you want to erase (partially or entirely). 

Track determines the track whose events you want to erase (partially or entirely). 

Time and To define the time range of the track whose events you want to erase (partially or entirely). Time is 
the start of the time range, and To is the end. 

Erase determines what types of events you will erase: 

• All erases all pad events from the designated time range and reset all of its settings. 

• Automation erases only automation from the designated time range. Use the Parameter field to 
select what type of automation to erase, or select All to erase all automation from the designated 
time range. 

• Note erases only specific pad events from the designated time range. Press each pad (in each bank) 
to select or deselect its notes, which will appear in the Notes field below. 

• Except Note erases everything except pad events from the designated time range. Press each pad 
(in each bank) to select or deselect its notes, which will appear in the Notes field below. 

3. Press F5/Do It to erase the events, or press F4/Back to return to the previous screen without erasing anything. 
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Edit Sequence 
 

You can use the Edit Sequence screen to make changes to your currently selected sequence. These functions are 
described below. All options in the screen will work for MIDI tracks, but some of them will not work for audio tracks. 

 

To enter the Edit Sequence screen, press Seq Edit. 

 

 
 
To select an editing function, press the corresponding pad (Pad 1–8) or press the corresponding button on the 
numeric keypad. 

To exit the screen, press F4/Back to return to Main Mode, or press another mode button. 

 

In the screen for each editing function, use the cursors to select each field, and then use the data dial or –/+ buttons 
to change the parameter. If the field is a number, you can use the numeric keypad to enter a number and then press 
Enter to confirm it. 

 
 

 
 
The Insert Blank Bars function adds empty bars to a sequence at a specified point. 

Sequence determines the sequence to which you want to add empty bars. 

Number Of Bars determines how many empty bars you will add. 

Time Sig determines the time signature of the empty bars (one field for the number of beats, one field for the 
note value). 

Before Bar is the bar before which the empty ones will be inserted. 

F5/Do It inserts the bars. 

F4/Back returns to the previous screen without making any changes. 

 

 
 
The Delete Bars function removes a range of bars from a sequence. 

Sequence determines the sequence containing the track whose bars you want to delete. 

First Bar and Last Bar define the range of bars in the track whose events you want to delete. First Bar is the 
start of the range, and Last Bar is the end. 

F5/Do It deletes the bars. 

F4/Back returns to the previous screen without making any changes. 
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The Copy Bars function copies a range of bars from a sequence and adds them to another at a specified point. 

The first Sequence field is the “source” sequence whose bars you want to copy. 

First Bar and Last Bar define the range of bars you want to copy in the source sequence. First Bar is the start 
of the range, and Last Bar is the end. 

The second Sequence field is the “destination” sequence where the source sequence bars will be copied. 

After Bar is the bar after which the new ones will be inserted. 

Copies determines how many instances of the copied bars you will add. 

F4/Replace overwrites the destination sequence. 

F5/Merge adds the events to the destination sequence without erasing anything. 

F3/Back returns to the previous screen without making any changes. 

 
 

 

 
The Copy Events function copies the content of a track from a sequence and adds them to a track in another 
sequence at a specified point. 

The first Sequence field is the “source” sequence containing the track whose content you want to copy. 

The first Track field is the “source” track whose content you want to copy. 

The Pads or Notes field lets you select specific events to copy. Press the pads to select the pads or notes to 
copy from. 

Time and To define the time range of the track whose content you want to copy. Time is the start of the time 
range, and To is the end. 

The second Sequence field is the “destination” sequence containing the track where the source track’s content 
will be copied. 

The second Track field is the “destination” track where the source track’s content will be copied. 

Time is the location in the sequence where the content will be copied. 

Copies determines how many instances of the copied content you will add. 

The lower-right field determines what events will be copied (available for MIDI tracks only): 

• All Events copies the notes in the time range determined by the Time and To fields above. 

• Only Selected copies only the currently selected events. 

F4/Replace overwrites the destination sequence. 

F5/Merge adds the events to the destination sequence without erasing anything. 

F3/Back returns to the previous screen without making any changes. 
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The Copy a Sequence function copies the contents of one sequence to another. 

Copy Contents of Sequence is the “source” whose events you want to copy. 

Over Contents of Sequence is the “destination” sequence where the source sequence will be copied. 

F5/Do It copies the sequence. 

F4/Back returns to the previous screen without making any changes. 

 

 

 

 

 

 

The Transpose function transposes a range of events on a track in a sequence. The events within that range will 
shift accordingly in the Grid View. This option is available for MIDI tracks only. 

Sequence determines the sequence containing the track whose events you want to transpose. 

Track determines the track whose events you want to transpose. 

Time and To define the time range of the track whose events you want to transpose. Time is the start of the time 
range, and To is the end. 

For drum programs: 

Change Pad is the “source” pad (whose events you want to transpose). 

To Pad is the “destination” pad (where the events will be placed). 

For keygroup programs, plugin programs, and MIDI programs: 

Range consists of two fields that define the range of notes of the events you want to transpose. Note events 
within this range will be transposed, while note events outside of this range will remain unchanged. 

Transpose determines how many semitones up or down you want to transpose the note events. 

F5/Do It tranposes the events. 

F4/Back returns to the previous screen without making any changes. 
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The Erase function erases all or part of a track in a specific sequence. 

Sequence determines the sequence containing the track whose events you want to erase (partially or entirely). 

Track determines the track whose events you want to erase (partially or entirely). 

Time and To define the time range of the track whose events you want to erase (partially or entirely). Time is the 
start of the time range, and To is the end. 

Erase determines what types of events you will erase: 

• All erases all pad events from the designated time range and reset all of its settings. 

• Automation erases only automation from the designated time range. Use the Parameter field to select 
what type of automation to erase, or select All to erase all automation from the designated time range. 

• Note erases only specific pad events from the designated time range. Press each pad (in each bank) to 
select or deselect its notes, which will appear in the Notes field below. 

• Except Note erases everything except pad events from the designated time range. Press each pad (in 
each bank) to select or deselect its notes, which will appear in the Notes field below. 

F5/Do It erases the events. 

F4/Back returns to the previous screen without making any changes. 

 

 
 

 
 

The Copy Track function copies the contents of one track to another within the same sequence. 

The first Track field is the “source” track whose content you want to copy. 

The second Track field is the “destination” track where the source track’s content will be copied. 

F5/Do It copies the track. 

F4/Back returns to the previous screen without making any changes. 
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Effects 
 

You can apply various effects to the pads, keygroups, audio tracks, programs, submixes, and master outputs, using 
insert and send/return effects. This chapter can help you get a good overall understanding of how the effects work. 

 

See Appendix > Effects & Parameters for a list of all available effects (with a brief description of each) and their 
editable parameters. 

 

 

Overview 

 

In a program, each pad or keygroup can have up to four insert effects applied to it. See Insert Effects > Pads or 
Keygroups to learn more about this. 

 

An entire program or audio track can also have up to four insert effects applied to it, as well. See Insert Effects > 
Programs or Audio Tracks to learn more about this. 

 

For even further flexibility, each submix can have up to four insert effects applied to it. You can route pads, 
keygroups, audio tracks, or programs to a submix, which is then routed to a master output. See Insert Effects > 
Submixes to learn more about this. 

 

Additionally, each pad, keygroup, audio track, program, and submix can each be sent to (up to) four return 
channels, each of which can have up to four insert effects of their own. Their audio will be routed through the insert 
effects on those returns, and the processed audio will be sent to a master output. See Send/Return Effects to learn 
more about this. 

 

Finally, you can apply up to four insert effects to each master output (a stereo pair of channels: Outputs 1/2, 
Outputs 3/4, etc.). See Insert Effects > Master Outputs to learn more about this. 

 

When you create an audio mixdown of a sequence or song, you can choose whether or not master insert effects are 
included or send/return effects are included, depending on what you are mixing down: 

If you are creating an audio mixdown of a pair of master outputs, you can choose whether or not master insert 
effects will be included in the mixdown. 

If you are creating an audio mixdown of separate programs or exploded tracks, you can choose whether or 
not send/return effects will be included in the mixdown. 

To see the user guide in the MPC software and learn about this, click the Help menu, select MPC Help, and select 
MPC User Manual. 

 

There are two other modes that handle effects differently: 

• Sample Record Mode can use up to four insert effects, which are applied to the audio as you record it. 
This means that the effects cannot be “removed” from the sound later. Learn more about this in the Modes > 
Sample Record Mode chapter. 

• Similarly, the Looper can use up to four insert effects, which are applied to the audio as you record it. This 
means that the effects cannot be “removed” from the sound later. Learn more about this in the Modes > 
Looper chapter. 
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When viewing effect slots (empty or loaded), you will see either all four slots at once or one slot at a time across four tabs: 

 

 
 

 
 

 
 

To load an effect to a slot or to change a slot’s loaded effect, use the cursors to select the field for that insert 
slot, and then use the data dial or –/+ buttons to enter the Select Effect screen (described below). 

To edit the parameters of a loaded effect, use the cursors to select the field for that insert slot, and then press 
Window to enter the effect’s parameter screen (described below). 

To clear the insert slot, load an effect as described above, but select the <none> option. 

To enable or disable an effect, turn its corresponding Q-Link knob while viewing an Insert tab in the Pad Mixer 
or Channel Mixer. 

To enable or disable all four effect slots, use the cursors to select Inserts in the upper-right corner (if it is shown), 
and then use the data dial or –/+ buttons to select On or Off (respectively). 

 

 

When selecting an effect, you will see the Select Effect screen: 

 

 
 

To move through the list, use the data dial or –/+ buttons.  

To load an effect, press F4/Select. 

To return to the previous screen without loading an effect, press F3/Back. 
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When editing an effect, you will see this screen: 

 

 

 

To adjust a parameter, use the cursors to select its field, and then use the data dial or –/+ buttons to change 
it. Alternatively, turn the corresponding Q-Link knob. 

To select another page of parameters, use the cursors to select Params in the upper-right corner, and then 
use the data dial or –/+ buttons to change which parameters you are viewing. 

To enable or disable the effect, press F6/On/Off. 

To return to the previous screen, press F4/Close. 
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Insert Effects 

This section describes the different ways to load insert effects to pads, keygroups, audio tracks, programs, submixes, 
and master outputs. 

 

 

Pads 

You can load up to four insert effects to each pad in a drum program or clip program. You can do this in Program Edit 
Mode or the Pad Mixer. 

Tip: When using pad insert effects, they will be applied to the selected pad only. This means that you could apply 
unique combinations of effects to each pad within a program. If you want to apply the same effect to all pads, do this 
with a program insert effect (see Insert Effects > Programs). 

 

 

 

 

To load a pad insert effect in Program Edit Mode: 

1. Press Prog Edit to enter Program Edit Mode. 

2. Use the cursors to select Program, and turn the data dial or –/+ buttons to select the desired program. 

3. Press the desired pad to select it. 

4. Press F6/Effects. 

5. Use the cursors to select the desired insert slot. 

6. Turn the data dial or –/+ buttons to open the Select Effect screen to select and load an effect. 

 

 

 

 

To load a pad insert effect in the Pad Mixer: 

1. Press Prog Mix to enter the Pad Mixer. 

2. Use the cursors to select Program, and turn the data dial or –/+ buttons to select the desired program. 

Alternatively, use the cursors to select Track, and turn the data dial or –/+ buttons to select the desired track—
the program it uses will be selected automatically. 

3. Press F5/Insert to select the desired insert slot. 

4. Press the desired pad to select it, or use the cursors to select its field. 

5. Turn the data dial or –/+ buttons to open the Select Effect screen to select and load an effect. 

Turn the Q-Link knobs to turn their corresponding effects on or off. 
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Keygroups 

You can load up to four insert effects to each keygroup in a keygroup program. You can do this in Program Edit 
Mode or the Pad Mixer. 

Important: When using keygroup insert effects, they will be applied to that keygroup only. Keep this in mind if you 
load insert effects to multiple keygroups with overlapping note ranges—the effects will overlap in that range as well.  

 

 

 

 

To load a keygroup insert effect in Program Edit Mode: 

1. Press Prog Edit to enter Program Edit Mode. 

2. Use the cursors to select Program, and turn the data dial or –/+ buttons to select the desired program. 

3. Press a pad to select the keygroup it belongs to, or press F1/Master and then use the Kg Select field. 

4. Press F6/Effects. 

5. Use the cursors to select the desired insert slot. 

6. Turn the data dial or –/+ buttons to open the Select Effect screen to select and load an effect. 

 

 

 

 

To load a keygroup insert effect in the Pad Mixer: 

1. Press Prog Mix to enter the Pad Mixer. 

2. Use the cursors to select Program, and turn the data dial or –/+ buttons to select the desired program. 

Alternatively, use the cursors to select Track, and turn the data dial or –/+ buttons to select the desired track—
the program it uses will be selected automatically. 

3. Press F5/Insert to select the desired insert slot. 

4. Press a pad to select the keygroup it belongs to, or use the cursors to select its field. 

5. Turn the data dial or –/+ buttons to open the Select Effect screen to select and load an effect. 

Turn the Q-Link knobs to turn their corresponding effects on or off. 
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Audio Tracks 

You can load up to four insert effects to each audio track. You can do this in Main Mode and the Channel Mixer. 

 

 

 

 

 

 

To load an audio track insert effect in Main Mode: 

1. Press Main to enter Main Mode. 

2. Press F2/Audio to view your audio tracks in Main Mode. 

3. Use the cursors to select Trk, and then use the data dial, –/+ buttons, or numeric keypad to select the desired 
audio track. Alternatively, press F3/Track– or F4/Track+. 

4. Use the cursors to select the parameter in the lower-right corner. This varies depending on the last parameter 
you adjusted in its sub-window. 

5. Press Window. 

6. Use the cursors to select the desired insert slot. 

7. Turn the data dial or –/+ buttons to open the Select Effect screen to select and load an effect. 

 

 

 

 

To load an audio track insert effect in the Channel Mixer: 

1. Press Shift+Prog Mix/Track Mix to enter the Channel Mixer. 

2. Use the cursors to select Mixer, and turn the data dial or –/+ buttons to select Audio Tracks. 

3. Press F5/Insert to select the desired insert slot. 

4. Use the cursors to select the corresponding field for the desired audio track. 

5. Turn the data dial or –/+ buttons to open the Select Effect screen to select and load an effect. 

Turn the Q-Link knobs to turn their corresponding effects on or off. 
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Programs 

You can load up to four insert effects to each program. You can do this in Main Mode, the Step Sequencer, and the 
Channel Mixer. In Main Mode, you can load insert effects for drum, keygroup, clip, and plugin programs only. In the 
Channel Mixer, you can load insert effects for drum, keygroup, or clip programs only. 

 

 

 

 

 

 

To load a program insert effect in Main Mode: 

Note: In Main Mode, you can load insert effects for drum, keygroup, clip, or plugin programs. MIDI and CV programs 
do not use insert effects. 

1. Press Main to enter Main Mode. 

2. Press F1/Midi to view your MIDI tracks in Main Mode. 

3. Use the cursors to select Trk, and then use the data dial, –/+ buttons, or numeric keypad to select the track 
with the desired program. Alternatively, press F3/Track– or F4/Track+. 

4. Use the cursors to select the parameter in the lower-right corner. This varies depending on the last parameter 
you adjusted in its sub-window. 

5. Press Window. 

6. Use the cursors to select the desired insert slot. 

7. Turn the data dial or –/+ buttons to open the Select Effect screen to select and load an effect. 
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To load a program insert effect in the Step Sequencer: 

Note: In the Step Sequencer, you can load insert effects for drum, keygroup, clip, or plugin programs. MIDI and CV 
programs do not use insert effects. 

1. Press Step Seq to enter the Step Sequencer. (If you cannot enter it because you are viewing audio tracks, press 
Main and then press F1/Midi to view MIDI tracks first.) 

2. Use the cursors to select Trk, and then use the data dial, –/+ buttons, or numeric keypad to select the track 
with the desired program. Alternatively, press F3/Track– or F4/Track+. 

3. Use the cursors to select the parameter in the lower-right corner. This varies depending on the last parameter 
you adjusted in its sub-window. 

4. Press Window. 

5. Use the cursors to select the desired insert slot. 

6. Turn the data dial or –/+ buttons to open the Select Effect screen to select and load an effect. 

 

 

 

 

To load a program insert effect in the Channel Mixer: 

Note: In the Channel Mixer, you can load insert effects for drum, keygroup, or clip programs—not plugin programs. 
MIDI and CV programs do not use insert effects. 

1. Press Shift+Prog Mix/Track Mix to enter the Channel Mixer. 

2. Use the cursors to select Mixer, and turn the data dial or –/+ buttons to select Programs. 

3. Press F5/Insert to select the desired insert slot. 

4. Use the cursors to select the corresponding field for the desired program. 

5. Turn the data dial or –/+ buttons to open the Select Effect screen to select and load an effect. 

Turn the Q-Link knobs to turn their corresponding effects on or off. 
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Submixes 

You can load up to four insert effects to each submix. You can do this in the Channel Mixer only. 

 

 

 

To load a submix insert effect in the Channel Mixer: 

1. Press Shift+Prog Mix/Track Mix to enter the Channel Mixer. 

2. Use the cursors to select Mixer, and turn the data dial or –/+ buttons to select Submixes. 

3. Press F5/Insert to select the desired insert slot. 

4. Use the cursors to select the corresponding field for the desired submix. 

5. Turn the data dial or –/+ buttons to open the Select Effect screen to select and load an effect. 

Turn the Q-Link knobs to turn their corresponding effects on or off. 
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Master Outputs 

You can load up to four insert effects to each master output (a stereo pair of channels: Outputs 1/2, Outputs 3/4, 
etc.). You can do this in the Channel Mixer or in the Effects screen. 

 

 

 

 

To load a master insert effect in the Channel Mixer: 

1. Press Shift+Prog Mix/Track Mix to enter the Channel Mixer. 

2. Use the cursors to select Mixer, and turn the data dial or –/+ buttons to select Outputs. 

3. Press F5/Insert to select the desired insert slot. 

4. Use the cursors to select the corresponding field for the desired master output. 

5. Turn the data dial or –/+ buttons to open the Select Effect screen to select and load an effect. 

Turn the Q-Link knobs to turn their corresponding effects on or off. 

 

 

 

 

To load a master insert effect in the Effects screen: 

1. Press Shift+Seq Edit/Effects to enter Effects screen. 

2. Use the cursors to select Outputs, and turn the data dial or –/+ buttons to select the desired master output. 

3. Use the cursors to select the desired insert slot (Insert 1–4). 

4. Turn the data dial or –/+ buttons to open the Select Effect screen to select and load an effect. 
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Send/Return Effects 

 

Send/return effects work in the following way: 

1. A pad, keygroup, audio track, program, or submix sends its audio to a return at a designated send level. 

2. That audio is processed by the effects on the return. Each return can have up to four insert effects loaded and 
activated. 

3. The processed audio is sent to a pair of master outputs (stereo) or a single master output (mono). 

 

You can load send/return effects and set return levels only in the Channel Mixer, described below. The rest of this section 
describes the different ways to set the desired send levels for pads, keygroups, audio tracks, programs, or submixes. 

 

 

 

 

To load a send/return effect to a return: 

1. Press Shift+Prog Mix/Track Mix to enter the Channel Mixer. 

2. Use the cursors to select Mixer, and turn the data dial or –/+ buttons to select Returns. 

3. Press F5/Insert to select the desired insert slot. 

4. Use the cursors to select the corresponding field for the desired return channel. 

5. Turn the data dial or –/+ buttons to open the Select Effect screen to select and load an effect. 

Turn the Q-Link knobs to turn their corresponding effects on or off. 

 

 

 

 

To set the return level: 

1. Press Shift+Prog Mix/Track Mix to enter the Channel Mixer. 

2. Use the cursors to select Mixer, and turn the data dial or –/+ buttons to select Returns. 

3. Press F1/Level to select the desired insert slot. 

4. Use the cursors to select the corresponding field for the desired return channel. 

5. Turn the data dial or –/+ buttons to set the return level. 

Alternatively, turn the corresponding Q-Link knob to set the return level for each insert slot. 
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Pads 

You can set the send levels for pads in Program Edit Mode or the Pad Mixer. 

 

 

 

 

To set the send levels for a pad in Program Edit Mode: 

1. Press Prog Edit to enter Program Edit Mode. 

2. Use the cursors to select Program, and turn the data dial or –/+ buttons to select the desired program. 

3. Press the desired pad to select it. 

4. Press F6/Effects. 

5. Use the cursors to select the desired send level (Send 1–4). 

6. Turn the data dial or –/+ buttons to adjust the send level. 

Alternatively, turn the corresponding Q-Link knob (4, 8, 12, or 16 on MPC Renaissance or the fourth column of 
Q-Link knobs on MPC Studio) to adjust the level immediately for each send channel. 

 

 

 

 

To set the send levels for a pad in the Pad Mixer: 

1. Press Prog Mix to enter the Pad Mixer. 

2. Use the cursors to select Program, and turn the data dial or –/+ buttons to select the desired program. 

Alternatively, use the cursors to select Track, and turn the data dial or –/+ buttons to select the desired track—
the program it uses will be selected automatically. 

3. Press F4/Send to select the desired send channel. 

4. Press a pad to select it, or use the cursors to select its field. 

5. Turn the data dial or –/+ buttons to adjust the send level. 

Alternatively, turn the corresponding Q-Link knob to adjust the send level immediately for each pad. 
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Keygroups 

You can set the send levels for keygroups in Program Edit Mode or the Pad Mixer. 

 

 

 

 

To set the send levels for a keygroup in Program Edit Mode: 

1. Press Prog Edit to enter Program Edit Mode. 

2. Use the cursors to select Program, and turn the data dial or –/+ buttons to select the desired program. 

3. Press the desired pad to select the keygroup it belongs to, or press F1/Master and then use the Kg Select field. 

4. Press F6/Effects. 

5. Use the cursors to select the desired send level (Send 1–4). 

6. Turn the data dial or –/+ buttons to adjust the send level. 

Alternatively, turn the corresponding Q-Link knob (4, 8, 12, or 16 on MPC Renaissance or the fourth column of 
Q-Link knobs on MPC Studio) to adjust the level immediately for each send channel. 

 

 

 

 

To set the send levels for a keygroup in the Pad Mixer: 

1. Press Prog Mix to enter the Pad Mixer. 

2. Use the cursors to select Program, and turn the data dial or –/+ buttons to select the desired program. 

Alternatively, use the cursors to select Track, and turn the data dial or –/+ buttons to select the desired track—
the program it uses will be selected automatically. 

3. Press F4/Send to select the desired send channel. 

4. Press a pad to select the keygroup it belongs to, or use the cursors to select its field. 

5. Turn the data dial or –/+ buttons to adjust the send level. 

Alternatively, turn the corresponding Q-Link knob to adjust the send level immediately for each keygroup. 
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Main Mode 
 

Main Mode gives you an overview of the most-used functions.  

 

To enter Main Mode, press Main.  

 

 

 

 

Use the cursors to select each field, and then use the data dial or –/+ buttons to change the parameter. If the field is 
a number, you can use the numeric keypad to enter a number and then press Enter to confirm it. 

Some information shown on this screen is common to both MIDI tracks and audio tracks (described below), while 
other information is used for MIDI tracks only (see MIDI Tracks) or audio tracks only (see Audio Tracks). 

 

 

Now is the time counter at the top of the screen, which shows the current playhead position. (If the Auto Record 
feature is on, Punch In or Seq Start will be shown next to the time.) See General Features > Now & Locators to 
learn about this.  

 

Seq is the current sequence number and its name. 

To select a sequence, use this field. 

To edit the sequence, select this field and then press Window. Use the fields in the Edit Current Sequence 
screen that appears: 

• F2/Clear clears all events from the sequence and resets all of its settings. Press F4/Clear to continue or 
F3/Cancel to return to the previous screen. 

• F3/Double immediately doubles the sequence in length and copies all events from the first half to the 
second half. 

• F4/Copy copies the contents of one sequence to another. Copy Contents of Sequence is the “source” 
whose events you want to copy. Over Contents of Sequence is the “destination” sequence where the 
source sequence will be copied. Select each field, and then use the numeric keypad, data dial, or –/+ 
buttons to select a sequence. Press F5/Do It to continue or F4/Back to return to the previous screen. 

• F5/Close returns to the previous screen. 

 

BPM is the tempo of the sequence.  

To set the tempo, press Tap Tempo in time with the desired tempo. Alternatively, use this integer or decimal 
field. 

To set whether the sequence follows its own tempo (seq) or a master tempo (mst), press Shift+Tap Tempo. 
Alternatively, select seq/mst, and then use the data dial or –/+ buttons. 

 

Bars is the length of the sequence in bars. 

To set the number of bars, use this field. 
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Loop determines whether or not the sequence (or a part of it) will loop. 

To enable or disable looping, set this field to ON or OFF (respectively). 

To set the start point and end point of loop, select this field, and then press Window. In the Loop Measures 
screen that appears: 

First Bar is the first bar of the loop. 

Last Bar is the last bar of the loop. 

Number of Bars is the total number of bars in the sequence. 

 F5/Close returns to the previous screen. 

 

The level meter in the upper-right corner shows the current volume level of the master mix. 

 

 

MIDI Tracks 
 

These are the buttons under the screen for MIDI tracks: 

F1 Midi Press this button to view your MIDI tracks in Main Mode.

F2 Audio Press this button to view your audio tracks in Main Mode.

F3 Track– Press this button to select the previous track.

F4 Track+ Press this button to select the next track.

F5 Mute Press this button to mute the current track.

F6 Solo Press this button to solo the current track.

Shift+F1 T.C. Press these buttons to open the Timing Correct/T.C. screen, which contains various 
settings to help quantize the note events in your sequence. See General Features > 
Timing Correct/T.C. to learn about this. 

Shift+F2 Click Press these buttons to open the Click/Metronome screen, which contains all settings 
regarding the metronome (click track). See General Features > Click/Metronome to learn 
about this. 

 

Tran is the transposition (in semitones) of the entire sequence: -24 to +24. Off indicates no transposition (0 semitones). 

To set the transposition, use this field. 

 

The In and Out boxes show that your MPC hardware is receiving or sending (respectively) MIDI messages from or to 
your computer. 

 

16 track indicators are arranged in a 4x4 grid of dots or squares next to the In and Out boxes. Dots indicate 
empty/unused tracks. Solid squares indicate used tracks. The outlined square indicates the currently selected track. 

To select a track, use the Trk field. Alternatively, press F3/Track– or F4/Track+. 

 

Trk is the current track number and its name. 

To select a track, use the Trk field. Alternatively, press F3/Track– or F4/Track+. 

To edit the track, select this field, and then press Window. In the Edit Current Track screen that appears: 

• F2/Clear clears all events from the track and resets all of its settings. Press F4/OK to continue or F3/Cancel 
to return to the previous screen. 
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• F3/Explode immediately splits the current track into multiple tracks—one for each distinct pad or note 
(pitch, not event). The current track will also remain present and intact, while each track created from it is 
labeled with the track name and pad name or number. 

• F4/Copy copies the contents of one track to another. Copy Contents of Track is the “source” track 
whose events you want to copy. Over Contents of Track is the “destination” track where the source 
track will be copied. Set each field to the desired track. Press F5/Do It to continue or F4/Back to return 
to the previous screen. 

• F5/Close returns to the previous screen. 

 

Length determines how long the track is in beats. If you select the minimum value, Seq (or 0), the track will be the 
exact same length as its sequence. 

Tip: This feature lets you maintain tracks of different lengths. For instance, you could play a 1-bar drum sequence 
repeatedly under a 4-bar bass line. 

To set the track length, use this field. 

 

Type is the type of program through which the track is being routed. The specific program name is in the Pgm field. 

To select a program type, use this field to select a drum program (Drum), plugin program (Plugin), MIDI 
program (Midi), keygroup program (KGrp), clip program (Clip), or CV program (CV). 

The screen may show additional fields, depending on the type of program: 

• Drum Program: (no additional fields) 

• Plugin Program: 

Note: You have to specify the disk directory where your plugins are located. This can be done in the 
software’s Preferences. To see the user guide in the MPC software and learn how to do this, click 
the Help menu, select MPC Help, and select MPC User Manual. 

Plg is the preset (if any) within the plugin the program is using. 

To select a preset, select this field, and then press Window. In the screen that appears, select 
the desired preset, and press F5/Select to continue or F4/Close to return to the previous 
screen. You can press F2/AutoSel to activate or deactivate automatic selection, which will 
automatically load each preset as you move through the list. 

Ch is the MIDI channel the program uses. Use this setting when you are working with a virtual 
instrument plugin that supports multi-mode. 

To select a MIDI channel, use this field. 

• MIDI Program: 

Port is the port over which the program sends its MIDI data. 

Note: You also have to configure the MIDI ports in the Preferences. To see the user guide in the 
MPC software and learn how to do this, click the Help menu, select MPC Help, and select MPC 
User Manual. 

To select a port, use this field. 

PC is the program change message the program sends out. 

To select a program change message, use this field. 

To set the MSB and LSB (Most Significant Byte and Least Significant Byte), select this field, and 
then press Window. In the screen that appears, set Bank Enable to ON or OFF. When set to 
ON, select the Bank MSB or Bank LSB values. Press F4/Close to return to the previous screen. 

Ch is the MIDI channel the program uses. Use this setting when you are working with a virtual 
instrument plugin that supports multi-mode. 

To select a MIDI channel, use this field. 

• Keygroup Program: (no additional fields) 
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• Clip Program: (no additional fields) 

• CV Program: 

Port is the port over which the program sends its MIDI data. 

Note: You also have to configure the MIDI ports in the Preferences. To see the user guide in the 
MPC software and learn how to do this, click the Help menu, select MPC Help, and select MPC 
User Manual. 

To select a port, use this field. 

PC is the program change message the program sends out. 

To select a program change message, use this field. 

To set the MSB and LSB (Most Significant Byte and Least Significant Byte), select this field, and 
then press Window. In the screen that appears, set Bank Enable to ON or OFF. When set to 
ON, select the Bank MSB or Bank LSB values. Press F4/Close to return to the previous screen. 

Ch is the MIDI channel the program uses. Use this setting when you are working with a virtual 
instrument plugin that supports multi-mode. 

To select a MIDI channel, use this field. 

 

Pgm is the program used by the current track. 

To select a program, use this field. 

To edit the program, select this field, and then press Window. In the Edit Program screen that appears: 

• F2/Delete erases all events from the track and resets all of its settings. Press F4/Delete to continue or 
F3/Cancel to return to the previous screen. 

• F3/New creates a new program. New Name is the name that the new program will use. Use the Type 
field to determine the type of program. 

• F4/Copy immediately creates an identical program. The duplicate program will use the same name but 
appended with a number (e.g., Drums-1). 

• F5/Close returns to the previous screen. 

 

The parameter in the lower-right corner varies depending on the last parameter you adjusted in its sub-window.  

 

 

 

 

 
To adjust the parameter, use this field. 

To edit the parameters in its sub-window, select this field, and then press Window. Use the fields and buttons 
in the screen that appears (MIDI programs or CV programs will show only the fields under the Track column): 
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Level is the volume level of the program (if it is under Program) or track (if it is under Track). (You can also 
use the numeric keypad to change this number.) 

Pan is the panning position of the program (if it is under Program) or track (if it is under Track) in the stereo 
field: 50 L (left) to 50 R (right). C indicates the center position. (If you use the numeric keypad to change this 
number, use values from 0 to 100: 0 corresponds to 50 L, 50 corresponds to C, and 100 corresponds to 50 R.) 

Mute determines whether or not the program is muted (Mute) or not (____). 

Automation is the program’s automation status. 

When off (x), the program will ignore automation data. If you have already recorded or entered 
automation, this will switch between Read (R) and Write (W) only, but you can override this and turn it off 
by pressing and holding Shift while pressing the button. 

Important: If you have already recorded automation and turn it off, the track will still use the effect and 
its parameter values at the point where you turned it off. 

When set to Read (R), the program will read automation data but will not record any additional automation 
over it. (Think of this as a protective feature to prevent accidental changes to your automation while 
recording.) 

When set to Write (W), the program can record automation. (If you have any Q-Link knobs assigned to 
automatable parameters, make sure not to touch any accidentally while you are recording.) 

Tip: See General Features > Automation to learn about setting global automation or automation for 
individual programs and audio tracks. 

Send1–4 show the send levels of the program (0–100). 

Inserts 1–4 show the insert effects loaded to the program. 

To load an effect, use its Insert field. Select an effect in the Select Effect screen that appears. Press 
F4/Select to load the selected effect or F3/Back to return to the previous screen. 

To change the settings of a loaded effect, select its Insert field, and press Window. In the screen that 
appears, you can select and change each parameter (you can use the numeric keypad on some of them). 
Press F4/Close to return to the previous screen. 

To activate or deactivate an effect, select its Insert field, and press Window. In the screen that appears, 
press F6/On/Off to activate or deactivate the effect. Press F4/Close to return to the previous screen. 

Tran is the transposition (in semitones) of the track: -24 to +24. Off indicates no transposition (0 semitones). 

Vel% determines how loudly or quietly a track plays relative to its recorded levels. When set to 50%, the 
track will be played with half the velocity it was originally played. When set to 200%, the track will play twice 
as loud. The maximum velocity level is still 127, though. 

F4/Close returns to the previous screen without confirming your changes. 

F5/Set confirms your changes and returns to the previous screen. 

 

 

Audio Tracks 
 

These are the buttons under the screen for audio tracks: 

F1 Midi Press this button to view your MIDI tracks in Main Mode.

F2 Audio Press this button to view your audio tracks in Main Mode.

F3 Track– Press this button to select the previous track.

F4 Track+ Press this button to select the next track.

F5 Mute Press this button to mute the current track.

F6 Solo Press this button to solo the current track.
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Sample Edit Mode 
 

Sample Edit Mode lets you edit samples in three different sub-modes: Trim Mode, Chop Mode, or Program Mode. 
Each mode has slightly different functions and methods of operation. Please refer to the Trim Mode, Chop Mode, 
and Program Mode parts of this chapter to learn how each works. 

To enter Sample Edit Mode, press Sample Edit. 

 

 

 

 

 

 

 

Use the cursors to select each field, and then use the data dial or –/+ buttons to change the parameter. If the field is 
a number, you can use the numeric keypad to enter a number and then press Enter to confirm it. 

Some information shown on this screen is common to all Sample Edit Modes, while other information is used for 
Trim Mode only, Chop Mode only, or Program Mode only. 

 

Tip: You can use Trim Mode for a specific slice of the sample, previously created and selected in Chop Mode. This 
allows for a more detailed view of a single slice than in Chop Mode and gives you more options for auditioning the 
slice. You can easily switch between Trim Mode and Chop Mode while doing this. 

 

To use both Trim Mode and Chop Mode to edit a sample slice: 

1. Press F1/Trim/Chop so it shows the Chop tab (Chop Mode). 

2. Set all fields as desired to create your sample slices. 

3. Set Slice to the desired slice. 

4. Press F1/Trim/Chop so it shows the Trim tab (Trim Mode). The region you are now editing is indicated by the 
normal start point and end point markers rather than slice markers. 

5. Press F1/Trim/Chop so at any time to return to the Chop tab (Chop Mode). 
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Trim Mode 

 

We recommend using Trim Mode to simply crop the start and/or end from a sample. 

To enter Trim Mode, press F1/Trim/Chop. 

 

 

 

These are the buttons under the screen in Trim Mode:  

F1 Trim Press this button to switch between Trim Mode and Chop Mode. See Chop Mode to 
learn about it. 

F2 Program Press this button to enter Program Mode. See Program Mode to learn more. 

F3 Zoom Out Press this button to zoom out of the waveform.

F4 Zoom In Press this button to zoom in on the waveform.

F5 Assign Press this button to show the Assign Sample screen, where you can assign the sample 
to a program or pad. See Trim Mode > Assigning Samples to learn more. 

F6 Process Press this button to show the Process Slice screen, where you can select different ways in 
which to process the slice. See Trim Mode > Processing Slices & Samples to learn more. 

Shift+F3 0 Snap Press these buttons to activate or deactivate 0 Snap, which forces start points, end
points, and loop points to occur only at the waveform’s “zero-crossings.” This can help 
prevent clicks and glitches when playing a sample. 

Shift+F4 Loop Press these buttons to switch the loop function between Fwd and Off. See the loop 
function described here. 

 

 

Sample is the sample you are currently editing. 

To select a sample, use this field. 

 

Loop Lock determines whether or not the Loop Lock feature is on. When set to ON, the sample’s loop point is the 
same as the start point. When set to OFF, the loop point is independent from the start point and indicated by a 
separate marker. 

To turn Loop Lock on or off, set this field to ON or OFF (respectively). 

 

Link determines whether or not the Link feature is activated. When activated (ON), changing the start point of a slice 
will also change the end point of the previous slice—and similarly, changing the end point of a slice will also change 
the start point of the next slice. You must have already created slices in Chop Mode to use this. Set Link to OFF if 
you are trying to create slices that use non-contiguous parts of the sample. 

To enable or disable Link, set this field to ON or OFF (respectively). 

Important: Link must be disabled (OFF) to make slices non-sequential, non-contiguous, or overlapping. 
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The waveform shows the “active” section of the sample’s waveform. The highlighted section of the waveform is the 
currently selected part. 

To zoom in on or zoom out of the waveform, press F4/Zoom In or F3/Zoom Out (respectively). Alternatively, 
turn Q-Link Knob 4 (MPC Renaissance) or the fourth Q-Link knob in the fourth column (MPC Studio). 

To scroll through the waveform, turn Q-Link Knob 8 (MPC Renaissance) or the third Q-Link knob in the 
fourth column (MPC Studio). 

 

Start is the start point of the sample or currently selected slice. 

End is the end point of the sample or currently selected slice. 

To change the start point or end point, do either of the following: 

• Use the Start or End field (respectively). 

• Use the first or second column of Q-Link knobs (respectively). The top-most Q-Link knob (13 and 14) in 
each column provides coarse adjustment. The bottom-most Q-Link knobs (1 and 2) provide fine adjustment. 

Tip: A recorded sample may have some silence at the beginning or end, which makes it difficult to time it correctly 
in a musical context. Fix this by adjusting the start point. You can also adjust end point to remove any extra silence 
or unwanted audio at the end. In addition to making your workflow easier, having a “tight,” well-edited sample can 
enhance your production or performance. 

 

Loop is the loop point of the sample or currently selected slice, which appears as a solid vertical line in the waveform. 
When the Loop feature is on, the region of the sample between the loop point and end point will repeat. This is useful 
when trying to find an ideal spot to begin the sample. The loop cannot be earlier than the start point. 

To change the loop point, do either of the following: 

• Use this field. 

• Use the third column of Q-Link knobs. The top-most Q-Link knob (15) provides coarse adjustment. The 
bottom-most Q-Link knobs (3) provides fine adjustment. 

 

Slice is which slice of the sample you are editing. You must have already created slices in Chop Mode to use this. 0 
corresponds to All. 

To select a slice to edit (after you have created slices in Chop Mode), use this field or turn Q-Link Knob 16. 

 

BPM is the tempo of the sample. 

To enter a tempo manually, use the integer or decimal field. 

To detect the tempo automatically, select the integer or decimal field, and then press Window. Use the fields 
and buttons in the Edit BPM window that appears: 

• Use the integer or decimal BPM field to enter a tempo manually. 

• F2/Detect detects the tempo of the sample automatically. 

• Press F3/Tap Tempo at the desired rate to use it as the tempo. You can play a sequence in the 
background to help with your timing. 

• F5/Close returns to the previous screen. 

Note: Before detecting tempo, it is recommended that you Normalize samples for best results. 
 

Note is the root note of the sample. This determines which note will play the sample at its original pitch when in a 
keygroup program. 

To set the root note, use this field. 
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Loop determines how the sample is currently being looped. When the Loop feature is on, the region of the sample 
between the loop point and end point will repeat. This is useful when trying to find an ideal spot to begin the sample. 
The loop cannot be earlier than the start point. 

To set how the sample loops, use this field to select an option: 

• Off: The sample will not loop. 

• Forward (Fwd): When the loop reaches its end point, it will start playing again from the loop point. 

• Alternating (Alt): When the loop reaches its end point, it will play in reverse. When it reaches the loop 
point again, it will start playing forward again from the loop point. 

• Reverse (Rev): When the loop reaches its end point, it will play in reverse. When it reaches the loop 
point again, it will return to the end point and continue playing in reverse. 

To switch between Fwd and Off, press Shift+F4/Loop. 

 

Tune determines the sample’s tuning relative to its original pitch. 

To tune the sample manually, use the integer or decimal field. 

To tune the sample automatically, select the integer or decimal field, and then press Window. Use the fields 
and buttons in the Edit Tuning window that appears: 

• Number Of Beats defines how many beats are in the sample according to the tempo. 

• F4/Match automatically tunes the sample to the sequence and returns to the previous screen. 

• F2/To Seq automatically tunes the sample to the sequence, returns to the previous screen, and matches 
the sequence’s tempo to the Tempo value from this screen. 

• Use the integer or decimal Tune field to tune the sample manually. 

• F5/Close returns to the previous screen. 

 

0 Snap forces start points, end points, and loop points to occur only at the waveform’s “zero-crossings.” This can 
help prevent clicks and glitches when playing a sample. 

To enable or disable 0 Snap, press Shift+F3/0 Snap. 
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Use your MPC hardware pads to play certain parts of the selected sample: 

 

Play Loop  Play to Loop 
Start  Play from 

Loop Start  Play Loop 
Continuous 

13  14 15 16

Play All  
Play Sample

 
(One Shot) 

 
Play Sample

 
(Note On) 

 No function 

09  10 11 12

Play from 
Start 

 
(Note On) 

 

Play to  
Start 

 
(Note On) 

 

Play to 
End 

 
(Note On) 

 

Play from 
End 

 
(Note On) 

05  06 07 08

Play from 
Start 

 
(One Shot) 

 

Play to  
Start 

 
(One Shot) 

 

Play to 
End 

 
(One Shot) 

 

Play from 
End 

 
(One Shot) 

01  02 03 04
 

 

Play Sample (One Shot) (Pad 10) plays the sample once from the start point to the end point. Press the pad 
once to play it. 

Play Sample (Note On) (Pad 11) plays the sample once from the start point to the end point. Press and hold the 
pad to play it, and release the pad to stop playing it. 

Play Loop Continuous (Pad 16) plays the sample repeatedly using the mode set by the Loop button (Forward, 
Reverse, or Alternating; if the Loop button is off, the sample will loop forward repeatedly). 

Play Loop (Pad 13) plays the sample repeatedly using the mode set by the Loop button (Forward, Reverse, or 
Alternating; if the Loop button is off, the sample will loop forward repeatedly). Press and hold the pad to play it, 
and release the pad to stop playing it. 

Play to Loop Start (Pad 14) plays the part of the sample just before the loop point. Press and hold the pad to 
play it, and release the pad to stop playing it. 

Play from Loop Start (Pad 15) plays the sample from the loop point to the end of the sample regardless of the 
end point. Press and hold the pad to play it, and release the pad to stop playing it. 

Play All (Pad 9) plays the entire sample. 

 

Pads 1–4 have the same respective functions as Pads 5–8, but Pads 1–4 play the sample part as “One Shots” 
(pressing the pad once will play the entire part) while Pads 5–8 play the sample part as “Note Ons” (pressing the pad 
and holding it will play the part; releasing it will stop playback): 

Play from Start (Pad 1, Pad 5) plays the sample from the start point to the end point. 

Play to Start (Pad 2, Pad 6) plays the part of the sample just before the start point to the start point. 

Play to End (Pad 3, Pad 7) plays the part of the sample just before the end point to the end point. 

Play from End (Pad 4, Pad 8) plays the part of the sample from the end point to the end of the sample. 



  

 
95 

 

 

Assigning Samples 

 

You can assign your new sample directly to a pad from Trim Mode. 

Important: Assigning a sample to a pad in this way will replace the sample on the first layer of the pad. 

To assign a sample, press F5/Assign, and use the fields and buttons in the Assign Sample window that appears. 

 

Assign To determines how the sample will be assigned. 

 

 

Assign slice to a pad refers the pad to the slice in this sample instead of creating a new sample. This is 
useful for reducing clutter in your project. 

Pad determines the pad to which the slice will be assigned. You can also press a pad to select it. 

Slice Type determines how the pad’s layer settings will be set when the slice is assigned to it (see 
Program Edit Mode to learn more about the parameters mentioned below): 

• Non-Destructive Slice sets each pad’s Slice setting to the slice number. 

• Pad Parameters sets each pad’s Slice setting to Pad. The pad Start and End parameters will 
be set to the slice’s start point and end point values, and the Loop position parameter will be set 
to the slice’s start point but with Pad Loop deactivated. 

Program determines the program to which the slice will be added. 

 

 

Make new sample creates a new sample in your project. The original sample will remain as it is. 

Pad determines the pad to which the slice will be assigned. You can also press a pad to select it. 

Crop Sample determines whether or not the sample will be cropped. When set to ON, the unused parts 
of the sample will be deleted when it is created and assigned. This feature is destructive, though the 
project will still contain your original sample. When set to OFF, the sample will not be cropped, enabling 
you to edit the sample further even if you are using only part of it at the moment. 

Program determines the program to which the slice will be added. 

 

F5/Do It assigns the sample and returns to the previous screen. 

F4/Close returns to the previous screen without assigning the sample. 
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Processing Slices & Samples 

 

To apply various editing processes to the sample, press F6/Process, and use the fields and buttons in the Process 
Slice window that appears. 

 

 

 

 

Function determines how the sample will be processed. 

Note: Almost all processes will affect only the part of the sample between the start point and the end point. Only 
Bit Reduce and Stereo -> Mono will affect the entire sample regardless of its start point or end point. 

Discard deletes the regions before the start point and after the end point. 

Delete deletes the region between the start point and end point and closes the gap between them. 

Silence replaces the region between the start point and end point with silence. 

Extract deletes the regions before the start point and after the end point and saves it as a new sample in 
your current project. 

Tip: This is useful if you recorded a drum loop and wanted to remove just a snare drum hit, a kick drum hit, 
etc. to use separately in the project. 

Normalize increases a sample’s level to the highest level possible without distortion. This is essentially a 
kind of digital gain optimization, so you do not have to worry about excessive level settings when working 
with samples with a wide range of amplitudes. 

Reverse reverses the region between the start point and end point. 

Fade In sets a fade-in between the start point and end point. Use the Type field to set the curve of the fade: 

• Linear fades the audio in with a linear curve—a straight line between the start and end. 

• Log fades the audio in with a logarithmic curve—quickly rising at the start and flattening out towards 
the end. 

• Exp fades the audio in with an exponential curve—slowly rising in the beginning and growing steeper 
towards the end. 

Fade Out sets a fade-out between the start point and end point. Use the Type field to set the curve of the fade: 

• Linear fades the audio out with a linear curve—a straight line between the start and end. 

• Log fades the audio out with a logarithmic curve—quickly rising at the start and flattening out towards 
the end. 

• Exp fades the audio out with an exponential curve—slowly rising in the beginning and growing steeper 
towards the end. 

Pitch Shift changes the pitch of the sample without changing its length. This lets you set the sample’s pitch 
to your sequence without affecting the sample’s tempo or duration. Use the Pitch field to determine the 
amount: -12.00 to 12.00 semitones. 0 corresponds to no pitch shift. Keep in mind that the audio quality may 
decrease at more extreme settings. 
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Time Stretch lengthens or shortens the sample without changing its pitch. This is useful for matching the 
durations of two samples with different pitches. 

• Number Of Beats determines the desired number of beats according to the new tempo. 

• New determines the new tempo (Ratio will then automatically show the time stretch factor). 

• Ratio is the time-stretch factor of the process (New will then automatically change based on this 
time stretch factor). 

Gain Change raises or lowers the volume of the sample. Use the Gain Amount field to determine the amount: 
-18 to 18 dB. 0 corresponds to no gain change. This function is different than Normalize because it will allow 
volumes beyond clipping level. This may be a desired effect, but remember to watch your output level! 

Copy saves a copy of the sample.  

Bit Reduce lowers the bit resolution of a sample, effectively reducing its degree of faithful reproduction. Use 
the Bit Depth field to determine the bit depth of the resulting sample: 1–16 bits. The sound is similar to the 
Resampler effect, but Bit Reduce will permanently alter the sample. 

Tip: Use this on drum loops to get a dirty, “old-school” sizzle but with a digital “edge.” 

Note: This process affects the entire sample regardless of its start point or end point. 

Stereo -> Mono converts a stereo sample to a new mono sample and saves it as a new sample. Use the 
Source field to determine which channels are converted:  

• Left converts the left channel only. 

• Right converts the right channel only. 

• Sum combines the left and right audio channels to a single mono channel. 

Note: This process affects the entire sample regardless of its start point or end point. 

 

F5/Do It applies the process to sample and returns to the previous screen. 

F4/Cancel returns to the previous screen without applying any process. 
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Chop Mode 

 

Whereas Trim Mode crops only the start and/or end off of a sample, Chop Mode divides the sample into multiple 
regions called slices. We recommend using Chop Mode when working with a long sample with different sounds 
throughout (e.g., a drum loop or a long melodic or harmonic passage). 

To enter Chop Mode, press F1/Trim/Chop. 

 

 

 

These are the buttons under the screen in Chop Mode:  

F1 Chop Press this button to switch between Trim Mode and Chop Mode. See Trim Mode to 
learn about it. 

F2 Program Press this button to enter Program Mode. See Program Mode to learn more. 

F3 Zoom Out Press this button to zoom out of the waveform.

F4 Zoom In Press this button to zoom in on the waveform.

F5 Play Cue Press this button to play the sample from the cue playhead. 

F6 Slice + Press this button to create a slice marker at the cue playhead position. You can do this 
at any point during sample playback. 

Shift+F1 One Shot Press these buttons to enable or disable the One Shot feature. When enabled, pressing a 
pad once plays the entire slice. When disabled, pressing the pad and holding it plays the 
slice and releasing it stops playback. 

Shift+F2 0 Snap Press these buttons to activate or deactivate 0 Snap, which forces start points, end 
points, and loop points to occur only at the waveform’s “zero-crossings.” This can help 
prevent clicks and glitches when playing a sample. 

Shift+F3 Process Press these buttons to show the Process Slice screen, where you can select different 
ways in which to process the slice. See Chop Mode > Processing Slices to learn more. 

Shift+F4 Convert Press these buttons to show the Convert or Assign Slices screen, where you can 
convert and assign the sample to a program or pad. See Chop Mode > Converting or 
Assigning Slices to learn more. 

Shift+F5 Clear All Press these buttons to remove all slice markers from the sample. 

Shift+F6 Slice – Press these buttons to remove the slice marker before the current playhead position 
from the sample. 

 

 

Sample is the sample you are currently editing. 

To select a sample, use this field. 
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Link determines whether or not the Link feature is activated. When activated (ON), changing the start point of a slice 
will also change the end point of the previous slice—and similarly, changing the end point of a slice will also change 
the start point of the next slice. You must have already created slices in Chop Mode to use this. Set Link to OFF if 
you are trying to create slices that use non-contiguous parts of the sample. 

To enable or disable Link, set this field to ON or OFF (respectively). 

Important: Link must be disabled (OFF) to make slices non-sequential, non-contiguous, or overlapping. 

 

The waveform shows the “active” section of the sample’s waveform. The highlighted section of the waveform is the 
currently selected part. 

To zoom in on or zoom out of the waveform, press F4/Zoom In or F3/Zoom Out (respectively), or turn Q-Link 
Knob 4 (MPC Renaissance) or the fourth Q-Link knob in the fourth column (MPC Studio). 

To scroll through the waveform, turn Q-Link Knob 8 (MPC Renaissance) or the third Q-Link knob in the 
fourth column (MPC Studio). 

 

Start is where the currently selected slice starts in the sample. 

End is where the currently selected slice ends in the sample. 

To change the start point or end point, do either of the following: 

• Use the Start or End fields (respectively). 

• Use the first or second column of Q-Link knobs (respectively). The top-most Q-Link knob (13 and 14) in 
each column provides coarse adjustment. The bottom-most Q-Link knobs (1 and 2) provide fine adjustment. 

Tip: A recorded sample may have some silence at the beginning or end, which makes it difficult to time it correctly 
in a musical context. Fix this by adjusting the start point. You can also adjust end point to remove any extra silence 
or unwanted audio at the end. In addition to making your workflow easier, having a “tight,” well-edited sample can 
enhance your production or performance. 

 

Cue is the position of the cue playhead, which appears as a dotted vertical line in the waveform. This is useful when 
manually inserting slice markers. You can set its position and behavior to suit your workflow. 

To set the position of cue playhead, use this field. 

To play the sample from the cue playhead, press F5/Play Cue. 

To create a slice marker at the cue playhead position, press F6/Slice +. 

To set how the cue playhead behaves, select Start, End, or Cue, and then press Window. Use the fields and 
button in the Cue Play Mode screen that appears: 

Cue Play Mode determines how the cue playhead will play audio. When set to One Shot, pressing Play Cue 
will play the entire sample from the cue playhead. When set to Toggle, pressing Play Cue will start or stop 
playback from cue playhead. 

Cue Preview determines if/how audio plays as you move the cue playhead. As you move the cue playhead 
through the sample waveform, you can set it to play the small part of the sample before the cue playhead 
(Before), play the small part of the sample after the cue playhead (After), or not play at all (Off). 

Slice Preview determines if/how audio plays as you move a slice marker. As you move a slice marker 
through the sample waveform, you can set it to play the small part of the sample before the slice marker 
(Before), play the small part of the sample after the slice marker (After), or not play at all (Off). 

F4/Close returns to the previous screen. 
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Slice determines which slice of the sample you are editing. You must have already created slices in Chop Mode to 
use this. 0 corresponds to All. 

To select a slice to edit (after you have created slices in Chop Mode), use this field or turn Q-Link Knob 16 
(MPC Renaissance) or the first Q-Link knob in the fourth column (MPC Studio). 

To split or combine slices, select this field, and then press Window. Use the buttons in the Split/Combine 
Slice screen that appears: 

• Split places a slice marker halfway through the current slice, dividing it into two equal slices. 

• Combine removes the start point of the current slice, consolidating it with the slice before it. 

• Back returns to the previous screen without splitting or combining any slices. 

 

Chop To determines how you want to use Chop Mode: 

To select a method, select this field, and then press Window. Use the field in the Chop Mode screen that 
appears, and then press F5/Do It to continue or F4/Close to return to the previous screen. 

• Manual lets you insert slices at locations you select. 

• Threshold uses an adjustable detection algorithm that derives the number of slices created from the 
volume levels present in the sample. 

• Regions divides a sample into several slices of equal length. 

• BPM divides a sample into several slices based on the tempo (beats per minute). 

The screen may show additional fields, depending on the type of program: 

Manual: (no additional fields) 

Threshold: 

Threshold determines the threshold level. The higher the selected value, the more slices will be created. 

To set the threshold, use this field or turn Q-Link Knob 11 (MPC Renaissance) or the second Q-
Link knob in the third column (MPC Studio). 

Min Time determines the minimum length of a slice in milliseconds. 

To set the minimum time, use this field. 

Regions: 

Regions determines how many slices into which the sample will be divided. The higher the selected 
value, the more slices will be created. 

To set the number of regions, use this field or turn Q-Link Knob 11 (MPC Renaissance) or the 
second Q-Link knob in the third column (MPC Studio). 

BPM: 

Bars determines how many bars are in the sample.  

To set the number of bars, use this field or turn Q-Link Knob 11 (MPC Renaissance) or the second 
Q-Link knob in the third column (MPC Studio). 

Beats determines how many beats are in each bar. 

To set the number of beats, use this field or turn Q-Link Knob 7 (MPC Renaissance) or the third 
Q-Link knob in the third column (MPC Studio). 

Time Div shows the note division. The slice markers will be placed according to this setting. You can 
select 1/4, 1/8, 1/16, or 1/32. (In most cases, you should set this parameter to 1/16.) 

To set the time division, use this field or turn Q-Link Knob 3 (MPC Renaissance) or the fourth Q-
Link knob in the third column (MPC Studio). 

 

One Shot determines how a slice is played when you press its corresponding pad. When enabled, pressing a pad once 
plays the entire slice. When disabled, pressing the pad and holding it plays the slice and releasing it stops playback. 

To enable or disable One Shot, press Shift+F4/One Shot. 

 

0 Snap forces start points, end points, and loop points to occur only at the waveform’s “zero-crossings.” This can 
help prevent clicks and glitches when playing a sample. 

To enable or disable 0 Snap, press Shift+F3/0 Snap. 
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Program Mode 

 

Program Mode lets you edit a sample in the context of the program in which you’ll use it. You can adjust the pad 
parameters as though you were in Program Edit Mode, auditioning and hearing how it will sound in the program’s 
audio path. 

To enter Program Mode, press F2/Program. 

 

 
  

These are the buttons under the screen in Program Mode:  

F1 Trim Press this button to switch between Trim Mode and Chop Mode. See Trim Mode and 
Chop Mode to learn about each one. 

F2 Program Press this button to enter Program Mode.

F3 Zoom Out Press this button to zoom out of the waveform.

F4 Zoom In Press this button to zoom in on the waveform.

F5 Assign Press this button to show the Assign Sample screen, where you can assign the 
sample to a program or pad. See Trim Mode > Assigning Samples to learn more. 

F6 Process Press this button to show the Process Slice screen, where you can select different 
ways in which to process the slice. See Trim Mode > Processing Slices & Samples 
to learn more. 

Shift+F3 0 Snap Press these buttons to activate or deactivate 0 Snap, which forces start points, end 
points, and loop points to occur only at the waveform’s “zero-crossings.” This can 
help prevent clicks and glitches when playing a sample. 

Shift+F4 Loop Press these buttons to switch the loop function between Fwd and Off. See the loop 
function described here. 

Shift+F6 To Pad/To All Press these buttons to switch the Slice setting between Pad and All. 

 

Press each pad to hear its sample/samples. The sample on its first layer will automatically appear in the waveform 
display for editing. 

 

Sample is the sample you are currently editing. 

To select a sample, use this field. 

 

Loop Lock determines whether or not the Loop Lock feature is on. When set to ON, the sample’s loop point is the 
same as the start point. When set to OFF, the loop point is independent from the start point and indicated by a 
separate marker. 

To turn Loop Lock on or off, set this field to ON or OFF (respectively). 

 

The waveform shows the “active” section of the sample’s waveform. The highlighted section of the waveform is the 
currently selected part. 

To zoom in on or zoom out of the waveform, press F4/Zoom In or F3/Zoom Out (respectively). Alternatively, 
turn Q-Link Knob 4 (MPC Renaissance) or the fourth Q-Link knob in the fourth column (MPC Studio). 

To scroll through the waveform, turn Q-Link Knob 8 (MPC Renaissance) or the third Q-Link knob in the 
fourth column (MPC Studio). 
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Start is the start point of the sample or currently selected slice. This is shown if Slice is set to All. 

PStart is the start point of the sample or currently selected slice. This is shown if Slice is set to Pad. 

End is the end point of the sample or currently selected slice. This is shown if Slice is set to All. 

PEnd is the end point of the sample or currently selected slice. This is shown if Slice is set to Pad. 

To change the start point or end point (when Slice it set to All), do either of the following: 

• Use the Start or End field. 

• Use the first column of Q-Link knobs. The top-most Q-Link knobs (13 and 14) provide coarse adjustment. 
The bottom-most Q-Link knobs (1 and 2) provide fine adjustment. 

Tip: A recorded sample may have some silence at the beginning or end, which makes it difficult to time it correctly 
in a musical context. Fix this by adjusting the start point. You can also adjust end point to remove any extra silence 
or unwanted audio at the end. In addition to making your workflow easier, having a “tight,” well-edited sample can 
enhance your production or performance. 

 

Loop is the loop point of the sample or currently selected slice, which appears as a solid vertical line in the waveform. 
When the Loop feature is on, the region of the sample between the loop point and end point will repeat. This is useful 
when trying to find an ideal spot to begin the sample. The loop cannot be earlier than the start point. 

To change the loop point, do either of the following: 

• Use this field. 

• Use the third column of Q-Link knobs. The top-most Q-Link knob (15) provides coarse adjustment. The 
bottom-most Q-Link knobs (3) provides fine adjustment. 

 

Slice determines whether the waveform shows the sample as it has been edited (Pad) or the entire sample (All). 
When set to All, you can display the sample as it has been edited but keep the start point and end point. 

To show the edited sample, set this field to Pad, or press Shift+F6/To Pad. PStart, PEnd, and PLoop will show 
the start, end, and loop points (respectively) of the edited sample, which will remain in their current positions. 

To show the entire sample, set this field to All, or press Shift+F6/To All. Start, End, and Loop will show the 
start, end, and loop points (respectively) of the edited sample. 

 

Loop determines how the sample is currently being looped. When the Loop feature is on, the region of the sample 
between the loop point and end point will repeat. This is useful when trying to find an ideal spot to begin the sample. 
The loop cannot be earlier than the start point. 

To set how the sample loops, use this field to select an option: 

• Off: The sample will not loop. 

• Forward (Fwd): When the loop reaches its end point, it will start playing again from the loop point. 

• Alternating (Alt): When the loop reaches its end point, it will play in reverse. When it reaches the loop 
point again, it will start playing forward again from the loop point. 

• Reverse (Rev): When the loop reaches its end point, it will play in reverse. When it reaches the loop 
point again, it will return to the end point and continue playing in reverse. 

To switch between Fwd and Off, press Shift+F4/Loop. 

 

0 Snap forces start points, end points, and loop points to occur only at the waveform’s “zero-crossings.” This can 
help prevent clicks and glitches when playing a sample. 

To enable or disable 0 Snap, press Shift+F3/0 Snap. 
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Assigning Samples 

 
You can assign your new sample directly to a pad from Program Mode. 

Important: Assigning a sample to a pad in this way will replace the sample on the first layer of the pad. 

To assign a sample, press F5/Assign, and use the fields and buttons in the Assign Sample window that appears. 

 

Assign To determines how the sample will be assigned. 

 

 

Assign slice to a pad refers the pad to the slice in this sample instead of creating a new sample. This is 
useful for reducing clutter in your project. 

Pad determines the pad to which the slice will be assigned. You can also press a pad to select it. 

Slice Type determines how the pad’s layer settings will be set when the slice is assigned to it (see 
Program Edit Mode to learn more about the parameters mentioned below): 

• Non-Destructive Slice sets each pad’s Slice setting to the slice number. 

• Pad Parameters sets each pad’s Slice setting to Pad. The pad Start and End parameters will 
be set to the slice’s start point and end point values, and the Loop position parameter will be set 
to the slice’s start point but with Pad Loop deactivated. 

Program determines the program to which the slice will be added. 

 

 

Make new sample creates a new sample in your project. The original sample will remain as it is. 

Pad determines the pad to which the slice will be assigned. You can also press a pad to select it. 

Crop Sample determines whether or not the sample will be cropped. When set to ON, the unused parts 
of the sample will be deleted when it is created and assigned. This feature is destructive, though the 
project will still contain your original sample. When set to OFF, the sample will not be cropped, enabling 
you to edit the sample further even if you are using only part of it at the moment. 

Program determines the program to which the slice will be added. 

 

F5/Do It assigns the sample and returns to the previous screen. 

F4/Close returns to the previous screen without assigning the sample. 
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Processing Slices 

 

To apply various editing processes to the sample, press F6/Process, and use the fields and buttons in the Process 
Slice window that appears. You can process the sample only if Slice is set to All. 

Important: Program Mode is non-destructive: You can choose the slice/edit behavior without destroying your original 
sample, giving you more control over sample playback; you can save your sliced sample and but also reuse all of the 
slice data in another project. See the Program Edit Mode chapter to learn more about setting a pad to play the entire 
sample, a specific slice of a sample, or a specific region of the sample (independent of its slice markers). 

 

 

 

 

 

Function determines how the sample will be processed. 

Note: Almost all processes will affect only the part of the sample between the start point and the end point. Only 
Bit Reduce and Stereo -> Mono will affect the entire sample regardless of its start point or end point. 

Discard deletes the regions before the start point and after the end point. 

Delete deletes the region between the start point and end point and closes the gap between them. 

Silence replaces the region between the start point and end point with silence. 

Extract deletes the regions before the start point and after the end point and saves it as a new sample in 
your current project. 

Tip: This is useful if you recorded a drum loop and wanted to remove just a snare drum hit, a kick drum hit, 
etc. to use separately in the project. 

Normalize increases a sample’s level to the highest level possible without distortion. This is essentially a 
kind of digital gain optimization, so you do not have to worry about excessive level settings when working 
with samples with a wide range of amplitudes. 

Reverse reverses the region between the start point and end point. 

Fade In sets a fade-in between the start point and end point. Use the Type field to set the curve of the fade: 

• Linear fades the audio in with a linear curve—a straight line between the start and end. 

• Log fades the audio in with a logarithmic curve—quickly rising at the start and flattening out towards 
the end. 

• Exp fades the audio in with an exponential curve—slowly rising in the beginning and growing steeper 
towards the end. 

Fade Out sets a fade-out between the start point and end point. Use the Type field to set the curve of the fade: 

• Linear fades the audio out with a linear curve—a straight line between the start and end. 

• Log fades the audio out with a logarithmic curve—quickly rising at the start and flattening out towards 
the end. 

• Exp fades the audio out with an exponential curve—slowly rising in the beginning and growing steeper 
towards the end. 
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Pitch Shift changes the pitch of the sample without changing its length. This lets you set the sample’s pitch 
to your sequence without affecting the sample’s tempo or duration. Use the Pitch field to determine the 
amount: -12.00 to 12.00 semitones. 0 corresponds to no pitch shift. Keep in mind that the audio quality may 
decrease at more extreme settings. 

Time Stretch lengthens or shortens the sample without changing its pitch. This is useful for matching the 
durations of two samples with different pitches. 

• Number Of Beats determines the desired number of beats according to the new tempo. 

• New determines the new tempo (Ratio will then automatically show the time stretch factor). 

• Ratio is the time-stretch factor of the process (New will then automatically change based on this 
time stretch factor). 

Gain Change raises or lowers the volume of the sample. Use the Gain Amount field to determine the amount: 
-18 to 18 dB. 0 corresponds to no gain change. This function is different than Normalize because it will allow 
volumes beyond clipping level. This may be a desired effect, but remember to watch your output level! 

Copy saves a copy of the sample.  

Bit Reduce lowers the bit resolution of a sample, effectively reducing its degree of faithful reproduction. Use 
the Bit Depth field to determine the bit depth of the resulting sample: 1–16 bits. The sound is similar to the 
Resampler effect, but Bit Reduce will permanently alter the sample. 

Tip: Use this on drum loops to get a dirty, “old-school” sizzle but with a digital “edge.” 

Note: This process affects the entire sample regardless of its start point or end point. 

Stereo -> Mono converts a stereo sample to a new mono sample and saves it as a new sample. Use the 
Source field to determine which channels are converted:  

• Left converts the left channel only. 

• Right converts the right channel only. 

• Sum combines the left and right audio channels to a single mono channel. 

Note: This process affects the entire sample regardless of its start point or end point. 

 

F5/Do It applies the process to sample and returns to the previous screen. 

F4/Cancel returns to the previous screen without applying any process. 
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Program Edit Mode 
 

Program Edit Mode contains all parameters for editing your programs. 

To enter Program Edit Mode, press Prog Edit. 

 

  

 

 

 

Use the cursors to select each field, and then use the data dial or –/+ buttons to change the parameter. If the field is 
a number, you can use the numeric keypad to enter a number and then press Enter to confirm it. 

 

The available parameters in this mode depend on the type of program you are editing. 

For drum programs, this mode includes the parameters of four layers as well as all synthesis parameters and 
insert effect settings. See the Drum Programs section to learn more. 

For keygroup programs, this mode contains slightly more parameters than drum programs. See the Keygroup 
Programs section to learn more. 

For clip programs, this mode looks very different from that of other programs due to how clip launching works. 
See the Clip Programs section to learn more. 

For plugin programs, skip to Plugin Programs to learn more. 

For MIDI programs and CV programs, skip to MIDI Programs and CV Programs to learn more. 

For more general information on the differences between the types of programs, please see General Features > 
Programs. 

 

To select a program to edit, use the Program field at the top of the screen. 
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Drum Programs 

 

 

 

When using drum programs, Program Edit Mode lets you edit the parameters for each pad. 

To select a pad, press it. Its parameters will appear on the screen immediately. 

 

These are the buttons under the screen for drum programs: 

F1 Master Press this button to view the Master tab, described here. 

F2 Samples Press this button to cycle the three Samples tabs, described here. 

F3 Pan Vel Press this button to view the Pan Vel (panning and velocity) tab, described here. 

F4 Flt Env Press this button to view the Flt Env (filter envelope) tab, described here. 

F5 Lfo Mod Press this button to view the Lfo Mod (LFO modulation) tab, described here. 

F6 Effects Press this button to view the Effects tab, described here. 

 

 

  

 

You can edit one pad, multiple pads, or all pads of a drum program simultaneously while in Program Edit Mode.  

To select how many pads and which pad/pads you are editing, select any parameter in Program Edit Mode 
except for the bottom-most eight parameters on the Flt Env tab, and then press Window. In the Edit Zones 
screen that appears, set the Edit Mode field: 

• Current: Only the currently selected pad can be edited. 

• Multiple: All selected pads can be edited simultaneously. 

• All: All pads can be edited simultaneously. 

Tip: You can immediately select or deselect multiple pads while on any tab in Program Edit Mode (regardless of 
the current Edit Mode setting). To do this, press Shift and each desired pad. Edit Mode will automatically 
change to the corresponding setting. 
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Master 

 

In the Master tab, you can configure playback settings and tuning for the program and pads. 

 

 

 

Poly (Polyphony) is the playback mode of the pads in the program. 

To set the playback mode of all pads in the program, use this field to select an option: 

• Mono: Only one pad will sound at a time. If a pad is played while another (or the same one) is still playing 
its sample/samples, the new pad will immediately mute all other currently playing pads in that program. 

• Poly: Several pads can be triggered at the same time (limited only by the total number of voices available). 

 

Semi is the coarse tuning of the program: -36 to +36 semitones. 0 corresponds to no coarse-tuning adjustment. 

To set the coarse tuning of the program, use this field. 

 

Fine is the fine tuning of the program: -99 to +99 cents. 0 corresponds to no fine-tuning adjustment. 

To set the fine tuning of the program, use this field. 

 

Level is the overall volume level of the loaded sample/samples of the current pad. 

To set the volume level of the pad, use this field. 

 

Pan is the overall panning position of the loaded sample/samples of the current pad in the stereo field: 50L (left) to 
50R (right). C indicates the center position. 

To set the panning position of the pad, use this field. If you use the numeric keypad to change this number, 
use values from -50 to +50: -50 corresponds to 50L, 0 corresponds to C, and +50 corresponds to 50R. 

 

Sim Play 1–4 (Simultaneous Play) can be set to one to four pads (in the same program) that will be triggered by 
pressing the current pad—the pads will play simultaneously. 

Tips: This feature is useful for triggering a stack of sounds such as layered kick drums. 

To assign pads to play simultaneously with the current pad, use these fields. 

 

Mute Tgt 1–4 (Mute Target) can be set to one to four pads (in the same program) for the currently selected pad. 
When the currently selected pad is played, it will immediately silence its mute targets. 

To assign pads to the mute target of the current pad, use these fields. 

Tips: 

This feature is useful for programming realistic hi-hats, especially if only the open or closed hat should be heard. 

This feature is similar to the mute group feature, available for both drum programs and keygroup programs. 
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Samples 

 

Each pad can trigger up to four samples, which are assigned in four individual layers. Each layer has identical, 
independently assignable parameters. 

Press F2/Samples to cycle through its three available tabs. 

Important: The parameters in the Samples tabs work in conjunction with Chop Mode (in Sample Edit Mode). Here’s 
how it works: 

When working in Sample Edit Mode and using Chop Mode to divide a sample into slices for your pads, you can 
convert a slice using Non-Destructive Slice or Pad Parameters. 

A Non-Destructive Slice will let its pad to refer to that slice when you press it; the original sample remains intact and 
each slice marker is like a “bookmark” for a pad. In Program Edit Mode, you’ll see that the layer to which it’s 
assigned has its Slice setting set to the corresponding slice number in the original sample. Playing that pad will 
cause it to refer to that slice marker like a “bookmark” instead of creating an entirely new sample of that slice. This 
means that you no longer have to clutter your project with a new sample for every slice (though you can still use this 
earlier method, if you prefer). 

A slice converted using Pad Parameters is very similar to a non-destructive slice described above. The difference is 
that in Program Edit Mode, the layers they’re assigned to have their Slice settings set to Pad (instead of the slice 
number), and the start and end points will correspond to the slice markers in the original sample. 

 

The first Samples tab contains controls for the pitch, timing, and playback of the current layer. 

 

 

 

Loop Lock determines if the loop point of a sample layer is “linked to” or “unlinked from” the start point. 

When set to On, the loop point is the same as the start point. 

When set to Off, the loop point is independent from the start point and indicated by a separate loop marker. This is 
the same as the Loop Lock button in Sample Edit Mode. 

To turn Loop Lock on or off, set this field to On or Off (respectively). 

 

Layer is the layer you are editing within the current pad: 1–4. 

To select a layer, use this field. 

 

Smpl (Sample) is the name of the sample assigned to the current layer of the pad. Remember that the sample has to be 
loaded into the project’s sample pool beforehand. To learn how to load samples into a project, please see Browser. 

To assign a sample, use this field. 
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Start and End define where the sample will start and stop playing when the pad is triggered. 

To change the start point or end point, do either of the following: 

• Use the Start or End field (respectively). 

• Use the first or second column of Q-Link knobs (respectively). The top-most Q-Link knobs (13 and 14) 
provide coarse adjustment. The bottom-most Q-Link knobs (1 and 2) provide fine adjustment. 

Note: When Loop Lock is set to ON, the loop position (as determined by the Loop field, if enabled) is the same 
as the sample’s start point. When set to OFF, the loop position is independent from the start point. 

Note: The 0 Snap feature in Sample Edit Mode is helpful when used in conjunction with these settings. 0 Snap 
forces start points, end points, and loop points to occur only at the waveform’s “zero-crossings,” which can help 
prevent clicks and glitches when playing a sample. See this description to learn more. 

Tip: A recorded sample may have some silence at the beginning or end, which makes it difficult to time it correctly 
in a musical context. Fix this by adjusting the start point. You can also adjust end point to remove any extra silence 
or unwanted audio at the end. In addition to making your workflow easier, having a “tight,” well-edited sample can 
enhance your production or performance. 

 

Loop is where the sample will loop when the pad is triggered. When the Loop feature is on, the region of the sample 
between the loop point and end point will repeat. This is useful when trying to find an ideal spot to begin the sample. 
The loop cannot be earlier than the start point. 

To change the loop point, use this field, or use the third column of Q-Link knobs. The top-most Q-Link knob 
(15) provides coarse adjustment. The bottom-most Q-Link knobs (3) provides fine adjustment. 

 

Slice is which slice of the sample is assigned to the pad. You must have already created slices in Chop Mode (in 
Sample Edit Mode) to use this. 0 corresponds to All. 

Note: The Link Slices setting in Sample Edit Mode is helpful when used in conjunction with this setting. Link Slices 
determines how the start point and end point of a slice in a larger sample is set. See this description to learn more. 

To select a slice to edit (after you have created slices in Chop Mode in Sample Edit Mode), use this field or turn Q-
Link Knob 16 (MPC Renaissance) or the first Q-Link knob in the fourth column (MPC Studio) to select an option: 

• All: The entire sample will play. 

• Pad: The sample will play from the Start position to the End position, described earlier. This also lets 
you activate Loop (if the Sample field in the Lfo Mod tab is set to NoteOn). 

• Slice 1, 2, 3, etc.: If you have sliced the sample in Chop Mode (in Sample Edit Mode), you can select 
which slice will play when you trigger the pad. 

 

Tune is the coarse and fine tuning of the sample when played by the pad. The first number is coarse tuning (-36 to 
+36 semitones) and the second number is fine tuning (-99 to +99 cents). 0 corresponds to no tuning adjustment. 

Note: These settings will affect the length of the sample (if Warp is set to Off). Also, these are the same as Semi and 
Fine on the second Samples tab. 

To adjust the tuning, use these fields. 

 

Dir (Direction) determines which direction the sample will play. 

To set the playback direction, use this field to select an option: 

• Forward (Fwd): The sample will play in the normal forward direction. 

• Reverse (Rev): The sample will play in reverse. 
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Loop determines how the sample will be looped. When the Loop feature is on, the region of the sample between the 
loop point (determined by the Loop field in the second row) and end point will repeat. This is useful when trying to 
find an ideal spot to begin the sample. The loop cannot be earlier than the start point. 

Important: For Loop to work, you must (1) set the Sample field (in the Lfo Mod tab) to NoteOn instead of OneSht 
and (2) set the Slice field (in the first Samples tab) to Pad instead of All or a slice number. 

To set how the sample loops, use this field to select an option: 

• Off: The sample will not loop. 

• Forward (Fwd): You can hold down the pad to cause that sample to repeat from the loop point to the 
end of the sample. Release the pad to stop the repeating playback. 

• Alternating (Alt): You can hold down the pad to cause that sample to play from the loop point to the end 
of the sample and then play in reverse until it reaches the loop point again. This will repeat as long as 
you are holding the pad down. Release the pad to stop the repeating playback. 

• Reverse (Rev): You can hold down the pad to cause that sample to play in reverse, repeating from the 
end of the sample to the loop point. Release the pad to stop the repeating playback. 

 

Warp determines whether or not stretching the time of the sample will change its pitch and vice versa. 

When set to On, lengthening or shortening the sample (based on the BPM) will not change its pitch. 

When set to Off, lengthening or shortening the sample will also change its pitch and vice versa. Use the Stretch, 
BPM, and BPM Sync settings (described below) in conjunction with this feature. See the note below to learn how to 
minimize CPU requirements while using Warp. 

To set whether or not the sample is warped, set this field to On or Off (respectively). 

 

Stretch is the “stretch factor,” which affects how the sample is warped (if Warp is set to On). See the note below to 
learn how to minimize CPU requirements while using Warp. 

To set the stretch factor, use this field. 

 

BPM is the tempo used when a sample is warped (if Warp is set to On). See the note below to learn how to minimize 
CPU requirements while using Warp. 

To set the tempo of the sample, use this field. 

 

BPM Sync determines whether the tempo of the sample is linked to or independent of the tempo of the sequence.  

When BPM Sync and Warp are both set to On, the sample’s tempo will be “locked” to the tempo of the sequence.  

When BPM Sync is set to Off but Warp is set to On, the sample will be independent of the tempo of your sequence—
use the Stretch field to lengthen or shorten a sample. See the note below to learn how to minimize CPU requirements 
while using Warp. 

To enable or disable BPM Sync, set this field to On or Off (respectively). 

 

Note: The Warp algorithms are very CPU-intensive and can result in audio drop-outs during playback if used too 
freely. Be mindful of how (and how often) you use the warp function. You can reduce the CPU resources required by 
doing any/all of the following: 

• Avoid using extreme Stretch values. 

• Minimize the amount of pitch adjustment (e.g., the Tune parameter) of warped audio. 

• Avoid warping very small track regions. 

• Warp as few tracks or track regions as possible (i.e., reduce the number of total number of voices of the 
polyphonic limit that use the Warp algorithm at a given time), especially instances where the warped regions start 
at the same time. 

• Avoid rapidly triggering samples that are warped. 

• If you have warped samples used in a drum program, consider using the Flatten Pad function to consolidate the 
affected pad’s layers into one audio sample. After you flatten the pad, its sample/samples no longer need to be 
warped. To see the user guide in the MPC software and learn how to do this, click the Help menu, select MPC 
Help, and select MPC User Manual. 



  

 
117 

 

 

The second Samples tab contains controls for the pitch and volume level of each layer. 

 

 

 

Loop Lock determines if the loop point of a sample layer is “linked to” or “unlinked from” the start point. 

When set to On, the loop point is the same as the start point. 

When set to Off, the loop point is independent from the start point and indicated by a separate loop marker. This is 
the same as the Loop Lock button in Sample Edit Mode. 

To turn Loop Lock on or off, set this field to On or Off (respectively). 

 

S1–4 (Sample 1–4) is the name of the sample assigned to the current layer (1–4) of the pad. Remember that the 
sample has to be loaded into the project’s sample pool beforehand. To learn how to load samples into a project, 
please see Browser. 

To assign a sample, use this field or turn the corresponding Q-Link knob (1, 5, 9, or 13 on MPC Renaissance or 
the first column of Q-Link knobs on MPC Studio). 

 

Semi is the coarse tuning of the sample on each layer: -36 to +36 semitones. 0 corresponds to no coarse-tuning 
adjustment. This will affect the length of the sample (if Warp is set to Off). 

To set the coarse tuning of the sample on each layer, use this field or turn the corresponding Q-Link knob (2, 6, 
10, or 14 on MPC Renaissance or the second column of Q-Link knobs on MPC Studio). 

 

Fine is the fine tuning of the sample on each layer: -99 to +99 cents. 0 corresponds to no fine-tuning adjustment. 
This will affect the length of the sample (if Warp is set to Off). 

To set the fine tuning of the sample on each layer, use this field or turn the corresponding Q-Link knob (3, 7, 
11, or 15 on MPC Renaissance or the third column of Q-Link knobs on MPC Studio). 

 

Level is the volume of the sample on each layer, enabling you to control the “balance” of the samples assigned to 
the pad. 

To set the volume level of the sample on each layer, use this field or turn the corresponding Q-Link knob (4, 8, 
12, or 16 on MPC Renaissance or the fourth column of Q-Link knobs on MPC Studio). 
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The third Samples tab contains a control for the offset of the sample on each layer. 
 

 
 
Loop Lock determines if the loop point of a sample layer is “linked to” or “unlinked from” the start point. 
When set to On, the loop point is the same as the start point. 
When set to Off, the loop point is independent from the start point and indicated by a separate loop marker. This is 
the same as the Loop Lock button in Sample Edit Mode. 

To turn Loop Lock on or off, set this field to On or Off (respectively). 
 
S1–4 (Sample 1–4) is the name of the sample assigned to the current layer (1–4) of the pad. Remember that the 
sample has to be loaded into the project’s sample pool beforehand. To learn how to load samples into a project, 
please see Browser. 

To assign a sample, use this field or turn the corresponding Q-Link knob (1, 5, 9, or 13 on MPC Renaissance or 
the first column of Q-Link knobs on MPC Studio). 

 
Offset is the time offset of the sample’s playback on each layer. When this setting is a positive value, playing the pad 
will immediately trigger the sample on that layer but at a later point in the sample (specified by this setting). When this 
setting is a negative value, the sample playback on that layer will be delayed by the amount specified by this setting. 

To set the offset of the sample on each layer, use this field or turn the corresponding Q-Link knob (2, 6, 10, or 14 
on MPC Renaissance or the second column of Q-Link knobs on MPC Studio). 

 
 
Panning & Velocity 
 
The Pan Vel tab contains settings that determine the stereo placement and velocity ranges of each layer of the pad. 
 

 
 
Pan is the panning position of the sample on each layer in the stereo field: 50L (left) to 50R (right). C indicates the 
center position. 

To set the panning position of the sample on each layer, use this field or turn the corresponding Q-Link knob 
(1, 5, 9, or 13 on MPC Renaissance or the first column of Q-Link knobs on MPC Studio). If you use the numeric 
keypad to change this number, use values from -50 to +50: -50 corresponds to 50L, 0 corresponds to C, and +50 
corresponds to 50R. 

 
Low and High determine the lowest and highest velocities (respectively) that will trigger the sample on each layer. A range 
from 0 to 127 lets the layer respond to the entire velocity range which is input from the respective pad, while, for example, 
a range from 100 to 127 lets the layer respond only to higher velocity levels. By assigning several samples of one 
instrument, you can create a realistic-sounding “multi-sample” by adjusting the velocity ranges of each layer accordingly. 
For example, you may have three samples of a drum hit with low force, medium force, and high force. You can set 
each sample to a layer and set the velocity ranges so only low velocities trigger the low-force sample, only mid-range 
velocities trigger the medium-force sample, and only high velocities trigger the high-force sample. 

To set the velocity range of the sample on each layer, use these fields or turn the corresponding Q-Link knob: 
for low velocities, turn Q-Link Knob 2, 6, 10, or 14 (MPC Renaissance) or the second column of Q-Link knobs 
(MPC Studio); for high velocities Q-Link Knob 3, 7, 11, or 15 (MPC Renaissance) or the third column of Q-Link 
knobs (MPC Studio). 
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Filter Envelope 
 
The Flt Env tab contains settings for the filter and amp envelopes that affect the pad. 

 

 
 
Type determines the filter that is applied to the selected pad. See Appendix > Glossary > Filter for an explanation of 
the available filter types. 

To set the filter type, use this field or turn Q-Link Knob 13 (MPC Renaissance) or the first Q-Link knob in the 
first row (MPC Studio). 

 
Cutoff is the cutoff frequency for low-pass and high-pass filter types or the center frequency for band-pass and 
band-stop filter types. See Appendix > Glossary > Filter for an explanation of the available filter types. 

To set the filter cutoff frequency, use this field or turn Q-Link Knob 14 (MPC Renaissance) or the second Q-Link 
knob in the first row (MPC Studio). 

 
Reso (Resonance) is the emphasis of the frequencies around the cutoff point. 

Tip: Use values lower than 80 to give more brilliance to the sound. At values higher than 80, the sound will result in a 
strong audible boost around the cutoff frequency.  

To set the filter resonance, use this field or turn Q-Link Knob 15 (MPC Renaissance) or the third Q-Link knob 
in the first row (MPC Studio). 

 
Env (Envelope) determines the amount of influence the filter envelope has on the cutoff frequency. Higher settings 
will increase the modulation of the filter by the envelope; lower settings will result in only subtle changes of the filter 
Cutoff over time. 

Tip: To give a sound a more distinctive attack, increase the Env setting and set low Atk and Dec values as well as 
a medium-low Sust value of the filter envelope (Flt). This will start a sound with the filter opened and close it shortly 
afterward, giving it a bright start followed by a darker sustain. String sounds, on the other hand, can sound much 
more “alive” with low Env settings and a high Atk value, resulting in a slight fade-in of the higher frequencies.  

To set the filter envelope amount, use this field or turn Q-Link Knob 16 (MPC Renaissance) or the fourth Q-Link 
knob in the first row (MPC Studio). 

 
V>Start (VelocityStart) determines how much velocity is needed (for a triggered pad) to modulate the sample start point. 

To set the “velocity to start,” use this field or turn Q-Link Knob 9 (MPC Renaissance) or the first Q-Link knob 
in the second row (MPC Studio). 

 
V>Attack (VelocityAttack) determines how much velocity is needed (for a triggered pad) to modulate the Attack 
(Atk) phase for the Amp envelope. 

To set the “velocity to filter attack,” use this field or turn Q-Link Knob 10 (MPC Renaissance) or the second 
Q-Link knob in the second row (MPC Studio). 

 
V>Env (VelocityEnvelope) determines to what degree velocity information affects the amount of the filter envelope’s 
effect on the cutoff frequency. 

To set the “velocity to envelope amount,” use this field or turn Q-Link Knob 11 (MPC Renaissance) or the 
third Q-Link knob in the second row (MPC Studio). 

 
V>Filter (VelocityFilter) determines to what degree the velocity of a pad modulates the cutoff frequency directly. 

To set the “velocity to filter cutoff,” use this field or turn Q-Link Knob 12 (MPC Renaissance) or the fourth Q-
Link knob in the second row (MPC Studio). 
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The third row of parameters determine how the filter envelope affects the filter frequency over a period of time. There 
are three possible sets of parameters, depending on the type of envelope: 

• AD (attack-decay) envelope: Flt Atk (filter attack), Flt Dec (filter decay), and Dec Type (decay type) 

• AHDS (attack-hold-decay-sustain) envelope: Flt Atk (filter attack), Flt Hold (filter hold), Flt Dec (filter decay), 
and Flt Sust (filter sustain) 

• ADSR (attack-decay-sustain-release) envelope: Flt Atk (filter attack), Flt Dec (filter decay), Flt Sust (filter 
sustain), and Flt Rel (filter release) 

See the later Anatomy of an Envelope section to learn about these envelope parameters. 

To adjust the filter envelope parameters, use these fields or turn the corresponding Q-Link knob (5–8 on MPC 
Renaissance or the Q-Link knobs in the third row on MPC Studio). 

To adjust the overall influence of the envelope on the filter frequency, use the Env field or turn Q-Link Knob 16 
(MPC Renaissance) or the first Q-Link knob in the fourth column (MPC Studio). 

To set the envelope type, press F5/Lfo Mod and set Sample to One Shot (OneSht), if you want to select an 
AD or AHDS envelope, or Note On (NoteOn), if you want to use ADSR envelopes only. To select an AD or AHDS 
envelope, press F4/Flt Env, select one of the eight bottom-most parameters, and then press Window. Use the 
Filter Envelope AD Mode field in the screen that appears to select an AD envelope (On) or AHDS (Off), and then 
press F4/Close. 

 

The fourth row of parameters determine how the amp envelope affects the volume level over a period of time. There 
are three possible sets of parameters, depending on the type of envelope: 

• AD (attack-decay) envelope: Amp Atk (amp attack), Amp Dec (amp decay), and Dec Type (decay type) 

• AHDS (attack-hold-decay-sustain) envelope: Amp Atk (amp attack), Amp Hold (amp hold), Amp Dec (amp 
decay), and Amp Sust (amp sustain) 

• ADSR (attack-decay-sustain-release) envelope: Amp Atk (amp attack), Amp Dec (amp decay), Amp Sust 
(amp sustain), and Amp Rel (amp release) 

See the later Anatomy of an Envelope section to learn about these envelope parameters. 

To adjust the amp envelope parameters, use these fields or turn the corresponding Q-Link knob (1–4 on MPC 
Renaissance or the Q-Link knobs in the fourth row on MPC Studio). 

To set the envelope type, press F5/Lfo Mod and set Sample to One Shot (OneSht), if you want to select an 
AD or AHDS envelope, or Note On (NoteOn), if you want to use ADSR envelopes only. To select an AD or AHDS 
envelope, press F4/Flt Env, select one of the eight bottom-most parameters, and then press Window. Use the 
Volume Envelope AD Mode field in the screen that appears to select an AD envelope (On) or AHDS (Off), and 
then press F4/Close. 
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LFO Modulation 

 

The Lfo Mod tab contains settings that determine sample playback and low-frequency oscillator of the pad. 

 

 
 

Mute Group determines if the pad is assigned to a mute group: 1–32 or Off (no mute group). When pads assigned to 
the same mute group receive MIDI notes, the last pad played will silence all other pads in that mute group. A mute 
group affects pads within that program only; mute groups do not affect pads in other programs. 

Tip: This feature is useful for programming realistic hi-hats, especially if only the open or closed hat should be heard. 

To set the mute group, use this field or turn Q-Link Knob 13 (MPC Renaissance) or the first Q-Link knob in 
the first row (MPC Studio). 

 

Layer determines how multiple samples assigned to the pad are played: 

To set the layer playback option, use this field or turn Q-Link Knob 14 (MPC Renaissance) or the second Q-Link 
knob in the first row (MPC Studio) to select an option: 

• Cycle (Cyc): Each time the pad is played, it will play the next layer’s sample. In other words, the samples 
will cycle through the layers as follows: 1, 2, 3, 4, 1, 2, 3, 4… etc. 

• Velocity (Vel): The pad will switch between layers depending on how hard you press a pad.  

• Random (Ran): Each time the pad is played, it will play one of its layer’s samples at random.  

 

Sample determines how much of the samples assigned to the pad are played. 

To set the playback amount of the samples on the pad, set this field to OneSht or NoteOn, or turn Q-Link 
Knob 15 (MPC Renaissance) or the third Q-Link knob in the first row (MPC Studio), to select an option. 

• One Shot (OneSht): The samples will play from start to end when the pad is pressed. Use this when you 
want to play short sounds. 

• Note On (NoteOn): The samples will play only as long as the pad is held down. This is better for longer 
samples so you can control a sound’s duration by pressing and holding its corresponding pad. 

 

Poly (Polyphony) determines how the pad’s sound behaves when multiple hits are registered. 

To set the polyphony of the pad, set this field to Mono or Poly, or turn Q-Link Knob 16 (MPC Renaissance) or 
the fourth Q-Link knob in the first row (MPC Studio), to select an option: 

• Mono: Only one pad will sound at a time. If a pad is played while another (or the same one) is still playing 
its sample/samples, the new pad will immediately mute all other currently playing pads in that program.  

• Poly: Several pads can be triggered at the same time (limited only by the total number of voices 
available). You can also select a specific number of pads (2–32) so that you can trigger up to this many 
pads at the same time (unless they exceed the total number of voices available). 

 

V>Pitch (VelocityPitch), V>Atk (VelocityAttack), V>Amp (VelocityAmp), and V>Pan (VelocityPanning) determine 
how much the velocity affects the pitch of the sound (Pitch), the attack of the filter envelope (Atk), the volume level of 
the filter envelope (Amp) and or the panning of the sound (Pan). When you press a pad softly, only minimal modulation 
is applied. When you press it harder, the modulation amount also gets stronger depending on the setting of the 
corresponding knob. 

To adjust the velocity sensitivity of the pad, use these fields or turn the corresponding Q-Link knob (9–12 on 
MPC Renaissance or the Q-Link knobs in the second row (MPC Studio). 
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A low-frequency oscillator (LFO) generates a periodic waveform with an adjustable frequency and shape which can be 
used for modulation purposes. The seven settings in the lower half of the screen affect the LFO applied to the pad. 

 

Wave is the type of waveform the LFO uses. 

To select the waveform of the LFO, use this field or turn Q-Link Knob 5 (MPC Renaissance) or the first Q-Link 
knob in the third row (MPC Studio) to select an option: 

• Sine (best suited for smooth modulations) 

• Triangle (best suited for smooth modulations) 

• S&H (samples a random value and holds it until the next value is generated) 

• Saw (can generate interesting filter or volume changes) 

• Saw Down (can generate interesting filter or volume changes) 

• Square (interesting results with hard-panning modulations) 

• Noise (generates random values and glides) 

 

Rate is the LFO frequency when Sync is on. At lower values, it might take some time for the LFO to complete a 
cycle, while higher values will come closer to audible range. 

To set the frequency of the LFO, use this field or turn Q-Link Knob 6 (MPC Renaissance) or the second Q-
Link knob in the third row (MPC Studio). 

 

Sync determines if or how the LFO’s rate is synchronized with the tempo. You can select one of several time 
divisions (a . indicates a dotted note; a T indicates a triplet-based time division). When None is selected, Sync is off. 

To set the synchronization of the LFO, use this field or turn Q-Link Knob 7 (MPC Renaissance) or the third Q-
Link knob in the third row (MPC Studio). 

 

L>Pitch (LFOPitch), L>Filter (LFOFilter), L>Amp (LFOAmp), and L>Pan (LFOPanning) determine how much 
the LFO affects the pitch of the sound (Pitch), the cutoff frequency of the filter (Filter), the volume level of the sound 
(Amp), and the panning of the sound (Pan). When you press a pad softly, only minimal modulation is applied. When 
you press it harder, the modulation amount also gets stronger depending on the setting of the corresponding knob. 

To adjust the LFO destinations of the pad, use these fields or turn the corresponding Q-Link knob (1–4 on 
MPC Renaissance or the Q-Link knobs in the fourth row (MPC Studio). 
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Effects 

 

Effects shows the insert effects and send effect levels for the pad. You can select up to four insert effects for each 
pad. Additionally, each pad can be sent to up to four return channels, each of which can have up to four insert 
effects of their own. Their audio will be routed through the insert effects on those returns, and the processed audio 
will be sent to a master output. 

Please see General Features > Effects to learn more about using insert and send effects. 

 

 

 

 

Inserts determines whether insert effects are activated (ON) or deactivated (OFF) for the pad. 

To activate or deactivate all four insert effects, set this field to ON or OFF (respectively). 

 

Insert 1–4 are the four available slots for insert effects on that pad. 

To load an effect, select an Insert field, and then use the data dial or –/+ buttons. In the Select Effect screen that 
appears, select an effect. Press F4/Select to load the selected effect or F3/Back to return to the previous screen. 

To change the settings of a loaded effect, select an Insert field with an effect, and press Window. In the screen 
that appears, you can select and change each parameter (you can use the numeric keypad on some of them). 
Press F4/Close to return to the previous screen. 

To activate or deactivate an effect, select its Insert field, and press Window. In the screen that appears, press 
F6/On/Off to activate or deactivate the effect. Press F4/Close to return to the previous screen. 

To activate or deactivate all four insert effects, set the Inserts field to ON or OFF (respectively). 

 

Send 1–4 are the audio signal levels that the pad sends to the four return channels, each of which can have up to 
four insert effects—these are send effects. The send effects will then send the audio to the assigned master output at 
the designated return levels. 

To adjust the send levels, turn their corresponding Q-Link knobs (4, 8, 12, or 16 on MPC Renaissance or the 
Q-Link knobs in the fourth column on MPC Studio). 

Important: To edit the send effects, use the Channel Mixer. See Channel Mixer > Returns to learn more how to 
do this. 
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Keygroup Programs 

 

 

 
When using keygroup programs, Program Edit Mode lets you edit the parameters for each keygroup. 

To select a keygroup to edit, press F1/Master and use the Kg Select field or turn Q-Link Knob 9 (MPC 
Renaissance) or the first Q-Link knob in the second row (MPC Studio). You can select All to edit all keygroups 
simultaneously. The current settings will appear on the screen immediately. 

 
 
These are the buttons under the screen for keygroup programs: 

F1 Master Press this button to view the Master tab, described here. 

F2 Samples Press this button to cycle the three Samples tabs, described here. 

F3 Pan Vel Press this button to view the Pan Vel (panning and velocity) tab, described here. 

F4 Flt Env Press this button to view the Flt Env (filter envelope) tab, described here. 

F5 Lfo Mod Press this button to view the Lfo Mod (LFO modulation) tab, described here. 

F6 Effects Press this button to view the Effects tab, described here. 

 
 
 

 
 
You can create up to 128 keygroups within a keygroup program. This is useful when working with multi-samples. For 
example, if you want to create a realistic piano, you can use different keygroups (e.g., 88 for a grand piano) with every 
keygroup containing its own sampled note (with up to four possible velocity layers). 

To set the number of keygroups in the program, select any parameter in Program Edit Mode except for the 
bottom-most eight parameters on the Flt Env tab, and then press Window. In the Set Number of Keygroups 
screen that appears, set the Num Keygroups field to the desired number of keygroups (1–128). 

To select a keygroup to edit, press F1/Master and use the Kg Select field or turn Q-Link Knob 9 (MPC 
Renaissance) or the first Q-Link knob in the second row (MPC Studio). You can select All to edit all keygroups 
simultaneously. The current settings will appear on the screen immediately. 
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Master 

 

In the Master tab, you can set the playback mode and tuning for the overall program. 

Tip: The Samples and Pan Vel tabs have some parameters similar to those in this section (Level, Pan, Semi, Fine, 
etc.). Remember that there are parameters that control the settings for the entire program, while other parameters 
control the settings for the current keygroup, and other parameters control the settings for each sample layer (up to 4). 

 

 
 

Poly (Polyphony) is the playback mode of the program’s keygroups. 

To set the playback mode of all keygroups in the program, use this field or turn Q-Link Knob 13 (MPC 
Renaissance) or the first Q-Link knob in the first row (MPC Studio) to select an option: 

• Mono: Only one keygroup will sound at a time. If a keygroup is played while another (or the same one) is still 
playing its sample/samples, the new keygroup will immediately mute all other currently playing keygroups in 
that program. 

• Poly: Several keygroups can be triggered at the same time (limited only by the total number of voices 
available). 

 

Semi is the coarse tuning of the program: -36 to +36 semitones. 0 corresponds to no coarse-tuning adjustment. 

To set the coarse tuning of the program, use this field or turn Q-Link Knob 14 (MPC Renaissance) or the second 
Q-Link knob in the first row (MPC Studio). 

 

Fine is the fine tuning of the program: -99 to +99 cents. 0 corresponds to no fine-tuning adjustment. 

To set the fine tuning of the program, use this field or turn Q-Link Knob 15 (MPC Renaissance) or the third Q-
Link knob in the third column (MPC Studio). 

 

Trans shifts the pitch of the MIDI notes sent to the program: -36 to +36 semitones. 0 corresponds to no transposition. 

To set the transposition of the program, use this field or turn Q-Link Knob 16 (MPC Renaissance) or the fourth 
Q-Link knob in the first row (MPC Studio). 

 

Kg Select (Keygroup Select) is the keygroup you are currently editing. This parameter works in conjunction with the 
Num Keygroups setting in (the Set Number of Keygroups window), which lets you create up to 128 keygroups 
within one keygroup program. A default keygroup program contains only one single keygroup. When set to All, you 
are editing all keygroups in the program simultaneously. 

To select a keygroup to edit, press F1/Master and use the Kg Select field or turn Q-Link Knob 9 (MPC 
Renaissance) or the first Q-Link knob in the second row (MPC Studio). You can select All to edit all keygroups 
simultaneously. The current settings will appear on the screen immediately. 

To set the number of keygroups in the program, select any parameter in Program Edit Mode except for the 
bottom-most eight parameters on the Flt Env tab, and then press Window. In the Set Number of Keygroups 
screen that appears, set the Num Keygroups field to the desired number of keygroups (1–128). 

 

Key Trk (Key Track) allows you to switch automatic transposition on or off. When set to On, the sample/samples in 
the current keygroup will play using their assigned transposition. When set to Off, the sample/samples will always 
play at the original pitch, no matter which note is triggered by pads or a connected MIDI keyboard. 

To enable or disable Key Track, set this field to On or Off (respectively) or turn Q-Link Knob 10 (MPC 
Renaissance) or the second Q-Link knob in the second row (MPC Studio). 
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Level is the overall volume level of the loaded sample/samples of the current keygroup. 
To set the volume level of the keygroup, use this field or turn Q-Link Knob 11 (MPC Renaissance) or the third 
Q-Link knob in the second row (MPC Studio). 

 
Pan is the overall panning position of the loaded sample/samples of the current keygroup in the stereo field: 50L (left) 
to 50R (right). C indicates the center position. 

To set the panning position of the keygroup, use this field or turn Q-Link Knob 12 (MPC Renaissance) or the 
fourth Q-Link knob in the second row (MPC Studio). If you use the numeric keypad to change this number, 
use values from -50 to +50: -50 corresponds to 50L, 0 corresponds to C, and +50 corresponds to 50R. 

 
Low Note and High Note determine the note range of the current keygroup. This lets you restrict the key range used 
for a sample’s playback. Only notes with a key number higher or equal (Low Key) or lower and equal (High Key) to 
the selected value will trigger a sound. 
Tip: Set Low Note to A0 and High Note to C8 to emulate the range of a standard 88-key piano. 

To set the note range of the keygroup, use these fields or turn Q-Link Knobs 5 and 6 (MPC Renaissance) or 
the first and second Q-Link knobs in the third row (MPC Studio). 

 
Kg Semi is the coarse tuning of the keygroup: -36 to +36 semitones. 0 corresponds to no coarse-tuning adjustment. 

To set the coarse tuning of the keygroup, use this field or turn Q-Link Knob 7 (MPC Renaissance) or the third 
Q-Link knob in the third row (MPC Studio) 

 
Kg Fine is the fine tuning of the program: -99 to +99 cents. 0 corresponds to no fine-tuning adjustment. 

To set the fine tuning of the keygroup, use this field or turn Q-Link Knob 8 (MPC Renaissance) or the fourth 
Q-Link knob in the third row (MPC Studio). 

 
Kg Ply (keygroup polyphony) field to determine how the keygroup will play. 

To set the playback mode of the keygroup, use this field or turn Q-Link Knob 1 (MPC Renaissance) or the 
first Q-Link knob in the fourth row (MPC Studio) to select an option: 

• Mono: Only one pad will sound at a time. If a pad is played while another (or the same one) is still playing 
its sample/samples, the new pad will immediately mute all other currently playing pads in that program.  

• Poly: Several pads can be triggered at the same time, limited only by the total number of voices 
available. You can also select a specific number of pads (2–32) so that you can play up to this many 
pads at the same time (unless they exceed the total number of voices available). 

 
Mute Group determines if the keygroup is assigned to a mute group: 1–32 or Off (no mute group). When keygroups 
assigned to the same mute group receive MIDI notes, the last keygroup played will silence all other keygroups in that mute 
group. A mute group affects keygroup within that program only; mute groups do not affect keygroups in other programs. 

To set the mute group, use this field or turn Q-Link Knob 2 (MPC Renaissance) or the second Q-Link knob in 
the fourth row (MPC Studio). 

 
Layer determines how multiple samples assigned to the keygroup are played: 

To set the layer playback option, use this field or turn Q-Link Knob 3 (MPC Renaissance) or the third Q-Link 
knob in the fourth row (MPC Studio) to select an option: 

• Cycle (Cyc): Each time the keygroup is played, it will play the next layer’s sample. In other words, the 
samples will cycle through the layers as follows: 1, 2, 3, 4, 1, 2, 3, 4… etc. 

• Velocity (Vel): The keygroup will switch between layers depending on how hard you press a pad.  

• Random (Ran): Each time the keygroup is played, it will play one of its layer’s samples at random.  

 
Sample determines how much of the samples assigned to the keygroup are played. 

To set the playback amount of the samples, use this field or turn Q-Link Knob 4 (MPC Renaissance) or the 
fourth Q-Link knob in the fourth row (MPC Studio) to select an option: 

• One Shot (OneSht): The samples will play from start to end when a pad in the keygroup is pressed. Use 
this when you want to play short sounds. 

• Note On (NoteOn): The samples will play only as long as a pad in the keygroup is held down. This is better 
for longer samples so you can control a sound’s duration by pressing and holding its corresponding pad. 
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Samples 

 

Each keygroup can trigger up to four samples, which are assigned in four individual layers. Each layer has identical, 
independently assignable parameters. 

Press F2/Samples to cycle through its three available tabs. 

Important: The parameters in the Samples tabs work in conjunction with Chop Mode (in Sample Edit Mode). Here’s 
how it works: 

When working in Sample Edit Mode and using Chop Mode to divide a sample into slices for your pads, you can 
convert a slice using Non-Destructive Slice or Pad Parameters. 

A Non-Destructive Slice will let its keygroup to refer to that slice when you press a pad in that keygroup; the original 
sample remains intact and each slice marker is like a “bookmark” for a keygroup. In Program Edit Mode, you’ll see 
that the layer to which it’s assigned has its Slice setting set to the corresponding slice number in the original 
sample. Playing that keygroup will cause it to refer to that slice marker like a “bookmark” instead of creating an 
entirely new sample of that slice. This means that you no longer have to clutter your project with a new sample for 
every slice (though you can still use this earlier method, if you prefer). 

A slice converted using Pad Parameters is very similar to a non-destructive slice described above. The difference is 
that in Program Edit Mode, the pads/layers they’re assigned to have their Slice setting set to Pad (instead of the slice 
number), and the start and end points will correspond to the slice markers in the original sample. 

 

 

The first Samples tab contains controls for its pitch, timing, and playback of the current layer. 

 

 

 

Loop Lock determines if the loop point of a sample layer is “linked to” or “unlinked from” the start point. When set to 
On, the loop point is the same as the start point. When set to Off, the loop point is independent from the start point 
and indicated by a separate loop marker. This is the same as the Loop Lock button in Sample Edit Mode. 

To turn Loop Lock on or off, set this field to On or Off (respectively). 

 

Layer is the layer you are editing within the current keygroup: 1–4. 

To select a layer, use this field. 

 

Smpl (Sample) is the name of the sample assigned to the current layer of the keygroup. Remember that the sample has to 
be loaded into the project’s sample pool beforehand. To learn how to load samples into a project, please see Browser. 

To assign a sample, use this field. 
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Start and End define where the sample will start and stop playing when a pad in the keygroup is triggered. 

To change the start point or end point, do either of the following: 

• Use the Start or End field (respectively). 

• Use the first or second column of Q-Link knobs (respectively). The top-most Q-Link knobs (13 and 14) 
provide coarse adjustment. The bottom-most Q-Link knobs (1 and 2) provide fine adjustment. 

Note: When Loop Lock is set to ON, the loop position (as determined by the Loop field, if enabled) is the same 
as the sample’s start point. When set to OFF, the loop position is independent from the start point. 

Tip: A recorded sample may have some silence at the beginning or end, which makes it difficult to time it correctly 
in a musical context. Fix this by adjusting the start point. You can also adjust end point to remove any extra silence 
or unwanted audio at the end. In addition to making your workflow easier, having a “tight,” well-edited sample can 
enhance your production or performance. 

 

Loop is where the sample will loop when a pad in the keygroup is triggered. When the Loop feature is on, the region 
of the sample between the loop point and end point will repeat. This is useful when trying to find an ideal spot to 
begin the sample. The loop cannot be earlier than the start point. 

To change the loop point, use this field, or use the third column of Q-Link knobs. The top-most Q-Link knob 
(15) provides coarse adjustment. The bottom-most Q-Link knobs (3) provides fine adjustment. 

 

Slice is which slice of the sample is assigned to the keygroup. You must have already created slices in Chop Mode 
(in Sample Edit Mode) to use this. 0 corresponds to All. 

To select a slice to edit (after you have created slices in Chop Mode in Sample Edit Mode), use this field or turn Q-
Link Knob 16 (MPC Renaissance) or the fourth Q-Link knob in the fourth column (MPC Studio) to select an option: 

• All: The entire sample will play. 

• Pad: The sample will play from the Start position to the End position, described earlier. This also lets 
you activate Loop (if the Sample field in the Lfo Mod tab is set to NoteOn). 

• Slice 1, 2, 3, etc.: If you have sliced the sample in Chop Mode (in Sample Edit Mode), you can select 
which slice will play when you trigger a pad in the keygroup. 

 

Tune is the coarse and fine tuning of the sample when played by a pad in the keygroup. The first number is coarse tuning 
(-36 to +36 semitones) and the second number is fine tuning (-99 to +99 cents). 0 corresponds to no tuning adjustment. 

Note: These settings will affect the length of the sample (if Warp is set to Off). Also, these are the same as Semi and 
Fine on the second Samples tab. 

To adjust the tuning, use these fields. 

 

Dir (Direction) determines which direction the sample will play. 

To set the playback direction, use this field to select an option: 

• Forward (Fwd): The sample will play in the normal forward direction. 

• Reverse (Rev): The sample will play in reverse. 
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Loop determines how the sample will be looped. When the Loop feature is on, the region of the sample between the 
loop point (determined by the Loop field in the second row) and end point will repeat. This is useful when trying to 
find an ideal spot to begin the sample. The loop cannot be earlier than the start point. 

Important: For Loop to work, you must (1) set the Sample field (in the Lfo Mod tab) to NoteOn instead of OneSht 
and (2) set the Slice field (in the first Samples tab) to Pad instead of All or a slice number. 

To set how the sample loops, use this field to select an option: 

• Off: The sample will not loop. 

• Forward (Fwd): You can hold down a pad in the keygroup to cause that sample to repeat from the loop 
point to the end of the sample. Release the pad to stop the repeating playback. 

• Alternating (Alt): You can hold down a pad in the keygroup to cause that sample to play from the loop 
point to the end of the sample and then play in reverse until it reaches the loop point again. This will 
repeat as long as you are holding the pad down. Release the pad to stop the repeating playback. 

• Reverse (Rev): You can hold down a pad in the keygroup to cause that sample to play in reverse, 
repeating from the end of the sample to the loop point. Release the pad to stop the repeating playback. 

 

Warp determines whether or not stretching the time of the sample will change its pitch and vice versa. 

When set to On, lengthening or shortening the sample (based on the BPM) will not change its pitch. 

When set to Off, lengthening or shortening the sample will also change its pitch and vice versa. Use the Stretch, 
BPM, and BPM Sync settings (described below) in conjunction with this feature. See the note below to learn how to 
minimize CPU requirements while using Warp. 

To set whether or not the sample is warped, set this field to On or Off (respectively). 

 

Stretch is the “stretch factor,” which affects how the sample is warped (if Warp is set to On). See the note below to 
learn how to minimize CPU requirements while using Warp. 

To set the stretch factor, use this field. 

 

BPM is the tempo used when a sample is warped (if Warp is set to On). See the note below to learn how to minimize 
CPU requirements while using Warp. 

To set the tempo of the sample, use this field. 

 

BPM Sync determines whether the tempo of the sample is linked to or independent of the tempo of the sequence.  

When BPM Sync and Warp are both set to On, the sample’s tempo will be “locked” to the tempo of the sequence.  

When BPM Sync is set to Off but Warp is set to On, the sample will be independent of the tempo of your sequence—
use the Stretch field to lengthen or shorten a sample. See the note below to learn how to minimize CPU requirements 
while using Warp. 

To enable or disable BPM Sync, set this field to On or Off (respectively). 

 

Note: The Warp algorithms are very CPU-intensive and can result in audio drop-outs during playback if used too 
freely. Be mindful of how (and how often) you use the warp function. You can reduce the CPU resources required by 
doing any/all of the following: 

• Avoid using extreme Stretch values. 

• Minimize the amount of pitch adjustment (e.g., the Tune parameter) of warped audio. 

• Avoid warping very small track regions. 

• Warp as few tracks or track regions as possible (i.e., reduce the number of total number of voices of the 
polyphonic limit that use the Warp algorithm at a given time), especially instances where the warped regions start 
at the same time. 

• Avoid rapidly triggering samples that are warped. 

• If you have warped samples used in a drum program, consider using the Flatten Pad function to consolidate the 
affected pad’s layers into one audio sample. After you flatten the pad, its sample/samples no longer need to be 
warped. To see the user guide in the MPC software and learn how to do this, click the Help menu, select MPC 
Help, and select MPC User Manual. 
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The second Samples tab contains controls for the pitch and volume level of each layer. 

 

 

 

Loop Lock determines if the loop point of a sample layer is “linked to” or “unlinked from” the start point. 

When set to On, the loop point is the same as the start point. 

When set to Off, the loop point is independent from the start point and indicated by a separate loop marker. This is 
the same as the Loop Lock button in Sample Edit Mode. 

To turn Loop Lock on or off, set this field to On or Off (respectively). 

 

S1–4 (Sample 1–4) is the name of the sample assigned to the current layer (1–4) of the keygroup. Remember that the 
sample has to be loaded into the project’s sample pool beforehand. To learn how to load samples into a project, 
please see Browser. 

To assign a sample, use this field or turn the corresponding Q-Link knob (1, 5, 9, or 13 on MPC Renaissance or 
the Q-Link knobs in the first column on MPC Studio). 

 

Semi is the coarse tuning of the sample on each layer: -36 to +36 semitones. 0 corresponds to no coarse-tuning 
adjustment. This will affect the length of the sample (if Warp is set to Off). 

To set the coarse tuning of the sample on each layer, use this field or turn the corresponding Q-Link knob (2, 
6, 10, or 14 on MPC Renaissance or the Q-Link knobs in the second column on MPC Studio). 

 

Fine is the fine tuning of the sample on each layer: -99 to +99 cents. 0 corresponds to no fine-tuning adjustment. 
This will affect the length of the sample (if Warp is set to Off). 

To set the fine tuning of the sample on each layer, use this field or turn the corresponding Q-Link knob (3, 7, 
11, or 15 on MPC Renaissance or the Q-Link knobs in the third column on MPC Studio). 

 

Level is the volume of the sample on each layer, enabling you to control the “balance” of the samples assigned to 
the pad. 

To set the volume level of the sample on each layer, use this field or turn the corresponding Q-Link knob (4, 
8, 12, or 16 on MPC Renaissance or the Q-Link knobs in the fourth column on MPC Studio). 
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The third Samples tab contains a control for the offset of the sample on each layer. 

 

 

 

Loop Lock determines if the loop point of a sample layer is “linked to” or “unlinked from” the start point. 

When set to On, the loop point is the same as the start point. 

When set to Off, the loop point is independent from the start point and indicated by a separate loop marker. This is 
the same as the Loop Lock button in Sample Edit Mode. 

To turn Loop Lock on or off, set this field to On or Off (respectively). 

 

S1–4 (Sample 1–4) is the name of the sample assigned to the current layer (1–4) of the keygroup. Remember that the 
sample has to be loaded into the project’s sample pool beforehand. To learn how to load samples into a project, 
please see Browser. 

To assign a sample, use this field or turn the corresponding Q-Link knob (1, 5, 9, or 13 on MPC Renaissance or 
the Q-Link knobs in the first column on MPC Studio). 

 

Offset is the time offset of the sample’s playback on each layer. When this setting is a positive value, playing a pad 
in the keygroup will immediately trigger the sample on that layer but at a later point in the sample (specified by this 
setting). When this setting is a negative value, the sample playback on that layer will be delayed by the amount 
specified by this setting. 

To set the offset of the sample on each layer, use this field or turn the corresponding Q-Link knob (2, 6, 10, or 14 
on MPC Renaissance or the Q-Link knobs in the second column on MPC Studio). 
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Panning & Velocity 

 

The Pan Vel tab contains settings that determine the stereo placement and velocity ranges of each layer of the keygroup. 

 

 

 

Pan is the panning position of the sample on each layer in the stereo field: 50L (left) to 50R (right). C indicates the 
center position. 

To set the panning position of the sample on each layer, use this field or turn the corresponding Q-Link knob 
(1, 5, 9, or 13 on MPC Renaissance or the Q-Link knobs in the first column on MPC Studio). If you use the 
numeric keypad to change this number, use values from 0 to 100: -50 corresponds to 50L, 0 corresponds to C, 
and +50 corresponds to 50R. 

 

Low and High determine the lowest and highest velocities (respectively) that will trigger the sample on each layer. A 
range from 0 to 127 lets the layer respond to the entire velocity range which is input from a pad in the keygroup, 
while, for example, a range from 100 to 127 lets the layer respond only to higher velocity levels. By assigning several 
samples of one instrument, you can create a realistic-sounding “multi-sample” by adjusting the velocity ranges of 
each layer accordingly. 

For example, you may have three samples of a piano key pressed with low force, medium force, and high force. You 
can set each sample to a layer and set the velocity ranges so only low velocities trigger the low-force sample, only 
mid-range velocities trigger the medium-force sample, and only high velocities trigger the high-force sample. 

To set the velocity range of the sample on each layer, use these fields or turn the corresponding Q-Link knob: 
for low velocities, turn Q-Link Knob 2, 6, 10, or 14 (MPC Renaissance) or the second column of Q-Link knobs 
(MPC Studio); for high velocities Q-Link Knob 3, 7, 11, or 15 (MPC Renaissance) or the third column of Q-Link 
knobs (MPC Studio). 

 

Root is the root note of the sample. This determines which note will play the sample at its original pitch when in a 
keygroup program. Sample denotes to the sample’s default pitch. 

To set the root note of the sample, use this field or turn the corresponding Q-Link knob (4, 8, 12, or 16 on MPC 
Renaissance or the Q-Link knobs in the fourth column on MPC Studio). If you use the numeric keypad to change 
this number, use values from 0 to 100: -50 corresponds to 50L, 0 corresponds to C, and +50 corresponds to 50R. 
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Filter Envelope 

 

The Flt Env tab contains settings for the filter and amp envelopes that affect the keygroup. 

 

 
 

Type determines the filter that is applied to the selected keygroup. See Appendix > Glossary > Filter for an explanation 
of the available filter types. 

To set the filter type, use this field or turn Q-Link Knob 13 (MPC Renaissance) or the first Q-Link knob in the 
first row (MPC Studio). 

 

Cutoff is the cutoff frequency for low-pass and high-pass filter types or the center frequency for band-pass and band-
stop filter types. See Appendix > Glossary > Filter for an explanation of the available filter types. 

To set the filter cutoff frequency, use this field or turn Q-Link Knob 14 (MPC Renaissance) or the second Q-
Link knob in the first row (MPC Studio). 

 

Reso (Resonance) is the emphasis of the frequencies around the cutoff point. 

Tip: Use values lower than 80 to give more brilliance to the sound. At values higher than 80, the sound will result in a 
strong audible boost around the cutoff frequency.  

To set the filter resonance, use this field or turn Q-Link Knob 15 (MPC Renaissance) or the third Q-Link knob 
in the first row (MPC Studio). 

 

Env (Envelope) determines the amount of influence the filter envelope has on the cutoff frequency. Higher settings 
will increase the modulation of the filter by the envelope; lower settings will result in only subtle changes of the filter 
Cutoff over time. 

Tip: To give a sound a more distinctive attack, increase the Env setting and set low Atk and Dec values as well as 
a medium-low Sust value of the filter envelope (Flt). This will start a sound with the filter opened and close it shortly 
afterward, giving it a bright start followed by a darker sustain. String sounds, on the other hand, can sound much 
more “alive” with low Env settings and a high Atk value, resulting in a slight fade-in of the higher frequencies.  

To set the filter envelope amount, use this field or turn Q-Link Knob 16 (MPC Renaissance) or the fourth Q-
Link knob in the first row (MPC Studio). 

 

Kbd>Flt (KeyboardFilter) sets how much the note value will be added to the filter cutoff. This allows higher notes to 
sound brighter. 

To set the “keyboard to filter,” use this field or turn Q-Link Knob 9 (MPC Renaissance) or the first Q-Link 
knob in the second row (MPC Studio). 

 

V>Attack (VelocityAttack) determines how much velocity is needed (for a triggered pad in the keygroup) to modulate 
the Attack (Atk) phase for the Amp envelope. 

To set the “velocity to filter attack,” use this field or turn Q-Link Knob 10 (MPC Renaissance) or the second 
Q-Link knob in the second row (MPC Studio). 

 

V>Env (VelocityEnvelope) determines to what degree velocity information affects the amount of the filter envelope’s 
effect on the cutoff frequency. 

To set the “velocity to envelope amount,” use this field or turn Q-Link Knob 11 (MPC Renaissance) or the 
third Q-Link knob in the second row (MPC Studio). 
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V>Filter (VelocityFilter) determines to what degree the velocity of a pad modulates the cutoff frequency directly. 

To set the “velocity to filter cutoff,” use this field or turn Q-Link Knob 12 (MPC Renaissance) or the fourth Q-
Link knob in the second row (MPC Studio). 

 

The third row of parameters determine how the filter envelope affects the filter frequency over a period of time. There 
are three possible sets of parameters, depending on the type of envelope: 

• AD (attack-decay) envelope: Flt Atk (filter attack), Flt Dec (filter decay), and Dec Type (decay type) 

• AHDS (attack-hold-decay-sustain) envelope: Flt Atk (filter attack), Flt Hold (filter hold), Flt Dec (filter decay), 
and Flt Sust (filter sustain) 

• ADSR (attack-decay-sustain-release) envelope: Flt Atk (filter attack), Flt Dec (filter decay), Flt Sust (filter 
sustain), and Flt Rel (filter release) 

See the later Anatomy of an Envelope section to learn about these envelope parameters. 

To adjust the filter envelope parameters, use these fields or turn the corresponding Q-Link knob (5–8 on MPC 
Renaissance or the Q-Link knobs in the third row on MPC Studio). 

To adjust the overall influence of the envelope on the filter frequency, use the Env field or turn Q-Link Knob 16 
(MPC Renaissance) or the first Q-Link knob in the fourth column (MPC Studio). 

To set the envelope type, press F1/Master and set Sample to One Shot (O.ht), if you want to select an AD or 
AHDS envelope, or Note On (N.On), if you want to use ADSR envelopes only. To select an AD or AHDS 
envelope, press F4/Flt Env, select one of the eight bottom-most parameters, and then press Window. Use the 
Filter Envelope AD Mode field in the screen that appears to select an AD envelope (On) or AHDS (Off), and then 
press F4/Close. 

 

The fourth row of parameters determine how the amp envelope affects the volume level over a period of time. There 
are three possible sets of parameters, depending on the type of envelope: 

• AD (attack-decay) envelope: Amp Atk (amp attack), Amp Dec (amp decay), and Dec Type (decay type) 

• AHDS (attack-hold-decay-sustain) envelope: Amp Atk (amp attack), Amp Hold (amp hold), Amp Dec (amp 
decay), and Amp Sust (amp sustain) 

• ADSR (attack-decay-sustain-release) envelope: Amp Atk (amp attack), Amp Dec (amp decay), Amp Sust 
(amp sustain), and Amp Rel (amp release) 

See the later Anatomy of an Envelope section to learn about these envelope parameters. 

To adjust the amp envelope parameters, use these fields or turn the corresponding Q-Link knob (9–12 on 
MPC Renaissance or the Q-Link knobs in the fourth row on MPC Studio). 

To set the envelope type, press F1/Master and set Sample to One Shot (O.ht), if you want to select an AD or 
AHDS envelope, or Note On (N.On), if you want to use ADSR envelopes only. To select an AD or AHDS 
envelope, press F4/Flt Env, select one of the eight bottom-most parameters, and then press Window. Use the 
Volume Envelope AD Mode field in the screen that appears to select an AD envelope (On) or AHDS (Off), and 
then press F4/Close. 
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LFO Modulation 

 

The Lfo Mod tab contains settings that determine sample playback and low-frequency oscillator of the pad. 

 

 
 

V>Pitch (VelocityPitch), V>Atk (VelocityAttack), V>Amp (VelocityAmp), and V>Pan (VelocityPanning) determine 
how much the velocity affects the pitch of the sound (Pitch), the attack of the filter envelope (Atk), the volume level of 
the filter envelope (Amp) and or the panning of the sound (Pan). When you press a pad in the keygroup softly, only 
minimal modulation is applied. When you press it harder, the modulation amount also gets stronger depending on the 
setting of the corresponding knob. 

To adjust the velocity sensitivity of the pad, use these fields or turn the corresponding Q-Link knob (13–16 on 
MPC Renaissance or the first row of Q-Link knobs on MPC Studio). 

 

A low-frequency oscillator (LFO) generates a periodic waveform with an adjustable frequency and shape which can be 
used for modulation purposes. The seven settings in the lower half of the screen affect the LFO applied to the keygroup. 

 

Wave is the type of waveform the LFO uses. 

To select the waveform of the LFO, use this field or turn Q-Link Knob 9 (MPC Renaissance) or the first Q-Link 
knob in the second row (MPC Studio) to select an option: 

• Sine (best suited for smooth modulations) 

• Triangle (best suited for smooth modulations) 

• S&H (samples a random value and holds it until the next value is generated) 

• Saw (can generate interesting filter or volume changes) 

• Saw Down (can generate interesting filter or volume changes) 

• Square (interesting results with hard-panning modulations) 

• Noise (generates random values and glides) 

 

Rate is the LFO frequency when Sync is on. At lower values, it might take some time for the LFO to complete a 
cycle, while higher values will come closer to audible range. 

To set the frequency of the LFO, use this field or turn Q-Link Knob 10 (MPC Renaissance) or the second Q-
Link knob in the second row (MPC Studio). 

 

Sync determines if or how the LFO’s rate is synchronized with the tempo. You can select one of several time 
divisions (a . indicates a dotted note; a T indicates a triplet-based time division). When None is selected, Sync is off. 

To set the synchronization of the LFO, use this field or turn Q-Link Knob 11 (MPC Renaissance) or the third 
Q-Link knob in the second row (MPC Studio). 

 

L>Pitch (LFOPitch), L>Filter (LFOFilter), L>Amp (LFOAmp), and LFO>Pan (LFOPanning) determine how 
much the LFO affects the pitch of the sound (Pitch), the cutoff frequency of the filter (Filter), the volume level of the 
sound (Amp), and the panning of the sound (Pan). When you press a pad in the keygroup softly, only minimal 
modulation is applied. When you press it harder, the modulation amount also gets stronger depending on the setting 
of the corresponding knob. 

To adjust the LFO destinations of the pad, use these fields or turn the corresponding Q-Link knob (5–8 on 
MPC Renaissance or the Q-Link knobs in the third row on MPC Studio). 
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Pitch determines the range (in semitones) of the pitch-bend wheel on a connected MIDI keyboard. (To use this 
feature, you must have a MIDI device that sends pitch-bend messages connected to your computer.) 

To set the range of the pitch-bend wheel, use this field or turn Q-Link Knob 2 (MPC Renaissance) or the 
second Q-Link knob in the fourth row (MPC Studio). 

 

WHL>LFO determines how much the modulation wheel on a connected MIDI keyboard affects the intensity of the LFO. 
(To use this feature, you must have a MIDI device that sends modulation messages connected to your computer.) 

To set how much the modulation wheel affects the LFO, use this field or turn Q-Link Knob 3 (MPC 
Renaissance) or the third Q-Link knob in the fourth row (MPC Studio). 

 

AFT>FILT (AftertouchFilter Cutoff) determines how much the filter cutoff frequency is affected by aftertouch 
messages from a connected MIDI keyboard. (To use this feature, you must have a MIDI device that sends aftertouch 
messages connected to your computer.) 

To set how much the filter cutoff frequency affects the filter cutoff, use this field or turn Q-Link Knob 4 
(MPC Renaissance) or the fourth Q-Link knob in the fourth row (MPC Studio). 
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Effects 

 

Effects shows the insert effects and send effect levels for the keygroup. You can select up to four insert effects for 
each keygroup. Additionally, each keygroup can be sent to up to four return channels, each of which can have up to 
four insert effects of their own. Their audio will be routed through the insert effects on those returns, and the 
processed audio will be sent to a master output. 

Please see General Features > Effects to learn more about using insert and send effects. 

Important: When using keygroup insert effects, they will be applied to that keygroup only. Keep this in mind if you 
load insert effects to multiple keygroups with overlapping note ranges—the effects will overlap in that range as well. 

 

 

 

Inserts determines whether insert effects are activated (ON) or deactivated (OFF) for the keygroup. 

To activate or deactivate all four insert effects, set this field to ON or OFF (respectively). 

 

Insert 1–4 are the four available slots for insert effects on that keygroup. 

To load an effect, select an Insert field, and then use the data dial or –/+ buttons. In the Select Effect screen that 
appears, select an effect. Press F4/Select to load the selected effect or F3/Back to return to the previous screen. 

To change the settings of a loaded effect, select an Insert field with an effect, and press Window. In the screen 
that appears, you can select and change each parameter (you can use the numeric keypad on some of them). 
Press F4/Close to return to the previous screen. 

To activate or deactivate an effect, select its Insert field, and press Window. In the screen that appears, press 
F6/On/Off to activate or deactivate the effect. Press F4/Close to return to the previous screen. 

To activate or deactivate all four insert effects, set the Inserts field to ON or OFF (respectively). 

 

Send 1–4 are the audio signal levels that the keygroup sends to the four return channels, each of which can have up 
to four insert effects—these are send effects. The send effects will then send the audio to the assigned master 
output at the designated return levels. You can select up to four send effects for each keygroup, but remember that 
they will be applied to that keygroup only. 

To adjust the send levels, turn their corresponding Q-Link knobs (4, 8, 12, or 16 on MPC Renaissance or the 
Q-Link knobs in the fourth column on MPC Studio). 

Important: To edit the send effects, use the Channel Mixer. See Channel Mixer > Returns to learn more how to 
do this. 
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Clip Programs 

 

 

 

When using clip programs, Program Edit Mode lets you assign a sample (a loop called a clip) to each pad in a single 
bank. You can also edit various settings to determine how each pad launches its assigned clip. 

To select a pad, press it. Its parameters will appear on the screen immediately. 

To view a specific tab of parameters, press F1/Program or F2/Pad. The Program tab is where you assign 
clips to pads (see Program in this section). The Pad tab is where you determine how each pad plays its clip (see 
Pad in this section). 

 

Below is a brief step-by-step process so you can get familiar with setting up a clip. Continue reading the rest of this 
chapter to learn how to use the parameters in this window. 

 

To assign a clip: 

1. Press F2/Pad, and set the Sample field at the top of the screen to the desired clip. For example, start with a 
four-bar drum loop. 

2. Note that the Tempo field has a value, which is automatically detected. 

Set Warp to On if it is not already. The Warp function keeps the loop in time with the sequence tempo or the 
master tempo.  

3. If you need to edit the loop’s tempo manually, use the Tempo field. 

4. Set Fade to On if it is not already. This applies a very small fade-in and fade-out at the start and end of the clip 
to prevent “clicks” and glitches that can occur if the start or end points are not at “zero-crossings.” 

5. If you need to edit the loop’s pitch manually, use the Semi and/or Fine fields, or turn Q-Link Knobs 1 and/or 2 
(MPC Renaissance) or the first and second Q-Link knobs in the fourth row (MPC Studio), respectively. These 
adjust the pitch by semitones and cents. You will hear the tuning adjustments in real time. 
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These are the buttons under the screen for clip programs: 

F1 Program Press this button to view the Program tab, described here. 

F2 Pad Press this button to view the Pad tab, described here. 

 

  

 

You can edit one pad, multiple pads, or all pads of a clip program simultaneously while in Program Edit Mode.  

To select how many pads and which pad/pads you are editing, select any parameter in Program Edit Mode, 
and then press Window. In the Edit Zones screen that appears, set the Edit Mode field: 

• Current: Only the currently selected pad can be edited. 

• Multiple: All selected pads can be edited simultaneously. 

• All: All pads can be edited simultaneously. 

Tip: You can immediately select or deselect multiple pads while on any tab in Program Edit Mode (regardless of 
the current Edit Mode setting). To do this, press Shift and each desired pad. Edit Mode will automatically 
change to the corresponding setting. 

 

 

Program 

 

The Program tab enables you set the program’s overall tuning and quantization. 

 

 

 

Semi is the coarse tuning of the program: -36 to +36 semitones. 0 corresponds to no coarse-tuning adjustment. 

To set the coarse tuning of the program, use this field or turn Q-Link Knob 9 (MPC Renaissance) or the 
second Q-Link knob in the first column (MPC Studio). 

 

Fine is the fine tuning of the program: -99 to +99 cents. 0 corresponds to no fine-tuning adjustment. 

To set the fine tuning of the program, use this field or turn Q-Link Knob 5 (MPC Renaissance) or the third Q-
Link knob in the first column (MPC Studio). 

 

Launch is the quantization of the program in bars or subdivisions of a bar. When you launch any clips in the program, 
it will use this quantization. None denotes no quantization; when you launch a clip, it will start playing immediately. 

To set the quantization of the program, use this field or turn Q-Link Knob 1 (MPC Renaissance) or the fourth 
Q-Link knob in the first column (MPC Studio). 



  

 
140 

 

 

Pad 

 

The Pad tab contains settings to assign a clip to each pad and set its timing, tuning, and playback behavior. 

 

 

 

Sample is the name of the sample assigned to the pad. Remember that the sample has to be loaded into the 
project’s sample pool beforehand. To learn how to load samples into a project, please see Browser. Select None to 
clear the pad’s assignment. 

To assign a sample to the current pad, use this field. 

 

Warp determines whether or not stretching the time of the sample will change its pitch and vice versa. 

When set to On, lengthening or shortening the sample (based on the BPM) will not change its pitch. 

When set to Off, lengthening or shortening the sample will also change its pitch and vice versa. Use the BPM setting 
(described below) in conjunction with this feature. See the note below to learn how to minimize CPU requirements 
while using Warp. 

To set whether or not the sample is warped, set this field to On or Off (respectively). 

Note: The Warp algorithms are very CPU-intensive and can result in audio drop-outs during playback if used too 
freely. Be mindful of how (and how often) you use the warp function. You can reduce the CPU resources required by 
doing any/all of the following: 

• Avoid using extreme Stretch values. 

• Minimize the amount of pitch adjustment (e.g., the Tune parameter) of warped audio. 

• Avoid warping very small track regions. 

• Warp as few tracks or track regions as possible (i.e., reduce the number of total number of voices of the 
polyphonic limit that use the Warp algorithm at a given time), especially instances where the warped regions start 
at the same time. 

• Avoid rapidly triggering samples that are warped. 

• If you have warped samples used in a drum program, consider using the Flatten Pad function to consolidate the 
affected pad’s layers into one audio sample. After you flatten the pad, its sample/samples no longer need to be 
warped. To see the user guide in the MPC software and learn how to do this, click the Help menu, select MPC 
Help, and select MPC User Manual. 

 

Tempo is the tempo used when a sample is warped (if Warp is set to On). See the note above to learn how to minimize 
CPU requirements while using Warp. 

To set the tempo of the sample, use this field. 

 

Play determines how the clip is played.  

To set how the clip is played, use this field or turn Q-Link Knob 6 (MPC Renaissance) or the second Q-Link 
knob in the third row (MPC Studio) to select an option: 

• One Shot: When you press the pad, the entire clip will play from start to end and then stop. 

• Toggle: When you press the pad, the entire clip will play from start to end and loop indefinitely. Pressing it 
again—or launching another in the same mute group—will stop its playback. This is the most common usage. 
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Launch is the quantization of the pad in bars or subdivisions of a bar. When you launch this clip, it will use this 
quantization instead of the program’s quantization (set in the Program tab). When set to PGM, the pad will use the 
program’s quantization (this is the default setting). None denotes no quantization; when you launch a clip, it will start 
playing immediately. 

To set the quantization of the pad, use this field or turn Q-Link Knob 7 (MPC Renaissance) or the third Q-Link 
knob in the third row (MPC Studio). 

 

Dir (Direction) determines which direction the sample will play. 

To set the playback direction, use this field to select an option: 

• Forward (Fwd): The sample will play in the normal forward direction. 

• Reverse (Rev): The sample will play in reverse. 

Alternatively, turn Q-Link Knob 8 (MPC Renaissance) or the fourth Q-Link knob in the third row (MPC Studio). 

 

Semi is the coarse tuning of the pad: -36 to +36 semitones. 0 corresponds to no coarse-tuning adjustment. 

To set the coarse tuning of the pad, use this field or turn Q-Link Knob 1 (MPC Renaissance) or the first Q-
Link knob in the fourth row (MPC Studio). 

 

Fine is the fine tuning of the pad: -99 to +99 cents. 0 corresponds to no fine-tuning adjustment. 

To set the fine tuning of the pad, use this field or turn Q-Link Knob 2 (MPC Renaissance) or the second Q-
Link knob in the fourth row (MPC Studio). 

 

Mute Grp determines if the pad is assigned to a mute group: 1–32 or Off (no mute group). When pads assigned to 
the same mute group receive MIDI notes, the last pad played will silence all other pads in that mute group. A mute 
group affects pads within that program only; mute groups do not affect pads in other programs. 

By default, each column of pads is assigned to the same mute group. This means only one pad from each column 
can be playing its clip at a time. You can use the Mute Group field to configure this any way you like, though. 

To set the mute group, use this field or turn Q-Link Knob 3 (MPC Renaissance) or the third Q-Link knob in the 
fourth row (MPC Studio). 

 

Fade determines whether or not a very small fade-in and fade-out are applied at the start and end of the clip. This 
feature helps prevent “clicks” and glitches that can occur if the start or end points are not placed at the waveform’s 
“zero-crossings.” 

To set whether or not the sample uses a fade-in and fade-out, set this field to On or Off (respectively) or turn 
Q-Link Knob 4 (MPC Renaissance) or the fourth Q-Link knob in the fourth row (MPC Studio). 

 

The start and end points of the clip assigned to the pad are not shown in the screen, but you can still use the MPC 
hardware to adjust them. 

To set the clip’s start point, use Q-Link Knobs 9–12 (MPC Renaissance) or the Q-Link knobs in the first row 
(MPC Studio) to adjust the start point with varying degrees of resolution.  

To set the clip’s end point, use Q-Link Knobs 13–16 (MPC Renaissance) or the Q-Link knobs in the second 
row (MPC Studio) to adjust the end point with varying degrees of resolution. 
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Plugin Programs 

 

When using plugin programs, Program Edit Mode shows an overview of all available plugin parameters with an 
adjustable parameter for each one. 

 

 

 

The buttons under the screen will vary depending on the plugin. Press each one to access a tab of parameters that 
you can adjust using the data dial, –/+ buttons, or corresponding Q-Link knob. Some of the fields may not contain a 
parameter. 

 

To select preset within your plugin: 

1. Select the Program field at the top of the screen, and press Window. 

2. In the screen that appears, select the desired preset, and press F5/Select to continue or F4/Close to return to 
the previous screen. 

3. You can press F2/AutoSel to activate or deactivate automatic selection, which will automatically load each 
preset as you move through the list. 

 

To assign a parameter to one of the fields, use the MPC software.  

Note: To see the user guide in the MPC software and learn how to do this, click the Help menu, select MPC Help, 
and select MPC User Manual. 
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MIDI Programs 

 

When using MIDI programs, Program Edit Mode shows an overview of all available MIDI CCs with an adjustable 
parameter for each one. 

 

 

 

The buttons under the screen correspond to six tabs. Press each one to access 16 MIDI CCs on each tab that you 
can adjust using the data dial, –/+ buttons, corresponding Q-Link knob, or numeric keypad. 

 

To assign a parameter to one of the fields, use the MPC software.  

Note: To see the user guide in the MPC software and learn how to do this, click the Help menu, select MPC Help, 
and select MPC User Manual. 

 

 

CV Programs 

 

When using CV programs, Program Edit Mode shows an overview of all eight CV outputs with an adjustable voltage 
parameter for each one. 

 

 

 

The buttons under the screen correspond to six tabs. You can press each one to access a tab, but only the first tab 
(Page1) contains the eight adjustable voltage parameters that you can adjust using the data dial, –/+ buttons, 
corresponding Q-Link knob, or numeric keypad. 

 

To assign a parameter to one of the fields, use the MPC software.  

Note: To see the user guide in the MPC software and learn how to do this, click the Help menu, select MPC Help, 
and select MPC User Manual. 
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Anatomy of an Envelope 

 

An envelope creates a variable control signal. It can be used, for instance, to modulate the filter settings of a sound 
over a given period of time. 

Drum programs and keygroup programs can use three types of envelopes: AD (attack-decay), AHDS (attack-hold-
decay-sustain), or ADSR (attack-decay-sustain-release).  

For drum programs, when Sample (in the Lfo Mod tab) is set to One Shot (OneSht), it will use ADSR envelopes 
only. When set to Note On (NoteOn), it can use an AD or ADHS envelope. See Program Edit Mode > Drum 
Programs > Filter Envelope and LFO Modulation to learn how to change the envelope. 

For keygroup programs when Sample (in the Master tab) is set to One Shot (O.ht), it can use an AD or AHDS 
envelopes. When set to Note On (N.On), it will use ADSR envelopes only. See Program Edit Mode > Keygroup 
Programs > Filter Envelope and Master to learn how to change the envelope. 

 

With AD envelopes, the following happens when you trigger a sample: 

1. Within the period of time you have defined with the attack (Atk), the sample 
volume rises to its maximum value. 

2. The sample’s maximum volume will be maintained until its decay (Dec) 
phase, when the sample’s volume will gradually drop to zero over the set 
duration. The decay can function in one of two ways: 

• Decay From Start (Strt): The volume will start decreasing 
immediately after reaching its maximum level. 

• Decay From End (End): The maximum volume will be maintained 
for a hold phase until it reaches the decay phase. 

 

With AHDS envelopes, the following happens when you trigger a sample: 

1. Within the period of time you have defined with the attack (Atk), the 
sample volume rises to its maximum value. 

2. The sample’s maximum volume will be maintained during the Hold phase. 

3. During the decay (Dec) phase, the sample’s volume will gradually drop to 
the Sustain (Sust) level. 

4. The sample’s volume will stay at the sustain level (Sust) until the pad is 
released.  

 

With ADSR envelopes, the following happens when you trigger a sample: 

1. Within the period of time defined by the attack (Atk), the sample volume 
rises to its maximum value. 

2. During the decay (Dec) phase, the sample’s volume will gradually drop to 
the Sustain (Sust) level. 

3. The sample’s volume will stay at the Sustain (Sust) level until the Release 
(Rel) phase begins. 

4. The sample’s volume will drop to “zero” over the duration set by Release 
(Rel). 
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Browser 
 

The Browser lets you navigate your computer’s internal hard disk to load samples, sequences, songs, etc. Using 
filter buttons and user-definable folders, you can easily adapt it to your preferred workflow. You can also audition 
(preview) your samples before loading them. 

 

To enter the Browser, press Browser. 

 

 

 

 

 

 

 

These are the buttons under the screen: 

F2 Auto Press this button to enable or disable the audition function. When enabled, each sample file 
will automatically play when it is first selected. 

F3 Play Press this button to play the sample.

F4 Volume Press and hold this button to show the Audition Volume field, which you can use to adjust 
how loudly samples play in the Browser. 

F5 Set Press this button to assign the current location to a folder button. Use the data dial or –/+ 
buttons to select one of Folders 1–5 and press F5/Do It to confirm your choice or 
F4/Cancel to return to the previous screen. 

F6 Open When a folder is selected, press this button to enter it. Alternatively, press the right cursor. 

F6 Load When a file is selected, press this button to load it.

If the file is a project, press F4/OK to confirm your choice or F3/Cancel to return to the 
previous screen. 

If the file is a sequence, press F5/Do It to confirm your choice or F4/Cancel to return to 
the previous screen. 

If the file is a sample (in a supported format), it will be loaded immediately to your 
project’s sample pool. 

 

 



  

 
146 

 

 

To enter a folder, press F6/Load. You can also use the folder buttons to jump immediately to those pre-assigned 
file paths (see below to learn how to assign these file paths): 

Folder 1: Shift+Project/Folder 1. 

Folder 2: Shift+Sequence/Folder 2. 

Folder 3: Shift+Program/Folder 3. 

Folder 4: Shift+Sample/Folder 4. 

Folder 5: Shift+No Filter/Folder 5. 

To move up one folder level, press the left cursor. 

 

To move through a list, turn the data dial, use the up or down cursors, or use the –/+ buttons. 

To load a selected file, press F6/Load. 

If the file is a project, press F4/OK to confirm your choice or F3/Cancel to return to the previous screen. 

If the file is a sequence, press F5/Do It to confirm your choice or F4/Cancel to return to the previous screen. 

If the file is a sample (in a supported format), it will be loaded immediately to your project’s sample pool. 

 

You can play a sound file to preview it before loading it into your project. The Audition feature lets you do this 
automatically as you move through lists of files. 

To play a selected sound, press and hold F3/Play. 

To enable or disable the audition function, press F2/Auto. When enabled, each sample file will automatically 
play when it is first selected. 

To set the volume level of sounds that play in the Browser, press and hold F4/Volume. Use the numeric 
keypad, data dial, or –/+ buttons to change the number of Audition Volume in the screen that appears. 

 

To get the most efficient use of the Browser, set the file paths to your favorite drive locations first. There are five 
folder buttons labeled 1–5 in the upper-right corner. You can set these to be shortcuts to five locations on your 
MPC hardware’s internal drive and/or any connected storage devices, giving you quick access to your files. 

To assign the current location to a folder button, press F5/Set. Use the data dial or –/+ buttons to select one 
of Folders 1–5 and press F5/Do It to confirm your choice or F4/Cancel to return to the previous screen. 

To enter a shortcut folder, press the corresponding combination of buttons below: 

Folder 1: Shift+Project/Folder 1. 

Folder 2: Shift+Sequence/Folder 2. 

Folder 3: Shift+Program/Folder 3. 

Folder 4: Shift+Sample/Folder 4. 

Folder 5: Shift+No Filter/Folder 5. 
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Sample Record Mode 
 

Sample Record Mode lets you record audio samples to use in your projects. 

Important: To record any audio, you need to connect an audio source to your MPC hardware or to your computer’s 
audio interface. 

Important: The Input, Channel, Monitor, Threshold, and effects (Fx) are the same for both Sample Record Mode 
and the Looper. 

To enter Sample Record Mode, press Shift+Sample Edit/Sample Rec. 

 

 

 

Use the cursors to select each field, and then use the data dial or –/+ buttons to change the parameter. If the field is 
a number, you can use the numeric keypad to enter a number and then press Enter to confirm it. 

 

These are the buttons under the screen during normal operation: 

F1 Sampler/Looper Press this button to switch between Sample Record Mode and the Looper.

F2 Sample/Slice/ 
Pad Tap/Pad Hold 

Press this button to cycle through the four sampling methods: Sample, Slice, 
Pad Tap, and Pad Hold. 

F3 Peak Press this button to reset the peak indicator on the input level meter. 

F4 Fx Press this button to show and edit the sampler’s insert effects. 

F6 Record Press this button to record-arm the sampler.

 

These are the buttons under the screen when the sampler is record-armed: 

F4 Fx Press this button to show and edit the sampler’s insert effects. 

F5 Cancel Press this button to record-disarm the sampler.

F6 Start Press this button to start recording in the sampler. 

 

To set up the sampler before recording: 

1. Make sure to reduce the volume levels of your audio source and speakers, headphones, and/or monitors before 
you make any connections to avoid “pops” or feedback. 

2. Connect a synthesizer or other line-level audio source to the input/inputs of your MPC hardware. 

3. Turn the Rec Gain knob to set the input level while playing your audio source. You should now see the level in 
the meter. Make sure it does not exceed the maximum level (the meter should not be “peaking” constantly). 

4. Set the recording controls as desired (described in this chapter). 

5. Press F6/Record to record-arm the sampler. 

 

You can record using four different methods: Sample, Slice, Pad Tap, or Pad Hold, all described later in this 
chapter. The following controls are present regardless of which method you use. 

To select a sampling method, press F2 to cycle through them: Sample, Slice, Pad Tap, Pad Hold. 
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Now is the time counter at the top of the screen, which shows the current playhead position. See General Features 
> Now & Locators to learn about this. 

 

Inserts determines whether insert effects are activated (ON) or deactivated (OFF) for the sampler and Looper. 

Important: These effects are applied to the audio as you record it. This means that the effects cannot be “removed” 
from the sound later. Learn more about how effects work in General Features > Effects. 

To activate or deactivate the insert effects, set this field to ON or OFF (respectively). 

To load, activate, deactivate, or edit the insert effects, press F4/Fx. 

 

Input determines the source of the recording in Sample Record Mode (and the Looper). You can select an external 
audio signal (In 1,2–In 31,32) or an internal signal (Resample). 

Tip: Because resampling does not record from an external source, it does not require an audio connection and can 
record without any loss in audio quality. Furthermore, you can resample two or more samples at once by pressing 
the corresponding pads simultaneously. 

To set the input, use this field. All options are stereo pairs. If you want to record a mono signal, use the Channel 
field to determine which one is the source. 

To set which channel is the source, use the Channel field to select the left channel only (LEFT), right channel 
only (RIGHT), or both channels (STEREO). 

 

Channel determines which channel you will record from the source while using Sample Record Mode (and the 
Looper): the left channel only (LEFT), right channel only (RIGHT), or both channels (STEREO). 

To set which channel is the source, use this field. 

 

Monitor determines whether or not input monitoring is on or off while using Sample Record Mode (and the Looper). 
When on, the audio you hear in your headphones will be taken before it reaches the sampler, ensuring zero latency. 
When off, the audio you hear in your headphones will be taken after it is processed in the sampler, so there may be 
some latency, but you will hear the audio source as it sounds in the recording. 

To activate or deactivate input monitoring, set this field to ON or OFF (respectively). 

Tip: To avoid possible clicks or feedback while input monitoring, reduce the level of the audio sources. 

 

Threshold indicates the minimum audio signal level required to start the sampler (or Looper) when it is record-
armed. In other words, when record-armed, the sampler will automatically start recording when the incoming audio 
signal is louder than this threshold. The T marker under the level meters is a visual indication of this setting. 

Set this level carefully. If you set it too high, the recording may not start when you play the input source, or the start 
of the material you wanted to record may be missing. If you set it too low, the recording may start too early, before 
you play the external source. Use the level meter to find the appropriate setting. 

To set the threshold, use this field, or Q-Link Knob 1 (MPC Renaissance) or the first Q-Link knob (MPC Studio). 

 

Time determines the maximum sampling time up to 19 minutes and 59 seconds (19:59) per sample. We recommend 
setting these to values that roughly match your estimated recording duration. 

To set the sampling time, use this field or turn Q-Link Knobs 3 and 4 (MPC Renaissance) or the third and 
fourth Q-Link knobs (MPC Studio) to set the Minutes and Seconds (respectively). If you use the numeric 
keypad to enter a time, enter the total number of seconds (e.g., enter 90 instead of 1:30). 

 

Output determines if the recorded sample will be monaural (Mono) or binaural (Stereo). 

To set whether the recorded sample will be monaural or binaural, use this field. 
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The Left/Right level meters shows the current input gain level of the incoming audio signal. The T marker under the 
level meters is a visual indication of the Threshold setting. 

 

You can record using four different methods: Sample, Slice, Pad Tap, or Pad Hold, all described later in this chapter. 

To select a sampling method, press F2 to cycle through them: Sampler, Slice, Pad Tap, Pad Hold. 

 

Peak allows you to reset the peak indicator when the input level meter has exceeded the maximum volume level. 

To reset the peak indicator, press F3/Peak. 

 

Fx shows any enabled or disabled effects for Sample Record Mode (and the Looper). 

Important: These effects are applied to the audio as you record it. This means that the effects cannot be “removed” 
from the sound later. Learn more about how effects work in General Features > Effects. 

To load, activate, deactivate, or edit the insert effects, press F4/Fx. Inserts 1–4 show the insert effects 
loaded to Sample Record Mode (and the Looper). 

To load an effect, use its Insert field. Select an effect in the Select Effect screen that appears. Press 
F4/Select to load the selected effect or F3/Back to return to the previous screen. 

To change the settings of a loaded effect, select its Insert field, and press Window. In the screen that 
appears, you can select and change each parameter (you can use the numeric keypad on some of them). 
Press F4/Close to return to the previous screen. 

To activate or deactivate an effect, select its Insert field, and press Window. In the screen that appears, 
press F6/On/Off to activate or deactivate the effect. Press F4/Close to return to the previous screen. 

To activate or deactivate all four insert effects, set the Inserts field to ON or OFF (respectively). 

To return to the previous screen, press F4/Fx. 

  

Press F6/Record to record-arm the sampler. The button will then change to Start and Waiting for Signal will appear 
in the screen.  

To start recording, start performing so that the incoming audio level exceeds the Threshold setting, or press 
F6/Start to start recording manually. For reference, the Sample Length counter shows you the length of your 
sample during the recording procedure. 

To disarm the sampler instead, tap F5/Cancel. 
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Sample 

 

Using this method, you can insert slice markers directly in your sample as you record it.  

Slice markers divide the sample into multiple regions called slices, which you can adjust in the Chop Mode of 
Sample Edit Mode (see Sample Edit Mode > Chop Mode for more information). This is useful when working with a 
long sample with different sounds throughout (e.g., a drum loop or a long melodic or harmonic passage). 

To select the Sample method, press F2 to cycle through the options until Sample appears in the button. 

 

 

 

 

 
To start recording, start performing so that the incoming audio level exceeds the Threshold setting, or press F6/Start 
to start recording manually. For reference, the Sample Length counter shows you the length of your sample during the 
recording procedure. 

To disarm the sampler instead, tap F5/Cancel. 

To stop recording, press F6/Stop. 

 

To insert a slice marker in a sample while recording, press Slice+ (in the lower-right corner) as the sample 
records. Each time you press it, a slice marker will be placed at that location. 

 

 

After you stop your recording, the Keep or Discard Sample window will appear. 

 

 

 
Name is the name of the new sample. 

 

Prg is the program to which the sample will be assigned.  

To assign the sample to a program, use this field. Select <none> to save it to the project without assigning it 
to a program. 
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Looper 
 

The Looper lets you record and overdub audio in real time—a great tool for live performance as well as spontaneous 
moments in the studio. You can export the loop as a sample to use in your project. 

Important: The Input, Channel, Monitor, Threshold, and effects (Fx) are the same for both Sample Record Mode 
and the Looper. The Input and Threshold settings, however, are shown in Sample Record Mode only. See Modes > 
Sample Record Mode to learn how to use these settings. 

 

To enter the Looper, press Shift+Sample Edit/Sample Rec to enter Sample Record Mode, and then press F1/Sampler 
to switch to the Looper. 

 

 

 

Use the cursors to select each field, and then use the data dial or –/+ buttons to change the parameter. If the field is 
a number, you can use the numeric keypad to enter a number and then press Enter to confirm it. 

 

These are the buttons under the screen: 

F1 Looper/Sampler Press this button to switch between the Looper and Sample Record Mode.

F2 Export Press this button to export the contents of the Looper as a sample.

F3 Reverse Press this button to reverse the playback of the Looper. 

F4 Play Press this button to play the Looper.

F5 Replace Press this button to overwrite the contents of the Looper while recording.

F6 Overdub Press this button to keep the contents of the Looper while recording, essentially 
adding more layers to it. 

Shift+F5 Fx Press these buttons to show and edit the Looper’s insert effects. 

Shift+F6 Clear Press this button to erase the contents of the Looper. 

 

 

Below is a brief step-by-step process so you can get started quickly. Continue reading the rest of this chapter to 
learn how to use the Looper in different cases. 

 

To get started using the Looper: 

1. Make sure to reduce the volume levels of your audio source and speakers/headphones/monitors before you 
make any connections to avoid “pops” or feedback. 

2. Connect a synthesizer, audio player, etc. to the input/inputs of your MPC hardware or computer interface.  

3. Turn the Rec Gain knob to set the input level while playing your audio source. You should now see the level in 
the meter. Make sure it does not exceed the maximum level (the meter should not be “peaking” constantly). 

4. Set the recording controls as desired (described in this chapter). 

5. Set Record To to Overdub. 

6. Press F6/Record to start recording in the Looper. 
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Pad Mixer 
 

In the Pad Mixer, you can set a program’s levels, stereo panning, routing, and effects. 

This mode appears differently for each type of program: 

For drum programs, this mode shows settings for each individual pad (of 128). 

For keygroup programs, this mode shows settings for each individual keygroup (up to 128). 

For clip programs, this mode shows settings for each individual clip. 

For MIDI programs, plugin programs, and CV programs, this mode is unavailable. 

For more information on how these programs differ, please see General Features > Programs. 

Important: The Prog Mix button on your MPC hardware corresponds to the Pad Mixer in the MPC software. This is 
due to the functionality changing as the software has evolved. 

 

To enter the Pad Mixer, press Prog Mix. 

 

  

 

  

 

  

 
The Pad Mixer works like an audio mixer with various settings for each pad, shown in a 4x4 array. All of their 
functionality is identical. The pad number is displayed in each field. 

Use the cursors to select each field, and then use the data dial or –/+ buttons to change the parameter. If the field is 
a number, you can use the numeric keypad to enter a number and then press Enter to confirm it. 

 

These are the buttons under the screen: 

F1 Level Press this button to view the levels of the pads. See Level to learn more. 

F2 Pan Press this button to view the panning of the pads. See Pan to learn more. 

F3 Mute Press this button to view the mute status of the pads. See Mute to learn more. 

F4 Send Press this button to cycle through the four tabs of send effect levels of the pads. See 
Send to learn more. 

F5 Insert Press this button to cycle through the four tabs of insert effects loaded to the pads. See 
Insert to learn more. 

F6 Route Press this button to view the routing of the pads. See Route to learn more. 
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To select a pad, press its corresponding pad. Alternatively, use the Pad field in the upper-left corner. 

To view more pads, use the Pad Bank buttons. 

To show the name of the sample assigned to each pad instead of the setting, press and hold Shift. The sample on 
the first layer of each pad will appear in place of the corresponding settings. Release Shift to return to the normal view.  

 

Program is the program whose pads you are viewing and editing. Only one type of program will be available in this 
field at a time (e.g., if Track is set to a track using a drum program, Program can be set to a drum program only). 
Remember that only drum programs, keygroup programs, or clip programs will display properly in the Pad Mixer. 

To select a program, use this field. 

 

Track is the track whose program you are viewing and editing. This also determines the type of program you can 
select with the Program field (e.g., if Track is set to a track using a drum program, Program can be set to a drum 
program only). 

To select a track, use this field. 

 

To view each setting in all 16 fields, press the corresponding button (F1–F6) under the screen. You can press F4/Send 
or F5/Insert multiple times to cycle through the four available slots for each. 

 

The following controls and tabs are available as indicated: 

 

Level 

When the Level tab is selected, the 16 fields show the volume level of each pad in dB.  

To adjust the level of a pad, use its corresponding field or turn its corresponding Q-Link knob. 

 

Pan 

When the Pan tab is selected, the 16 fields show the panning (stereo placement) of each pad. 50 L (left) to 
50 R (right). C indicates the center position. 

To adjust the panning of a pad, use its corresponding field or turn its corresponding Q-Link knob. If 
you use the numeric keypad to change this number, use values from 0 to 100: 0 corresponds to 50 L, 
50 corresponds to C, and 100 corresponds to 50 R. 

 

Mute 

When the Mute tab is selected, the 16 fields show the mute status of each pad. 

To mute or unmute a pad, use its corresponding field or turn its corresponding Q-Link knob. 

 

Send 

When the Send tab is selected, the 16 fields show one of the four send levels of each pad: 0–100. You can 
select up to four send effects for each pad. You can use various effects in the MPC software as well as 
other VST and AU plugins installed on your computer.  

Important: To use a send effect, you have to load an effect into the corresponding send effect slot in the 
Channel Mixer. Please see General Features > Effects > Send/Return Effects to learn more about send effects. 

To adjust the send level of a pad, use its corresponding field or turn its corresponding Q-Link knob. 

To cycle through the four send effect levels, press F4/Send. 
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Insert 

When the Insert tab is selected, the 16 fields show one of the four insert effects of each pad. You can select 
up to four insert effects for each pad. You can use various effects in the MPC software as well as other VST 
and AU plugins installed on your computer. 

Important: 

When using keygroup insert effects, they will be applied to that keygroup only. Keep this in mind if you load 
insert effects to multiple keygroups with overlapping note ranges—the effects will overlap in that range as well. 

If a routing is set to anything other than Program, then a program insert effect will not be applied to that pad 
or keygroup. 

Please see General Features > Effects > Insert Effects to learn more about insert effects. 

To select an insert effect for a pad, use its corresponding field. 

To cycle through the four insert effect slots, press F4/Send. 

To load an effect, use its corresponding field. Select an effect in the Select Effect screen that appears. 
Press F4/Select to load the selected effect or F3/Back to return to the previous screen. 

To change the settings of a loaded effect, select its Insert field, and press Window. In the screen that 
appears, you can select and change each parameter (you can use the numeric keypad on some of them). 
Press F4/Close to return to the previous screen. 

To activate or deactivate an effect, turn its corresponding Q-Link knob. Alternatively, select its Insert 
field, and press Window. In the screen that appears, press F6/On/Off to activate or deactivate the effect. 
Press F4/Close to return to the previous screen. 

 

Route 

When the Route tab is selected, the 16 fields show the output of each pad: Program, Submix (Sub) 1–8, 
Out 1,2–31,32, or Out 1–32. Usually, this is set to Program. 

Note: When set to a mono channel, the left and right channels are summed post-pan knob. If the pan knob 
is set to the center position, the left and right channels will be summed and padded. If the pan knob is set to 
the maximum left or right positions, only the respective channel will be sent to the output. 

To select the output of a pad, use its corresponding field or turn its corresponding Q-Link knob. 
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Channel Mixer 
 

In the Channel Mixer, you can set levels, stereo panning, and other settings for your MIDI and audio tracks, 
programs, returns, submixes, and master outputs. 

This mode appears differently for each type of “channel”: MIDI Tracks (Tracks), Audio Tracks, Programs, Returns, 
Submixes, and Master Outputs (Outputs). 

Important: Track Mix (or Shift+Prog Mix/Track Mix) on your MPC hardware corresponds to the Channel Mixer in 
the MPC software. This is due to the functionality changing as the software has evolved. 

 

To open the Channel Mixer, press Shift+Prog Mix/Track Mix. 

 

  

  

  

 

The Channel Mixer works like an audio mixer with various settings for each channel, shown in a 4x4 array. Their 
functionality is mostly identical. The name of the track, program, or channel is displayed at the top of each one. 

Use the cursors to select each field, and then use the data dial or –/+ buttons to change the parameter. If the field is 
a number, you can use the numeric keypad to enter a number and then press Enter to confirm it. 

 

These are the buttons under the screen: 

F1 Level Press this button to view the levels of the pads. See the description here to learn more. 

F2 Pan Press this button to view the panning of the pads. See the description here to learn more. 

F3 Mute Press this button to view the mute status of the pads. See the description here to learn more. 

F4 Send Press this button to cycle through the four tabs of send effect levels of the pads. See the 
description here to learn more. 

F5 Insert Press this button to cycle through the four tabs of insert effects loaded to the pads. See the 
description here to learn more. 

F6 Route Press this button to view the routing of the pads. See the description here to learn more. 

 

Mixer is the type of channels whose settings you are viewing and editing: MIDI Tracks (Tracks), Audio Tracks, 
Programs, Returns, Submixes, and Master Outputs (Outputs). Each page has slight differences, described in 
each section of this chapter. 

To select the type of channel, use this field. 
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The field in the upper-right corner determines the channels whose settings you are viewing and editing: 1–16, 17–32, 
etc. The name of the field varies depending on the type of channel. You cannot change this value for returns, 
submixes, or master outputs (pairs) because there are 16 or fewer of them. 

To select the channels shown in the screen, use this field: Track (for MIDI tracks), Audio Track, Program, 
Return, Submix, or Output Pairs (for master outputs). 

 

To view each setting in all 16 fields, press the corresponding button (F1–F6) under the screen. You can press F4/Send 
or F5/Insert multiple times to cycle through the four available slots for each. 

 

To show the names or numbers of the channels instead of their settings, press and hold Shift. The track name, 
program name, return number, submix number, or master output numbers will appear in place of the corresponding 
settings. Release Shift to return to the normal view.  

 

 

The following controls and tabs are available as indicated: 

 

Level 

When the Level tab is selected, the 16 fields show the velocity level (0–127) of MIDI tracks or the volume 
levels in dB of the audio tracks, programs (except for MIDI and CV programs), returns, submixes, or master 
outputs. 

To adjust a level setting, use its corresponding field or turn its corresponding Q-Link knob. 

 

Pan 

When the Pan tab is selected, the 16 fields show the panning of the MIDI or audio tracks, programs (except 
for MIDI and CV programs), returns, submixes, or master outputs. 50 L (left) to 50 R (right). C indicates the 
center position. 

To adjust a panning setting, use its corresponding field or turn its corresponding Q-Link knob. If you 
use the numeric keypad to change this number, use values from 0 to 100: 0 corresponds to 50 L, 50 
corresponds to C, and 100 corresponds to 50 R. 

 

Mute 

When the Mute tab is selected, the 16 fields show the mute status of the MIDI or audio tracks, programs 
(except for MIDI and CV programs), returns, submixes, or master outputs. 

To mute or unmute a channel, use its corresponding field or turn its corresponding Q-Link knob. 

 

Send (audio tracks, programs, and submixes only) 

When the Send tab is selected, the 16 fields show one of the four send levels of the audio tracks, programs 
(except for MIDI and CV programs), or submixes: 0–100. You can select up to four send effects for each one. 
You can use various effects in the MPC software as well as other VST and AU plugins installed on your computer.  

Important: To use a send effect, you have to load an effect into the corresponding send effect slot in the 
Channel Mixer. Please see General Features > Effects > Send/Return Effects to learn more about send effects. 

To adjust a send level, use its corresponding field or turn its corresponding Q-Link knob. 

To cycle through the four send effect levels, press F4/Send. 
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Insert (audio tracks, programs, returns, submixes, and master outputs only) 

When the Insert tab is selected, the 16 fields show one of the four insert effects of the audio tracks, 
programs (except for MIDI and CV programs), returns, submixes, and master outputs. You can select up to 
four insert effects for each one. You can use various effects in the MPC software as well as other VST and 
AU plugins installed on your computer. 

To select an insert effect, use its corresponding field. 

To cycle through the four insert effect slots, press F4/Send. 

To load an effect, use its corresponding field. Select an effect in the Select Effect screen that appears. 
Press F4/Select to load the selected effect or F3/Back to return to the previous screen. 

To change the settings of a loaded effect, select its Insert field, and press Window. In the screen that 
appears, you can select and change each parameter (you can use the numeric keypad on some of them). 
Press F4/Close to return to the previous screen. 

To activate or deactivate an effect, turn its corresponding Q-Link knob. Alternatively, select its Insert 
field, and press Window. In the screen that appears, press F6/On/Off to activate or deactivate the effect. 
Press F4/Close to return to the previous screen. 

Please see General Features > Effects > Insert Effects to learn more about insert effects. 

 

Route (audio tracks, programs, returns, and submixes only) 

When the Route tab is selected, the 16 fields show the output of the audio tracks, programs (except for MIDI 
and CV programs), returns, and submixes: Submix (Sub) 1–8 (for audio tracks and programs), Out 1,2–31,32, 
or Out 1–32. 

Note: When set to a mono channel, the left and right channels are summed post-pan knob. If the pan knob 
is set to the center position, the left and right channels will be summed and padded. If the pan knob is set to 
the maximum left or right positions, only the respective channel will be sent to the output. 

To select the output for a channel, use its corresponding field or turn its corresponding Q-Link knob. 
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MIDI Tracks 
 

The MIDI Track Mixer shows levels, panning, and mute states for all used tracks. 

To view a specific setting on all tracks, press F1/Level, F2/Pan, or F3/Mute. 
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Audio Tracks 

 

The Audio Track Mixer shows levels, mute states, send and insert effects, and routing for all used tracks. 

To view a specific setting on all tracks, press F1/Level, F2/Pan, F3/Mute, F4/Send, F5/Insert, or F6/Route. Press 
F4/Send or F5/Insert to cycle through the four send effect levels or insert effect slots (respectively). 
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Programs 

 

The Pad Mixer shows levels, panning, mute states, send and insert effects, and routing for all programs except for 
MIDI programs and CV programs. 

To view a specific setting on all programs, press F1/Level, F2/Pan, F3/Mute, F4/Send, F5/Insert, or F6/Route. 
Press F4/Send or F5/Insert to cycle through the four send effect levels or insert effect slots (respectively). 
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Returns 

 

Pads, programs, and audio tracks can each be sent to up to four send channels. Their audio signals will be routed to 
the send channels at their designated send levels. After being processed by the effects on those channels, their signals 
are then sent to the assigned master output based on their return settings (levels, panning, etc.). This view displays the 
four return channels. The return mixer shows levels, panning, mute states, insert effects, and routing for all used tracks. 

To view a specific setting on all returns, press F1/Level, F2/Pan, F3/Mute, F5/Insert, or F6/Route. Press F5/Insert 
to cycle through the four insert effect slots. 
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Submixes  

 

The Submixer shows levels, panning, mute states, send and insert effects, and routing for the eight available submixes. 

To view a specific setting on all submixes, press F1/Level, F2/Pan, F3/Mute, F4/Send, F5/Insert, or F6/Route. 
Press F4/Send or F5/Insert to cycle through the four send effect levels or insert effect slots (respectively). 
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Master Outputs 

 

The Master Mixer shows levels, panning, mute states, and insert effects for all stereo pairs of outputs: Out 1,2–31,32. 

To view a specific setting on all master outputs, press F1/Level, F2/Pan, F3/Mute, F5/Insert, or F6/Route. Press 
F5/Insert to cycle through the four insert effect slots. 
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Track Mute Mode 
 

Track Mute Mode lets you easily mute tracks within a sequence—by simply pressing them on your MPC hardware. 
This function is similar to muting tracks in the Channel Mixer but more convenient. You can also set groups for each 
track, enabling you to mute multiple tracks at once. This is useful if you want to hear a sequence without a particular 
track (e.g., muting your keyboard track to focus on the bass) or if you want to isolate specific sounds or combinations 
of sounds that are separated by track. 

 

To enter Track Mute Mode, press Track Mute.  

 

 

 

Use the cursors to select each field at the top of the screen, and then use the data dial or –/+ buttons to change the 
parameter. If the field is a number, you can use the numeric keypad to enter a number and then press Enter to 
confirm it. 

 

These are the buttons under the screen: 

F1 TrkMute Press this button to view the PadMute tab. 

F2 TrkGroup Press this button to view the PadGroup tab. 

F4 Time Div Press this button to open the Timing Correct screen. 

F5 T.C. This button indicates whether or not Timing Correct is on. Pressing it does not perform 
any function. 

F6 Solo Press and hold this button, and then press one or more pads to solo them rather than 
mute them. 

 

Now is the time counter at the top of the screen, which shows the current playhead position. See General Features 
> Now & Locators to learn about this. 

 

Seq is the sequence whose tracks you are viewing. 

To select a program, use this field. 

 

The tracks are represented by the 16 pads in a 4x4 array with their names. Unused tracks show (unused) and cannot 
be muted. 

To mute a track, press its corresponding pad on your MPC hardware. Pads with muted tracks are blue in the 
screen and red on your MPC hardware. Pads with unmuted tracks are white in the screen and yellow on your 
MPC hardware. 

To view more tracks, use the Pad Bank buttons. 
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To select an edit mode for the Q-Link knobs, press the corresponding button (F1–F5) under the screen: 

Project: In this edit mode, the Q-Link knobs can control 16 parameters within the current project overall. See the 
following Project section to learn about this specific Q-Link Edit Mode. 

Program: In this edit mode, the Q-Link knobs can control 16 program or audio track parameters. See the 
following Program section to learn about this specific Q-Link Edit Mode. 

Pad Scene (for drum programs only): In this edit mode, the Q-Link knobs can control 16 parameters for the 
currently selected pad. See the following Pad Scene section to learn about this specific Q-Link Edit Mode. 

Pad Parameter: In this edit mode, the 16 Q-Link knobs correspond to the 16 pads, each one controlling the 
same parameter for each pad. This is useful if you need to adjust the same parameter on multiple pads at once 
rather than having to select and edit each pad individually. See the following Pad Parameter section to learn 
about this specific Q-Link Edit Mode. 

Screen: In this edit mode, the Q-Link knobs will control a parameter or group of parameters in your currently 
selected mode (e.g., Main Mode, Sample Edit Mode, etc.).  

 

 

Project 

 

In the Project Q-Link Edit Mode, the Q-Link knobs control 16 parameters within the current project. 

 

 

 

You can customize the parameters shown in this mode by using the Q-Link Setup section in MPC software window. 
To see the user guide in the MPC software and learn how to do this, click the Help menu, select MPC Help, and 
select MPC User Manual. 

 

 

Program 

 

In the Program Q-Link Edit Mode, the Q-Link knobs control 16 parameters within the currently selected program or 
audio track. 

 

 

 

You can customize the parameters shown in this mode by using the Q-Link Setup section in MPC software window. 
To see the user guide in the MPC software and learn how to do this, click the Help menu, select MPC Help, and 
select MPC User Manual. 
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Pad Scene 
 

In the Pad Scene Q-Link Edit Mode, the Q-Link knobs control your favorite 16 parameters for the currently selected 
pad. You can select another pad simply by pressing it, allowing you to adjust the same 16 parameters for that new pad. 
(These assignments are automatically saved with other user settings. Any project you load will use these assignments.) 

 

 
 

To select a pad, press it. 

You can customize the parameters shown in this mode by using the Q-Link Setup section in MPC software window. 
To see the user guide in the MPC software and learn how to do this, click the Help menu, select MPC Help, and 
select MPC User Manual. 

 

 

Pad Parameter 
 

In the Pad Parameter Q-Link Edit Mode, the Q-Link knobs control the same pad parameter for the each of the 16 
pads in the current pad bank. 

For example, if the Parameter is set to Level, the 16 Q-Link knobs will adjust the 16 independent Level settings for 
each pad in the current pad bank. You could then set the Parameter to Pan and use the Q-Link knobs to adjust the 
panning of all 16 pads. 

Tip: Pressing F6/Parameter/Value to switch between viewing the parameter names (Parameter) and values (Value) 
in the screen is the most useful in this mode. 

 

 
 

 
 

You can customize the parameters shown in this mode by using the Q-Link Setup section in MPC software window. 
To see the user guide in the MPC software and learn how to do this, click the Help menu, select MPC Help, and 
select MPC User Manual. 
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Appendix 
 
Effects & Parameters 
 

This chapter lists the available effects. To learn more about how effects work with MPC, please see General Features 
> Effects. 

Note: Some of these effects have a “sync” version (e.g., Flanger Sync, Autopan Sync, etc.) whose rates will be 
affected by the current tempo. While viewing the rate of these effects, a “.” next to the time division indicates a 
triplet-based rate. 

 

 

Reverbs 
 

Options: Reverb Small, Reverb Medium, Reverb Large, Reverb Large 2, Reverb In Gate, Reverb Out Gate 

 

 

Reverb Small 

This is a spatial effect, designed to emulate a small room. Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 50 

Pre-Delay 1–100 50 

Early Reflection 0–100 50 

Density 0–100 50 

Diffuse 0–100 50 

Decay 0–100 50 

Lo-Cut 0–100 15 

Hi-Cut 0–100 10 

 

 

Reverb Medium 

This is a spatial effect, designed to emulate a medium room. Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 50 

Pre-Delay 1–100 50 

Early Reflection 0–100 50 

Density 0–100 50 

Diffuse 0–100 50 

Decay 0–100 50 

Lo-Cut 0–100 15 

Hi-Cut 0–100 10 
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Reverb Large 

This is a spatial effect, designed to emulate the sound of a 
large hall. 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 50 

Pre-Delay 1–100 50 

Early Reflection 0–100 50 

Density 0–100 50 

Diffuse 0–100 50 

Decay 0–100 75 

Lo-Cut 0–100 10 

Hi-Cut 0–100 10 

 

 

Reverb Large 2 

This is a less CPU-intensive spatial effect, emulating the 
sound of a large hall. 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 50 

Pre-Delay 1–100 50 

Early Reflection 0–100 50 

Density 0–100 50 

Diffuse 0–100 50 

Decay 0–100 75 

Lo-Cut 0–100 10 

Hi-Cut 0–100 10 

 

 

Reverb In Gate 

This is a hall reverb with an additional control. The reverb 
effect is cut off when the input drops below the level set in 
the Gate In parameter. 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 50 

Pre-Delay 1–100 50 

Early Reflection 0–100 50 

Density 0–100 50 

Diffuse 0–100 50 

Decay 0–100 75 

Lo-Cut 0–100 10 

Hi-Cut 0–100 10 

Gate In 0–100 0 
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Reverb Out Gate 

This is a hall reverb that has an additional control. The reverb 
effect is cut off when the output drops below the level set in 
the Gate Out parameter. 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 50 

Pre-Delay 1–100 50 

Early Reflection 0–100 50 

Density 0–100 50 

Diffuse 0–100 50 

Decay 0–100 75 

Lo-Cut 0–100 10 

Hi-Cut 0–100 10 

Gate Out 0–100 0 

 
 
 
Delays 
 

Delays the original signal for a specified period of time and plays it back over an adjustable period of time. 

Options: Delay Mono, Delay Mono Sync, Delay Stereo, Delay Sync (Stereo), Delay LP, Delay HP, Delay Analog, 
Delay Analog Sync, Delay Tape Sync, Delay Ping Pong, Delay Multi-Tap 

 

 

Delay Mono 

 Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 50 

Time 2–2000 ms 100 

Feedback 0–100 25 

Damping 0–100 100 

 

 

Delay Mono Sync 

 Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 50 

Time 1 bar – 1/16 triplets 1/4 

Feedback 0–100 50 

Damping 0–100 100 
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Delay Stereo 

Stereo Delay operates similarly to Mono Delay but in true 
stereo. 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 50 

Time 2–2000 ms 100 

Feedback 0–100 25 

Damping 0–100 100 

 
 

Delay Sync (Stereo) 

Stereo Delay operates similarly to Mono Delay but in true 
stereo. 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 50 

Time 1 bar – 1/16 triplets 1/4 

Feedback 0–100 50 

Damping 0–100 100 

 

 

Delay LP 

LP Delay is identical to the Mono Delay, but it uses a 
resonant low-pass filter in the delay line. 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 50 

Time 2–2000 ms 500 

Feedback 0–100 50 

Cutoff 0–100 50 

Resonance 0–100 20 

 

 

Delay HP 

HP Delay is identical to the Mono Delay, but it uses a 
resonant high-pass filter in the delay line. 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 50 

Time 2–2000 ms 100 

Feedback 0–100 50 

Cutoff 0–100 33 

Resonance 0–100 33 
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Delay Analog 

Analog Delay is similar to the Mono Delay, except that it’s 
designed to emulate an analog “Bucket Brigade”-style delay. 
This delay has a unique character to it that gives a warmer 
sound by adding subtle inaccuracies in phase and timing. 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 50 

Time 2–2000 ms 100 

Feedback 0–100 25 

 

 

Delay Analog Sync 

Analog Delay is similar to Mono Delay, except that it’s 
designed to emulate an analog “Bucket Brigade”-style delay. 
This delay has a unique character to it that gives a warmer 
sound by adding subtle inaccuracies in phase and timing. 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 50 

Time 1 bar – 1/16 triplets 1/4 

Feedback 0–100 50 

Ramp 0–100 50 

 

 

Delay Tape Sync 

Tape Delay emulates a delay system using an analog tape 
loop and a series of tape heads to produce an echo effect. 
This delay type yields a very distinct echo sound often heard 
in reggae and dub-style music. 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 50 

Time 1 bar – 1/16 triplets 1/4 

Feedback 0–100 50 

Ramp 0–100 50 

Head 1 0–100 100 

Head 2 0–100 0 

Head 3 0–100 0 

Head 4 0–100 0 

Tone 0–100 50 

Spread 0–100 50 

Wow & Flutter 0–100 50 

 

 

Delay Ping Pong 

This stereo delay allows you to set different delay times for 
its left and right repeats. 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 50 

Time, Left 2–2000 ms 100 

Time, Right 2–2000 ms 100 

Feedback 0–100 25 

Damping 0–100 100 
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Delay Multi-Tap 

This delay is a mono delay which has three delay generators 
with independently adjustable delay times and stereo 
position. 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 50 

Time 1 2–2000 ms 100 

Time 2 2–2000 ms 100 

Time 3 2–2000 ms 100 

Feedback 0–100 25 

Pan 1 0–100 50 

Pan 2 0–100 50 

Pan 3 0–100 50 

Damping 0–100 100 

Gain 1 0–100 25 

Gain 2 0–100 25 

Gain 3 0–100 25 

 

 
Flangers 
 

A flanger is a modulated delay to emulate the sound created when running two analog tape machines in parallel with 
a slight time misalignment. Slow Rate settings can produce a “whooshing” jet engine sound, while faster rates result 
in more of a “warble.” 

Options: Flanger, Flanger Sync 
 
Flanger 
 Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100 

Rate 0–100 10 

Feedback -100 – 100  0 

Delay 0–100 20 

Width 0–100 80 

 

 

Flanger Sync 
 Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100 

Rate 8 bars – 1/16 triplets 1/4 

Feedback -100 – 100 0 

Delay 0–100 20 

Width 0–100 80 
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Choruses 
 

A chorus effect uses an LFO to modulate the pitch and a delay of the input signal, which are then added to the dry 
signal. In small amounts, this creates the illusion of multiple voices playing at once. Turn up the Feedback and 
Depth for more pronounced “shimmering” and “watery” sounds. 

Options: Chorus 2-Voice, Chorus 4-Voice 
 

Chorus 2-Voice 
 Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100 

Delay 0–100 20 

Amount 0–100 80 

Width 0–100 80 

Feedback 0–100 50 

Rate 0–100 10 

 
 

Chorus 4-Voice 
 Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100 

Delay 0–100 20 

Amount 0–100 80 

Width 0–100 80 

Feedback 0–100 50 

Rate 0–100 10 

 
 
Autopans 
 

This effect uses an LFO to move the incoming signal back and forth across the stereo field, creating a rotary effect. 

Options: Autopan, Autopan Sync 

 

Autopan 

 Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100 

Rate 0–100 10 

 

 

Autopan Sync 

 Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100 

Rate 8 bars – 1/32 1/4 
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Tremolos 
 

This effect uses an LFO to increase and decrease the volume of the signal. Depending on the LFO shape, this can 
produce a smooth wave effect (sine wave) or a stuttering “on-off” effect (square wave). 

Options: Tremolo, Tremolo Sync 

 

Tremolo 

 Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100 

Rate 0–100 10 

Sine to Square 0–100 (sine–square) 0 

 

Tremolo Sync 

 Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100 

Rate 1 bar – 1/16 triplets 1/4 

Sine to Square 0–100 (sine–square) 0 

 
 
Phasers 
 

The classic phaser effect created by multiple ganged all-pass filters to create “notches,” or sharp spikes, in the frequency 
spectrum. The frequencies of these all-pass filters are usually modulated by an LFO to create a sweeping sound. 

Options: Phaser 1, Phaser 2, Phaser Sync 

 

Phaser 1 

 Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100 

Rate 0–100 10 

 

 

Phaser 2 

 Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100 

Rate 0–100 10 

 

 

Phaser Sync 

 Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100 

Rate 1 bar – 1/16 triplets 1/4 
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HP (High-Pass) Filters 
 

Options: HP Filter, HP Filter Sweep, HP Filter Sync, HP Shelving Filter 

 

HP Filter 

This effect is a static filter without modulation. Parameter Value Range Default Value

Frequency 10–19999 Hz 1500 

Resonance 0–100 0 

 

 

HP Filter Sweep 

This effect is a high-pass filter with its cutoff frequency 
modulated by an LFO. 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 80 

Low Frequency 0–100 50 

High Frequency 0–100 100 

Resonance 0–100 33 

Rate 0–100 10 

 

 

HP Filter Sync 
This effect is a high-pass filter with its cutoff frequency 
modulated by an LFO. 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100 

Low Frequency 0–100 0 

High Frequency 0–100 100 

Resonance 0–100 50 

Rate 8 bars – 1/32 1/4 

 

 

HP Shelving Filter 
This filter differs from the standard filter type, as it attenuates 
all frequencies after the cutoff point equally. 

Parameter Value Range Default Value

Frequency 10–19999 Hz 1500 

Resonance 0–100 0 

Gain -18.0 – 18.0 dB 0.0 
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LP (Low-Pass) Filters 
 

Options: LP Filter, LP Filter Sweep, LP Filter Sync, LP Shelving Filter 

 

LP Filter 
This effect is a static filter without modulation. Parameter Value Range Default Value

Frequency 10–19999 Hz 1500 

Resonance 0–100 0 

 

 

LP Filter Sweep 
This effect is a low-pass filter with its cutoff frequency 
modulated by an LFO. 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 80 

Low Frequency 0–100 0 

High Frequency 0–100 100 

Resonance 0–100 33 

Rate 0–100 10 

 

 

LP Filter Sync 
This effect is a low-pass filter with its cutoff frequency 
modulated by an LFO. 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100 

Low Frequency 0–100 0 

High Frequency 0–100 100 

Resonance 0–100 50 

Rate 8 bars – 1/32 1/4 

 

 

LP Shelving Filter 
This filter differs from the standard filter type, as it attenuates 
all frequencies after the cutoff point equally. 

Parameter Value Range Default Value

Frequency 10–19999 Hz 1500 

Resonance 0–100 0 

Gain -18.0 – 18.0 dB 0.0 
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Parametric EQs 
 

Options: PEQ 2-Band, 2-Shelf, PEQ 4-Band 

 

PEQ 2-Band, 2-Shelf 

This effect is a combination of one two-band parametric 
equalizer and two shelving filters. 

Parameter Value Range Default Value

Low Frequency 22–1000 Hz 220  

Frequency 1 82–3900 Hz 820  

Frequency 2 220–10000 Hz 2200  

High Frequency 560–19999 Hz 5600  

Q1 0–100 0 

Q2 0–100 0 

Low Gain -18.0 – 18.0 dB 0.0  

Gain 1 -18.0 – 18.0 dB 0.0  

Gain 2 -18.0 – 18.0 dB 0.0  

High Gain -18.0 – 18.0 dB 0.0  

 

 

PEQ 4-Band 

This effect is a powerful four-band parametric equalizer with 
four independent EQ ranges. 

Parameter Value Range Default Value

Low Frequency 22–1000 Hz 220 

Frequency 1 82–3900 Hz 820  

Frequency 2 220–10000 Hz 2200  

High Frequency 560–19999 Hz 5600  

Q1 0–100 5 

Q2 0–100 5 

Q3 0–100 5 

Q4 0–100 5 

Gain 1 -18.0 – 18.0 dB 0.0  

Gain 2 -18.0 – 18.0 dB 0.0 

Gain 3 -18.0 – 18.0 dB 0.0  

Gain 4 -18.0 – 18.0 dB 0.0  
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CV CV stands for control voltage, an analog method of sending control messages to external 
synthesizers, drum machines, etc. CV messages are typically used in conjunction with Gate 
messages (CV messages determine the pitch of notes while Gate messages determine note 
activation and length). CV messages are sent from the CV out ports of your MPC hardware and 
to the CV in ports of your external MIDI device. 

Please note that each external MIDI device uses a specific control voltage range, which 
determines how many volts are used in each octave (e.g., 1V/oct). Be mindful of this when 
setting it up with the MPC software and/or controller hardware—mismatched voltage ranges can 
produce unusual/undesirable “re-scaling” of the octaves. 

Decay Decay describes the descent rate of an envelope once the attack phase has reached its 
maximum and the envelope drops to the level defined by the sustain value. 

Envelope An envelope is used to modulate a sound-shaping component within a given time. For instance, 
an envelope that modulates the cutoff frequency of a filter opens and closes this filter over a 
period of time. An envelope is started via a trigger, usually a MIDI note. 

The classic ADSR envelope consists of four individually variable phases: attack, decay, sustain, 
and release. Attack, decay and release are time or slope values, while sustain is an adjustable 
level. Once an incoming trigger is received, the envelope runs through the attack and decay 
phases until it reaches the programmed sustain level. This level remains constant until the trigger 
is terminated. The envelope then initiates the release phase until it reaches the minimum value. 

You can see and read about the envelopes used in MPC Studio in Operation > Modes > 
Program Edit Mode > Anatomy of an Envelope. 

Filter A filter is a component that allows some of a signal’s frequencies to pass through it and 
dampens other frequencies. The most important aspect of a filter is the filter cutoff frequency. 
Filters generally come in four categories: low-pass, high-pass, band-pass, and band-stop. 
These are the available filters: 

A low-pass filter (the most common type) dampens all frequencies above the cutoff frequency. 

A high-pass filter in turn dampens the frequencies below the cutoff.  

A band-pass filter allows only those frequencies around the cutoff frequency to pass. All 
others are dampened. 

A band-stop filter does the opposite of a band-pass: it dampens only the frequencies around 
the cutoff frequency. 

A band-boost filter boosts the frequencies around the cutoff frequency, similar to what a band 
on an equalizer would do. All other frequencies pass through normally. 

The number of poles in a filter’s “slope” determines how extreme or subtle the effect of the 
filter will be. Filters with one or two poles produce a subtler sound while filters with six or eight 
poles are much more pronounced. 

The Model filters are analog-style emulations of famous vintage synth filters. Model1 is a four-
pole filter that distorts at high input levels. Model2 uses a mellow resonance with a “fattening” 
distortion in the lower frequencies. Model3 can produce howling, piercing resonances and 
extreme sub frequencies—watch your speakers! 

The Vocal filters are formant filters that emulate the human voice. Vocal1 produces “ah” and 
“ooh” vowel sounds. Vocal2 uses three bands to produce “oh” and “ee” vowel sounds. 
Vocal3 uses five bands to emulate an idealized model of the vocal tract. 

MPC3000 LPF is a dynamic, resonant low-pass filter (12 dB/oct) that was used on the original 
MPC3000, released in 1994. 

Please also see the entry for Resonance, an essential characteristic of a filter’s sound. 

Gate Gate messages are analog messages sent to external synthesizers, drum machines, etc. Gate 
messages are typically used in conjunction with CV messages (CV messages determine the pitch 
of notes while Gate messages determine note activation and length). Gate messages are sent from 
the CV out ports of your MPC hardware and to the CV/Gate in ports of your external MIDI device. 
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Program A program is a file that contains a list of all samples to be used, and settings for each sample 
(e.g., pad assignments, loop points, pitch tuning, effects, etc.) Program Edit Mode is where 
you can edit and assign samples (read more about this in Operation > Modes > Program 
Edit Mode). You can have a total of 128 programs in a project. 

There are three kinds of programs that use samples for their sound source. Drum programs 
are mostly used for creating drum programs and easy and quick assigning of samples to a 
pad. With keygroup programs, you can use one sample (or more) and spread it across two or 
more keys and play the sample chromatically over a keyboard. That way, there is no need to 
sample every key of, for instance, a piano. Clip programs use several samples that can be 
looped (clips), each of which can assigned to a pad; launching different combinations of clips 
together lets you create intriguing, layered performances. 

Program Change These are MIDI messages that select sound programs. Programs 1–128 can be changed via 
program change messages. 

Release An envelope parameter. This term describes the descent rate of an envelope to its minimum 
value after a trigger is terminated. The release phase begins immediately after the trigger is 
terminated, regardless of the envelope’s current status. For instance, the release phase may 
be initiated during the attack phase. 

Resonance Resonance or emphasis is an important filter parameter. It emphasizes the frequencies around 
the filter cutoff frequency by amplifying them with a narrow bandwidth. This is one of the most 
popular methods of manipulating sounds. If you increase the emphasis to a level where the 
filter enters a state of self-oscillation, it will generate a relatively pure sine waveform. 

Root Key The root key determines the original pitch of a recorded instrument or of a sample. Samples 
in MPC contain the dedicated root key information. This information will be created 
automatically during recording or importing. 

Sample When you press the pads on your MPC hardware, you can trigger sounds that we call 
samples. Samples are digitized snippets of audio that can be recorded using the recording 
(sampling) function of your MPC hardware or loaded from the Browser. 

You can edit and process a sample in different ways. For example, a sample can be 
trimmed, looped, pitch-shifted or processed, using various effects. When you have finished 
editing your sample, you can assign it to one or more drum pads to play it. Samples can be 
either mono or stereo. 

Sample Rate This is the frequency representing the amount of individual digital sample scans per second 
that are taken to capture an analog signal digitally. For normal CD audio recordings, 44100 
samples per second are used, also written as 44.1 kHz.  

You can export audio using sampling rates up to 96 kHz (see Operation > General Features 
> Audio Mixdown) and play audio using 44.1 kHz. 

Sequence A sequence is the most basic “building block” of music you can create within an MPC 
project. MIDI information from your MPC hardware pads, buttons, and Q-Link knobs are 
recorded to the tracks of a sequence. Each sequence on your MPC hardware can contain 
128 MIDI tracks and 8 audio tracks. Each project can store up to 128 separate sequences. 

The length of a sequence can be set from 1 to 999 bars, which would be enough to create an 
entire song using only one sequence. However, MPC Studio has a dedicated Song Mode 
that lets you chain sequences together to create a song. 

Song Song Mode that allows you to arrange different sections (verse, chorus, hook, etc.) in order 
to build a song. Each song can have up to 999 “steps” (stages in which a sequence may play 
one or more times). Each project can store up to 32 songs. 
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Updates in MPC 2.4 
 
New Features 
 

Clip Program Improvements 
 

The internal architecture of clip programs has been significantly improved. You can now play up to 16 clip programs 
at the same time. Clips will continue to play when changing tracks or sequences, allowing you to seamlessly 
incorporate them into live performance. 

 

 

Next Sequence Mode 
 

Next Sequence Mode now remembers the next sequence change when switching to another mode. 

 

 

Additional Transport Controls 
 

You can now hold Shift and press Stop to return the playhead to the beginning of the timeline. 
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Updates in MPC 2.6 
 
New Features 
 

Erase Parameters 
 
From the Erase window, you can now erase selected automation parameters. 

 

 
 

1. While the sequence is stopped, press the Erase button to open the Erase screen. 

2. Set the Erase field to Automation. 

3. By default, the Parameter field is set to All. Use the data dial or –/+ buttons to scroll through the list of all 
parameters that have been automated on the current track. 

4. Select the parameter you would like to erase, and then press F5/Do It to erase the automation. 

 

 

Workflow Enhancements 
 
The Keep or Discard screen in Sample Record Mode now has function button assignments to Save or Edit the 
recorded sample. 

 
In Sequence Edit Mode, you can now copy events from individual or multiple pads or notes from the Copy Events 
screen. 

 
Timing Correct can now be applied to all tracks by pressing the All Track function button in the Timing Correct 
window. 
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